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Reporting in OpsCenter

This chapter includes the following topics:

= About OpsCenter reports

= About managing reports in OpsCenter

= About managing My Reports

= About managing My Dashboard

= About managing reports folders in OpsCenter

= About managing report schedules in OpsCenter

= About managing time schedules in OpsCenter

About OpsCenter reports

OpsCenter is a web-based software application that helps organizations by providing
visibility into their data protection environment. By using OpsCenter, you can track
the effectiveness of data backup and archive operations by generating
comprehensive business-level reports.

OpsCenter displays customizable, multi-level views of backup and archive resources
and customizable reports for tracking service usage and expenditures. It also
contains tools for defining cost metrics and chargeback formulas or handling alerts.
A wide range of audiences benefit from the reporting and the management
capabilities of OpsCenter. The audiences include IT (Information Technology)
managers, application owners, IT finance teams, external compliance auditors,
legal teams, line-of-business managers, external customers, IT architects, and
capacity planning teams.
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OpsCenter reporting user interface

The OpsCenter reporting user interface consists of the following components:

Report Templates tab This tab lists all Report Templates (or standard or canned
reports) that are available in OpsCenter. You can modify the
default parameter values of a Report Template as required
and generate a new report of that kind.

For example, use the existing Backup > Job Activity >
Client Count Report Template, change the relative
timeframe to four weeks (default timeframe is two weeks)
and generate a new Client Count report. You can see all
clients that are backed up over the last four weeks.

My Reports tab You can save generated reports for your future use. These
saved reports are stored in the My Reports tab. Use this
section to view the saved reports or modify the parameters
of the saved reports and generate new reports out of them.
You can also delete the saved reports using the My Reports
tab.

See “About managing My Reports” on page 19.

See “Saving an OpsCenter report” on page 13.

My Dashboard tab Your saved reports are preserved in My Reports tab, which
you can select and publish on My Dashboard tab. You can
select multiple reports and add them in the same dashboard
section. Thus, you can create multiple dashboard section
containing a number of reports.

See “About managing My Dashboard” on page 22.

Schedules tab This tab contains all report schedules.
You can create, edit, or delete schedules using this tab.

See “Using report schedules in OpsCenter” on page 29.

Manage Folders tab Use this tab to manage folders where you have saved your
reports.

See “About managing reports folders in OpsCenter”
on page 25.

Report creation wizards in OpsCenter

OpsCenter provides wizards, which guide you through the entire report creation
procedure.

8
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To create a report, in the OpsCenter console on the Reports tab, click Create New
Report. The following report creation options are available on the Select Report
Creation Option panel:

= Create a report using an existing Report Template .
See “Creating an OpsCenter report using a Report Template” on page 40.

= Create a custom report.
See “Creating a custom report in OpsCenter” on page 333.

= Create a report using SQL Query.
See “Creating an OpsCenter report using SQL query” on page 346.

Reports > Report Templates

This section provides details of the Report Templates that are available in
OpsCenter.

OpsCenter provides a number of Report Templates (or standard or canned reports)
that you can modify and generate a new report of that kind.

In the OpsCenter console, when you click the Reports tab, the Report Templates
home page is displayed.

From the Reports > Report Templates page, you can click any of the Report
Templates to view the respective report with default parameter values.

You can also click the following options on the Reports > Report Templates page:

Create New Report Click Create New Report to create a standard report, custom report,
or run an SQL query.

Edit Report If you do not want to run a report template with default parameter
values, you can directly edit it from Reports > Report Templates
page. To edit a report template, first select the report template by
selecting the checkbox on the extreme left of the report template.
Click Edit Report to edit and save the report without executing it.

Figure 1-1 shows various components of a report that is generated using a template.
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This tree lists all Report Templates that are
available in OpsCenter.

Use this toolbar to save, export, or email the
generated report.

Use these time filters to view the data for a
specific period of time:

OpsCenter reports are displayed here.

Reports can be viewed in different forms or
views, Distribution, Historical, or Ranking.
Use these options to change the current
report view. These options are available only
for chart-based reports.

reports in OpsCenter Analytics

Apart from generating reports using the existing templates, you can also create
custom reports in OpsCenter by changing the report parameters as required.

See “Creating a custom report in OpsCenter” on page 333.

10



Reporting in OpsCenter | 11
About managing reports in OpsCenter

About custom SQL query in OpsCenter Analytics

In OpsCenter, you can create reports by directly running SQL queries. Using this
report creation option, you do not need to go through multiple parameter selections.

OpsCenter provides detailed information about the OpsCenter database schema
that you may want to know before running any SQL query to generate reports. On
the Report Wizard > SQL Query page, click the OpsCenter Schema Document link
to open the PDF that contains all relevant information.

Note: You can create only tabular reports by running SQL queries. You can also
run stored procedures using this feature.

See “About supporting OpsCenter custom reports and custom SQL queries”
on page 11.

See “Creating an OpsCenter report using SQL query” on page 346.

About supporting OpsCenter custom reports and custom SQL queries

OpsCenter is committed to provide the accuracy and validity of the data collected
and stored in its database and the documentation of its database schema. However,
no Technical Support will be provided on the actual creation of custom reports,
custom SQL queries for specific reports, or for 3rd party reporting applications (for
example, Microsoft Excel, Access, or Crystal Reports).

See “About custom reports in OpsCenter Analytics” on page 10.

See “About custom SQL query in OpsCenter Analytics” on page 11.

About managing reports in OpsCenter

This section provides information on the operations that you can carry out on the
standard reports that you generate in OpsCenter.

You can carry out the following operations:

= Saving a report
See “Saving an OpsCenter report” on page 13.
= Exporting a report
See “Exporting an OpsCenter report” on page 14.

= Emailing a report
See “Emailing a report in OpsCenter” on page 16.
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Save report and email report dialog boxes

A description of the Save report and Email report dialog box options follows in

the table.

Table 1-1

Save report dialog box options

Option

Description

Report name

Enter the report name. For example, if you generated the
Job Count standard report with the group by option that is
selected as Policy Type and report view as Historical, you
can name this report NumberofJobsbyPolicies.

When you select this report on the Saved Reports tab, the
report is displayed with the saved filters and in the report
view that were selected when the reports were saved, with
respect to the current time.

Review the following points about report names:

= The report name must be unique in the folder where you
create it. For example, if you create a report in the Private
Reports folder under My Reports, the report name that
you specify must be unique in the Private Reports folder.
The same user can have two reports with the same name
- like one in Public Reports and one in Private Reports
folder.

= The report name must not contain any special characters
like (/\*?]")

s The report name must not be more than 220 characters.

Description

Enter the short description for the report.

Folder

Select Public or Private folder. If you save the report in a
public folder, all other OpsCenter users can view it. If you
save the report in a private folder, only you can view it.

Expand the Public or Private folder and select a folder where
you want to save the report. Depending on the folder type
that you have selected - public or private - the folders
displayed for selection vary.

Create New

Click this option to create a new public or private folder.
Clicking this option changes the view of Folder. Enter the
folder name and click OK.

This folder is made available in the Folder tree for selection.
Select this newly created folder where you want to save the
report.

12
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Save report dialog box options (continued)

Option

Description

Overwrite if report already
exists in the selected folder

Select this check box if you want to overwrite the existing
report with the same name in the same folder. If you do not
select this check box and save a report with a name identical
to any of the existing reports in the selected folder, a
confirmation message is displayed before you overwrite the
existing report.

Table 1-2

Email report dialog box options

Option

Description

Select Format

Select one of the following formats:

= PDF
= HTML
= CSV
= TSV
= XML

Note: Some of these formats may not be available for
specific reports. For example, the Drive Throughput and Drive
Utilization reports can be exported and emailed only in the
HTML format.

Select Content

Select one of the following report formats:

n Distribution
= Historical

= Ranking

= Tabular

Distribution, Historical, and Ranking formats are available
only for chart-based reports.

Email

Enter appropriate email details like address, subject, and
message.

Saving an OpsCenter report

You can save a standard report. This action saves the filters that you have selected

while generating a report. You can use this set of filters to regenerate the reports
with the current time selections.

13
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These reports are saved in the OpsCenter database, which you can view using the
My Reports tab.

You cannot save a report whose name contains any special characters like (/\ * ?
1)

See “About managing My Reports” on page 19.

To save a report

1 Inthe OpsCenter console, click Reports > Report Templates.

2 From the Reports tree, select the report template that you want to save.

3 In the right-hand report view area, click the Save As Report icon. The Save
Report pop-up screen opens.

4 On the Save Report screen, enter the required details.
See “Save report and email report dialog boxes” on page 12.
5 Click OK.

After a successful save, My Reports tab is displayed with this report selected.

Note: You cannot save a report name that contains special characters like (/
\ * 7 | ll)

Exporting an OpsCenter report
Using OpsCenter, you can preserve report data in files or print the data.
See “ File formats available in OpsCenter” on page 15.

You can open the exported file using other applications, such as a spreadsheet
program or a text editor.

To export a report
1 Inthe OpsCenter console, click Reports > Report Templates.

You can also export reports that you may have created from Reports > My
Reports.

2 From the Reports tree, select the report template or report that you want to
export.

3 Inthe report view area at the right-hand side, click the Export Report icon.
The Export Report pop-up screen opens.
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4 On the Export Report pop-up screen, select the export options that you want
to export the report with: File format, such as PDF, HTML, CSV, TSV, or XML
and content or report view, such as Tabular, Distribution, Historical, or
Ranking.

Note that only the applicable formats and report views appear for specific
reports.

See “Save report and email report dialog boxes” on page 12.

5 Click OK. The system displays the export options pertaining to the file format
you have selected. Select those options and export the report.

File formats available in OpsCenter

You can export or email OpsCenter reports in the following file formats:

PDF (Portable Can be viewed using a PDF reader, such as Adobe Reader
Document Format)

csv Use with spreadsheet programs, such as Microsoft Excel.
(comma-separated

values)

TSV (tab-separated Compatible with word-processing applications and text editors

values)

HTML (hypertext Can be opened using with Web browsers

markup language )

XML (Extensible Can be imported (using user-written scripts) by other programs like
Markup Language) databases or billing applications.

The following is the XML format:

<Report>
<ReportView>
<Name> {nameValue} </Name>
<Description> {descriptionForReportView} </Description>

<TimeDuration> {timeValue} </TimeDuration>

<ViewName> {viewNameValue} </ViewName>

<ViewSelections>

<SelectedItem value="{selectedNodeNameValuel}">
<ExcludedItem> {excludedNodeNamel} </ExcludedItem>
<ExcludedItem> {excludedNodeName2} </ExcludedItem>
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</SelectedItem>

<SelectedItem value="{selectedNodeNameValue2}">
<ExcludedItem> {excludedNodeName3} </ExcludedItem>
<ExcludedItem> {excludedNodeNamed} </ExcludedItem>

</SelectedItem>
</ViewSelections>
<Table>
<Header>
<Row>..</Row>
</Header>
<Rows>
<Row>..</Row> ..
</Rows>
</Table>

</ReportView>
<ReportView>

</Report>

In the new format <Table> has been moved under a new tag called <ReportView>.
If multiple views (distribution, historical, ranking) are selected for export or email,
each of the views will have one <ReportView> tag corresponding to it. Name,
Description and TimeDuration tags inside ReportView tag will always be present
for each view. However, ViewName, GroupBy, and ViewSelections tags will be
present only if applicable. If report is edited and view selections are changed, these
tags will be added in export.

Emailing a report in OpsCenter

Using OpsCenter, you can email report data to the selected recipients. You can
email a report in a number of different file formats.

See “ File formats available in OpsCenter” on page 15.
To email a report
1 Inthe OpsCenter console, click Reports > Report Templates.

You can also export reports that you may have created from Reports > My
Reports.

2 From the Reports tree, select the report template or the report that you want
to email.
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In the report view area at the right-hand side, click the Email Report icon. The
Email Report pop-up screen opens.

See “Save report and email report dialog boxes” on page 12.

On the Email Report pop-up screen, select the email options: File format, such
as PDF, HTML, CSV, TSV, or XML and content or report view, such as Tabular,
Distribution, Historical, or Ranking

Note that only the applicable formats and report views appear for specific
reports.

Enter email IDs in To, Cc, and Bcc text boxes, to which you want to send
emails.

If these email IDs do not already exist, they are automatically added to the
database.

Alternatively, you can add existing email recipients.
See “Adding email recipients to an OpsCenter report mailing” on page 18.
Enter the subject of the email.

Enter the message that may be a short description regarding the report data
that you want to email.

Click OK.

Configuring number of rows in a tabular report for email or export

When you export, email, or schedule a tabular report, 4000 rows are exported by
default.

You can configure the maximum number of rows in a tabular report that you can
export or email.

To configure the maximum number of rows for export

1
2

Log on to the OpsCenter Server.

Stop all the OpsCenter Server services or processes by using the following
commands on Windows and UNIX:

Windows INSTALL_PATH\OpsCenter\server\bin\opsadmin.bat stop

UNIX <INSTALL_PATH>/SYMCOpsCenterServer/bin/opsadmin.sh stop

17
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3 Navigate to the following location:

Windows C:\Program Files\Symantec\OpsCenter\server\config

UNIX <INSTALL_PATH>/SYMCOpsCenterServer/config

4 Open the report.conf file.

You may want to export all the rows or you may want to increase or decrease
the maximum value. Note that if you export all rows or increase the number of
rows, exporting a report may take time when there are a large number of rows.

= To export all the rows, you can either comment out
report.schedule.max.tabular.rows parameter or specify any value less
than or equal to -1 for report.schedule.max.tabular.rows parameter.
To comment out report.schedule.max.tabular.rows parameter, add
two forward slashes before the parameter in this manner:

//report.schedule.max.tabular.rows=4000
or
Edit the value 4000 in report.schedule.max.tabular.rows=4000 to -1.

report.schedule.max.tabular.rows=-1

= To change the maximum number of rows to say 5000, you can set the value
of report.schedule.max.tabular.rows as 5000.

Configure report.schedule.max.tabular.rows=5000
6 Start all OpsCenter Server services or processes by using the following
command for Windows and UNIX:
Windows INSTALL_PATH\OpsCenter\server\bin\opsadmin.bat start

UNIX <INSTALL_PATH>/SYMCOpsCenterServer/bin/opsadmin.sh start

Adding email recipients to an OpsCenter report mailing

This section provides information on how to add email recipients to whom you want
to send emails. This procedure assumes you've already started the email report
procedure. More information is available about this procedure.

See “Emailing a report in OpsCenter” on page 16.
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To add email recipients

1 Onthe Add Email Recipients screen, select the check boxes in front of the
email recipients to whom you want to send emails.

See “Add email recipients dialog box options” on page 19.

Click To.., Cc.., or Bcc.. depending on where you want to add the selected
recipients.

2 Click OK.

Add email recipients dialog box options

Table 1-3 Add email recipients dialog box options
Option Description
Recipient Name/Email Select the check boxes in front of the email recipients to
Address whom you want to send emails.
To...ICc.../Bcc... Click To.., Cc.., or Bcc.. depending on where you want to
add the selected recipients.

About managing My Reports

You can save generated reports for your future use. These saved reports are stored
in the My Reports tab. Use this section to view the saved reports or modify the
parameters of the saved reports and generate new reports out of them. You can
also delete the saved reports using the My Reports tab.

The following topics provide more information about managing reports.
See “ Creating a report using the My Reports tab” on page 19.

See “Deleting a saved report using the My Reports tab” on page 20.
See “Viewing a saved report using the My Reports tab” on page 20.
See “Editing a saved report using the My Reports tab” on page 20.
See “Exporting a saved report” on page 21.

See “Emailing a saved report” on page 21.

Creating a report using the My Reports tab

This section provides the procedure to create a report using My Reports tab.
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To create a report using the My Reports tab

1
2

In the OpsCenter console, click Reports > My Reports.

On the My Reports tab, click Create New Report.

You can create a report in any of the following ways:

See “Creating an OpsCenter report using a Report Template” on page 40.
See “Creating a custom report in OpsCenter” on page 333.

See “Creating an OpsCenter report using SQL query” on page 346.

Deleting a saved report using the My Reports tab

This section provides the procedure to delete a saved report.

To delete a saved report

1
2

In the OpsCenter console, click Reports > My Reports.

On the My Reports tab, in the Reports list, expand a report folder to view the
reports that are saved within it.

Select the check box in front of the report name.

Click Delete.

Viewing a saved report using the My Reports tab

You can view the saved reports using the My Reports tab.

To view a saved report

1
2

In the OpsCenter console, click Reports > My Reports.

On the My Reports tab, in the Reports list, expand a report folder to view the
reports that are saved within it. Select the saved report that you want to view.

Editing a saved report using the My Reports tab

You can edit a saved report. You can edit the report details, such as the report
name or the folder where you want to save the edited report.

To edit a saved report

1
2

In the OpsCenter console, click Reports > My Reports.

On the My Reports tab, in the Reports list, expand a report folder to view the
reports that are saved within it. Select the saved report that you want to edit.

In the report view area at the right-hand side, click the Save As Report icon.
The Save Report pop-up screen opens.

20



Reporting in OpsCenter | 21
About managing My Reports

4 On the Save Report screen, enter the required information.
See “Save report and email report dialog boxes” on page 12.

5 Click OK.

Exporting a saved report

Using OpsCenter, you can preserve saved report data in files or print the data. You
can email a report in a number of different file formats.

See “ File formats available in OpsCenter” on page 15.

You can open the exported file using other applications, such as a spreadsheet
program or a text editor.

To export a saved report
1 Inthe OpsCenter console, click Reports > My Reports.

2 Onthe My Reports tab, in the Reports list, expand a report folder to view the
reports that are saved within it. Select the saved report that you want to export.

3 Inthe report view area at the right-hand side, click the Export Report icon.
The Export Report pop-up screen opens.

4 On the Export Report pop-up screen, select the export options that you want
to export the report with. Select file format, such as PDF, CSV, or XML and
content or report view, such as Distribution, Historical, or Ranking.

5 Click OK. The system displays the export options pertaining to the file format
you have selected. Select those options and export the saved report.

Emailing a saved report

Using OpsCenter, you can email the saved report data to the selected recipients.
You can email the report in the following file formats:

PDF (Portable Can be viewed using a PDF reader, such as Adobe Reader
Document Format)

csv Use with spreadsheet programs, such as Microsoft Excel.
(comma-separated

values)

TSV (tab-separated Compatible with word-processing applications and text editors
values)

HTML (hypertext Can be opened using with Web browsers
markup language )
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XML (Extensible Can be imported (using user-written scripts) by other programs like
Markup Language) databases or billing applications

To email a report

1 Inthe OpsCenter console, click Reports > Saved Reports.

2 Onthe My Reports tab, in the Reports list, expand a report folder to view the
reports that are saved within it. Select the saved report that you want to email.

3 Inthe report view area at the right-hand side, click the Email Reporticon. The
Email Report pop-up screen opens.

4  Onthe Email Report pop-up screen, select the email options: File format, such
as PDF, CSV, or XML and content or report view, such as Distribution,
Historical, or Ranking.

5 Enter email IDs in To, Cc, and Bcc text boxes, to which you want to send
emails.

Enter the subject of the email.

Enter the message that may be a short description regarding the report data
that you want to email.

8 Click OK.

About managing My Dashboard

Your saved reports are preserved in My Reports tab, which you can select and
publish on My Dashboard tab. You can select multiple reports and add them in
the same dashboard section. Thus, you can create multiple dashboard sections
containing a number of reports.

You can add only 10 reports in a dashboard.

See “Adding reports to a dashboard” on page 23.
See “Modifying a dashboard section” on page 23.
See “Deleting a dashboard section” on page 24.
See “Emailing dashboard sections” on page 24.

See “Refreshing My Dashboard” on page 25.
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Reports > My Dashboard options

Select and publish reports on My Dashboard tab. You can select multiple reports
and add them in the same dashboard section. Thus, you can create multiple
dashboard sections containing a number of reports.

You can add only 10 reports in a dashboard.

Table 1-4 Reports > My Dashboard options

Option

Description

Add/Edit/Delete

You can add multiple Dashboards on this page and one or
more reports from My Reports to each of the dashboards.
Use Add, Edit, Delete tasks to add, edit, or remove dashboard

Email Dashboard

Select this option if you want to email all the dashboard
reports.

In the Email Dashboard dialog box that opens, you can
specify the format in which you want to email the dashboard
reports.along with the other email details. Click OK.

Refresh Dashboard

Select this option to update the reports in the dashboard.

Adding reports to a dashboard

This section provides the procedure to add reports to a dashboard.

To add reports to a dashboard

In the OpsCenter console, click Reports > My Dashboard.

2 Click Add.
3
4
5
on the dashboard.
6 Click OK.

Modifying a dashboard section

On the Add Dashboard Section pop-up screen, enter the section name.
Expand the Private or Public Reports folder to view existing reports.

Select the check boxes in front of the report names, which you want to publish

This section provides the procedure to modify dashboard section.
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To modify a dashboard

1
2
3

In the OpsCenter console, click Reports > My Dashboard.
Click Edit.

On the Edit Dashboard Section pop-up screen, select the dashboard section
from the drop-down list, that you want to modify.

Modify the section name.
Expand the Private or Public Reports folder to view existing reports.

Select or clear the check boxes in front of the report names, which you want
to publish on or remove from this dashboard section.

Click OK.

Deleting a dashboard section

This section provides the procedure to delete a dashboard section.

To delete a dashboard section

1
2
3

4

In the OpsCenter console, click Reports > My Dashboard.
Click Delete.

On the Delete Dashboard Section pop-up screen, select the dashboard
section from the drop-down list, that you want to delete.

Click OK.

Emailing dashboard sections

You can email your dashboards.

To email a dashboard

1
2
3

In the OpsCenter console, click Reports > My Dashboard.
Click the Email Dashboard icon.

On the Email Dashboard pop-up screen, select the format in which you want
to send the email.

Select email recipients from the To.., Cc.., and Bcc.. as appropriate.
Alternatively, enter new email recipients, which are added into the database.
Enter the email subject and message.

Click OK.



Reporting in OpsCenter | 25
About managing reports folders in OpsCenter

Refreshing My Dashboard
This section provides the procedure to refresh My Dashboard.
To refresh My Dashboard
1 Inthe OpsCenter console, click Reports > My Dashboard.
2 Click the Refresh icon.

About managing reports folders in OpsCenter

OpsCenter provides a way to manage folders where you have saved your reports.
They can be both private reports and public reports.

Using the Manage Folders tab in the Reports section, you can add new report
folders, edit names of the existing folders, or delete them.

You can also select reports in a particular folder and delete them using this tab.
See “Adding a reports folder in OpsCenter” on page 25.
See “Editing a reports folder in OpsCenter” on page 26.
See “Deleting reports folders in OpsCenter” on page 26.

See “Deleting reports from a folder in OpsCenter” on page 26.

Reports > Manage Folders options

Using the Manage Folders tab in the Reports section, you can add new report
folders, edit names of the existing folders, or delete them.

Adding a reports folder in OpsCenter
This section provides a procedure to add a report folder.
To add a folder
1 Inthe OpsCenter console, click Reports > Manage Folders.

2 On the Reports tree, select a check box in front of a private folder node or
public folder node in which you want to create a new folder.

3 Click Add.

In the Create new folder pop-up window, make sure that you have selected
only one folder. If multiple folders are selected, the Add option is disabled.
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Enter the folder name.
Click OK.

This folder is added in the selected node.

Editing a reports folder in OpsCenter

This section provides a procedure to edit a report folder.

To edit a folder

1
2

In the OpsCenter console, click Reports > Manage Folders.

On the Reports tree, select a check box in front of a private folder or public
folder that you want to edit.

Click Edit.

In the Edit folder name pop-up window, make sure that you have selected
only one folder. If multiple folders are selected, the Edit option is disabled.

Edit the folder name.

Click OK.

Deleting reports folders in OpsCenter

This section provides a procedure to delete a report folder. If you delete a report
folder, all reports that are saved in that folder are deleted.

To delete folders

1
2

In the OpsCenter console, click Reports > Manage Folders.

On the Reports tree, select a check boxes in front of the private folders or
public folders that you want to delete.

Click Delete.

Deleting reports from a folder in OpsCenter

This section provides a procedure for deleting the reports that are saved in a public
folder or private folder.

To delete reports from a folder

1
2

In the OpsCenter console, click Reports > Manage Folders.

On the Reports tree, select a private folder or public folder from which you
want to delete the reports. A list of reports that are saved in the selected folder
displays at the right-hand side of the page.
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3 From the list of reports, select the check boxes in front of the reports that you
want to delete.

4 Click Delete.

About managing report schedules in OpsCenter

NetBackup OpsCenter provides a way to export or email a report on a specific
schedule. For this task you need to create a report schedule that is associated with
a time schedule on which the specified reports are exported or emailed.

Each report schedule can be associated with a single time schedule. A single time
schedule can be associated with multiple report schedules.

See “About managing time schedules in OpsCenter” on page 34.

The following topics describe how to create and manage report schedules.
See “Viewing report schedule details in OpsCenter” on page 28.

See “Creating a report schedule in OpsCenter” on page 32.

See “Editing a report schedule in OpsCenter” on page 33.

See “ Deleting a report schedule in OpsCenter” on page 33.

See “Enabling or disabling a report schedule” on page 34.

Reports > Schedules options

Using report schedules, you can email or export reports at a scheduled time. Each
report schedule is associated with a time schedule at which it emails or sends the
specified reports.

Table 1-5 Report Schedules tab options
Option Description
Add/Edit Select Add or Edit to start the Report Schedule Wizard.
Delete Select Delete to remove the selected report schedules.
Enable/Disable Select Enable or Disable to enable or disable the selected

report schedules.

Name Name of a report schedule.
Time Schedule Name Name of a time schedule that is associated with this report
schedule.

Enabled Specifies whether the report schedule is enabled or not.
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Table 1-5 Report Schedules tab options (continued)
Option Description
Start Date Date on which this schedule runs.
End Date Date on which this schedule stops.
Export Specifies whether you have exported the associated reports.
Email Specifies whether you have emailed the associated reports.
Reports Number of the reports that are exported or emailed when this

schedule runs.

Table 1-6 Time Schedules tab options

Option Description

Add/Edit Select Add or Edit to go to the Time Schedule page.
Delete Select Delete to delete the selected time schedules.

Name Name of the time schedule.

Schedule Time Time when the associated reports are exported or emailed.
Recurrence Pattern A pattern with which this schedule runs.

Start Date Date when the schedule starts.

End Date Date when the schedule stops.

Viewing report schedule details in OpsCenter
This section provides information on viewing the list of report schedules.

If you have applied conditions for the selected report, the list of applicable conditions
is shown on the last page of the wizard. You can select the appropriate conditions.
An email notification is sent to the relevant recipients if the selected condition is
satisfied.

To view report schedule details
1 In the OpsCenter console, click Reports > Schedules.
By default, the Report Schedules tab is selected.
2 On the Report Schedules tab, view the report schedule details.

See “Reports > Schedules options” on page 27.
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Using report schedules in OpsCenter

Using report schedules, you can email or export reports at a scheduled time. Each
report schedule is associated with a time schedule at which it emails or sends the

specified reports.

OpsCenter provides a wizard to create a report schedule.

See “Creating a report schedule in OpsCenter” on page 32.

The following table describes the steps that you need to carry out to email or export

a report on a specific schedule.

See “About managing time schedules in OpsCenter” on page 34.

Table 1-7

Creating a report schedule

Step Step and reference topic

Number

1 Create a time schedule.

See “Creating a time schedule” on page 35.

2 Create a report schedule.

OpsCenter provides a wizard to create a report schedule. This wizard lets you
specify the following details:

Report schedule name

File format in which you want to email or export reports

Select a time schedule.

You can either select an existing time schedule that you have created in the
first step or create a new schedule from here to associate it with this report
schedule.

Specify details of export or email options.

Select the reports that you want to export or email on a specific schedule.

Note: You can select only saved reports in a schedule.

See “Creating a report schedule in OpsCenter” on page 32.

Table 1-8
Steps Reference topic
€ Create a time schedule. See “Creating a time schedule” on page 35.
Create a time schedule.
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Table 1-8 (continued)

Steps

Reference topic

¢ Create a report schedule.

Create a report schedule.

OpsCenter provides a wizard to create a
report schedule. This wizard lets you specify
the following details:

Report schedule name

File format in which you want to email or
export reports

Select a time schedule.

You can either select an existing time
schedule that you have created in the first
step or create a new schedule from here
to associate it with this report schedule.
Specify details of export or email options.
Select the reports that you want to export
or email on a specific schedule.

Note: You can select only saved reports
in a schedule.

See “Creating a report schedule in
OpsCenter” on page 32.

Report Schedule Wizard

The Report Schedule Wizards contains five panels to help you create a schedule.

Table 1-9

Enter Report Schedule Details panel options

Option Description

Report Schedule Name

Enter a report schedule name. This field must be filled.

Select Format

Select a file format in which you want to export or email report
the associated reports.

See “ File formats available in OpsCenter” on page 15.

Table 1-10

Select Time Schedule panel options

Option Description

Create new Time Schedule

Select this option if you want a new time schedule to be
associated with the report schedule.
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Table 1-10 Select Time Schedule panel options (continued)
Option Description
Use existing Schedule Select this option if you want the report schedule to be

associated with an existing time schedule

Table 1-11 Select Export/Email Report Options panel options
Option Description
Export Select this check box if you want to export the reports that

are associated with this schedule.

See “ File formats available in OpsCenter” on page 15.

Location Enter a directory path where you want to save the exported
report or click Browse to select the desired location.

Overwrite if file exists Select this check box if you want to overwrite a file that
already exists at the specified location.

Email Select this check box if you want to email the reports that are
associated with this schedule.

To Select email IDs to which you want to email reports.

Cc Select email IDs to add in the Cc list of email.

Bcc Select email IDs to add in the Bcec list email.

Subject Type the email subject. For example: Daily Job Count Report
Message Type any other related information.
Table 1-12 Select Reports panel options

Option Description

Private Reports Select private reports from the list that you want to schedule.

You can select both public reports and private reports.

Public Reports Select public reports from the list that you want to schedule.
You can select both public reports and private reports.
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Table 1-13 Select a report condition to be applied panel options

Option Description

Send email only if the Check this option if you want the report to be emailed only if

report meets one or more | it meets one or more of the selected conditions. You can

selected conditions create conditions for custom reports while editing the report.

Report Name The custom reports that have conditions and are selected to
be scheduled are displayed.

Condition The condition that is associated with the custom report is
displayed. You can create a condition only for custom reports.

Creating a report schedule in OpsCenter
To create a report schedule
1 Inthe OpsCenter console, click Reports > Schedules.

2 On the Report Schedules tab, click Add. OpsCenter provides a Report
Schedule Wizard that guides you through the procedure of creating a report
schedule.

The Enter Report Schedule Details panel appears.
Enter the report schedule details.
See “Report Schedule Wizard” on page 30.
3 Click Next.
The Select Time Schedule panel appears:

Select the Use existing schedule option if you want to run this schedule on
any existing time schedule. If you want to create a new time schedule for this
report schedule, select Create new time schedule.

See “Creating a time schedule” on page 35.

If you have selected Create new time schedule, the system takes you to the
Time Schedule Wizard. After creating a time schedule you can select the export
and the email report options.

4  Click Next.

If you have selected the Use existing schedule option in the previous step,
in the Configure Export/Email Report Settings panel, specify the following
details:

You can select either Export, Email, or both options.

See “Report Schedule Wizard” on page 30.
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Click Next.

In the Select Reports panel, select the public reports or private reports that
you want to export or email on this schedule.

These reports should be saved.
Click Back if you want to change the previous selections.

In the Select a report condition to be applied panel, select a report and
report condition to be applied. You can apply report conditions to custom
reports.

You can also select the option Send email only if the report meets one or
more of the selected conditions if you want the report to be emailed only
when the report meets one or more of the selected conditions.

Click Save.

Editing a report schedule in OpsCenter

This section describes how to edit report schedule details.

To edit a report schedule

1

In the OpsCenter console, click Reports > Schedules.
By default, the Report Schedules tab is selected.

On the Report Schedules tab, select a report schedule from the list that you
want to edit.

Click Edit.
Edit the report schedule details using the wizard.
Click Save.

Deleting a report schedule in OpsCenter

This section describes how to delete a report schedule.

To delete a report schedule

1

In the OpsCenter console, click Reports > Schedules.
By default, the Report Schedules tab is selected.

On the Report Schedules tab, select one or more report schedules from the
list that you want to delete.

Click Delete.
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Enabling or disabling a report schedule
This section describes how to enable or disable a report schedule.
To enable or disable a report schedule
1 Inthe OpsCenter console, click Reports > Schedules.
By default, the Report Schedules tab is selected.

2 On the Report Schedules tab, select one or more report schedules from the
list that you want to enable or disable.

3 Click Enable or Disable.

About managing time schedules in OpsCenter

This section provides procedures to create and manage a report schedule.

Each report schedule can be associated with only a single time schedule. A single
time schedule can be associated with multiple report schedules.

See “About managing report schedules in OpsCenter” on page 27.

The following topics provide more information about managing time schedules.
See “Viewing time schedule details” on page 35.

See “Creating a time schedule” on page 35.

See “Editing a time schedule” on page 35.

See “Deleting a time schedule” on page 36.

Reports > Schedules > Create or Edit Time Schedule options

Use the page to create or edit a time schedule.

Table 1-14 Create or Edit Time Schedule options
Option Description
Schedule Name Enter name of the time schedule.
Schedule Time Enter the time when the schedule runs and the associated
reports are exported or emailed.
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Table 1-14 Create or Edit Time Schedule options (continued)
Option Description
Schedule Pattern Select a pattern with which you want this schedule to be run.

The following schedule patterns are available:

x  One Time
= Daily

s Weekly

= Monthly

»  Quarterly
s Yearly

Depending on the pattern-selected , options change.

Viewing time schedule details
This section provides a procedure to view the details of time schedules.
To view a time schedule
1 Inthe OpsCenter console, click Reports > Schedules.
2 Click Time Schedules.
The time schedule details appear:

See “Reports > Schedules options” on page 27.

Creating a time schedule
Use the following procedure to create a time schedule.
To create a time schedule

In the OpsCenter console, click Reports > Schedules.

2 Click Time Schedules.
3 Onthe Time Schedules tab, click Create.
4 On the Create Time Schedule page, specify the necessary details.
See “Reports > Schedules > Create or Edit Time Schedule options” on page 34.
5 Click OK.

Editing a time schedule

Use the following procedure to edit a time schedule.
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To edit a time schedule

In the OpsCenter console, click Reports > Schedules.
Click Time Schedules.

On the Time Schedules tab, in the table, select the time schedule that you
want to edit.

Click Edit.
Edit the time schedule details.

Click OK.

Deleting a time schedule

Use the following procedure to delete a time schedule.

To delete a time schedule

1
2
3

In the OpsCenter console, click Reports > Schedules.
Click Time Schedules.

On the Time Schedules tab, in the table, select the time schedules that you
want to delete.

Click Delete.
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This chapter includes the following topics:
= Report Templates in OpsCenter

= About Report Templates descriptions

Report Templates in OpsCenter

OpsCenter provides a set of Report Templates or standard or canned reports that
have parameters set to default values. You can modify the default parameters and
generate reports to view the required data. OpsCenter reports help you to have a
good visibility into your data protection environment.

See “Reports > Report Templates” on page 9.

Report Templates are categorized as follows:

Backup Reports The backup reports show the information that
is related to backups, such as success rate,
job status, and protected bytes.

This category also includes recovery reports.

Note: If you select Reports > Activity
Planning > Job Size in the OpsCenter user
interface, the report that appears displays the
wrong client name. Instead of showing the
client names, a list of backed up VM images
is displayed in this report. In addition, the list
of VM images may not be accurate.

Catalog Reports These reports provide details about the
catalogs.



Chargeback Reports

Client Reports

Cloud Reports

Disk & Tape Device Activity Reports

Media Reports

Performance Reports

Policy Reports

Restore Reports
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The chargeback reports provide details of the
backup services expenditures.

Using these reports you can track the backup
and the recovery usage and the associated
cost. You can calculate the cost of data
protection management and chargeback to
customers and business units.

These reports provide details about clients
such as backup status, restore job details, or
summary dashboard.

These reports provide details about
NetBackup cloud storage servers.

The following cloud providers are supported
by OpsCenter:

Note: Among all Amazon S3-compatible
cloud providers that NetBackup supports,
OpsCenter supports monitoring and reporting
of Amazon (S3) and Amazon GovCloud (S3)
providers only.

If you have configured cloud storage servers
for AT&T or Rackspace providers and
upgraded to 8.1.2, stale information is
displayed in cloud reports for AT&T and
Rackspace providers.

Disk-based data protection (DBDP) reports
show disk pool capacity and its usage,
performance of clients on LAN or SAN,
NetBackup storage lifecycle Map

These reports provide media data, such as
tape count or usage.

These reports provide details of throughput.

These reports show all details about the
backup job policies in NetBackup.

These reports provide details about restore
operation.
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About report filters in OpsCenter
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The SLP reports in OpsCenter show an
end-to-end view of the SLP process that
includes backup to import of duplicated image
into different NetBackup domains. The SLP
reports help you to verify if each step in the
SLP is executed and identify the possible
bottlenecks.

The Workload Analyzer report gives
information about the activities that are done
across a period of seven days. The activities
are number of jobs running at a given period
of time and the amount of data that is
transferred during this period. The report
contains 168 data points of analysis in terms
of the activities that are done for each hour
for a period of seven days.

There can be hundreds of records or thousands of MB of the data that you may not
be concerned about. For example, you want to view only those jobs that were
successful. To view this specific data, you need to use the ‘status’ filter. By setting
this filter to Successful while generating the Job Count report, you can view all

jobs that were successful.

OpsCenter provides a number of filters that you can use to view the required data.
For each report category there is a different set of filters.

Note the following considerations with respect to using the report filters:

= Ifyou edit certain standard reports and select Backup from Snapshot Job type
from the Filters section, incorrect data is shown if data for Backup from Snapshot
jobs exists. This also happens when you create image-related reports via custom
reporting and apply Backup from Snapshot job type filter.
The following standard reports display incorrect data when you select Backup
from Snapshot job type from the Filters section:

= Backup > Planning Activity > Stored Backup Images > Duplicate copies

= Backup > Planning Activity > Stored Backup Images > Stored Backup Images

on Media

= Backup > Planning Activity > Stored Backup Images > Valid Backup Images

= Backup > Planning Activity > Capacity Planning > Forecasted Size

= Backup > Planning Activity > Capacity Planning > Historical Size
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The Backup Media Role filter when applied to the Tapes Expiring In Future and
Tapes Expiring Now reports does not return any data as data is miscalculated
in OpsCenter.

Creating an OpsCenter report using a Report Template

This section provides the procedure to create a report using an existing Report
Template .

To create a report using an existing Report Template

1
2

In the OpsCenter console, click Reports.
On the Report Template tab, click Create New Report.

To view a report output of a template, select a template in the reports tree. The
report output is as per the default parameter values. You cannot modify any
of the report parameters.

By clicking the Create New Report option, you can launch the report creation
wizard that guides you through the entire report creation procedure. Here you
can modify the report parameters and view the required data.

In the Report Wizard, retain the default selection Create a report using an
existing Report Template and click Next.

On the Report Templates list, expand a report category to see the Report
Templates within it. Select the Report Template that you want to create a report
from.

Click Next.
Select time frame and other filters as required and click Next.

Modify display options and click Next.

Using report formats

The following formats are available for standard reports in OpsCenter.

About report formats

Report formats are described as follows:

Rankings reports Display a horizontal bar graph showing all the data for each view

level object, from greatest to least, within the selected time frame.

Distribution reports Display a pie chart showing all the data for each view level object

within the selected time frame.
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Historical reports Display a stacked (segmented) bar graph with a trend line
superimposed over it, showing the average upward and downward
trends of the data over time.

For example the total size of each day’s backup jobs broken out
by geography. Some backup reports use a different bar chart format,
displaying clustered columns for easy comparison between two
classes of objects or events

Tabular reports Display backup data in a table

About viewing data in a graphical report

Graphical reports present data in a convenient, ‘at a glance’ fashion. However,
some precision may be lost when you use this format. When you are viewing a
graphical report, tool tips are available to provide the precise numerical data. To
view the numerical data on which a graphical report is based, move your mouse
pointer over an area of the graph.

You can also click Show Chart as Table at the bottom of the report to view the
data in a tabular format.

When you are viewing a backup report, you can easily view lower-level reports. On
a graphical report, when you click an area within a graph, the report refreshes to
display data for the next lowest object level.

For example, in a Geography view, you can click a bar labeled Canada to display
a bar chart showing data for Toronto and Vancouver. You can select the bar for a
host to display data for the host’s file systems.

About Report Templates descriptions

This section provides descriptions of all Report Templates available in OpsCenter.
A few important notes on the OpsCenter Report Templates :

= The Drive Throughput, and Drive Utilization reports can be exported and emailed
only in the HTML format.
The Drive Throughput and Drive Utilization reports display data only till 1 A.M.
and not till the time when you run the report. This is because OpsCenter collects
data for Drive Throughput and Drive Utilization report once per day at 1 A.M.
everyday after midnight.
Therefore the Drive Throughput or Drive Utilization reports are only able to report
on data up until 1 AM on that day, even when run with a relative timeframe of
Previous 24 hours. Similarly if you run Drive Throughput and Drive Utilization
reports at 2 P.M. in the afternoon, the reports display data collected till 1 A.M.
only.
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= Itis recommended that you configure the retention period of error logs in
NetBackup as more than 1 day. If the retention period of error logs is less than
24 hours, it may result in data loss for some reports like Drive Throughput.

= A tabular report that is scheduled for emailing has up to 4000 rows by default.
Similarly, exporting a tabular report in the available formats displays data for a
maximum of 4000 rows by default. The maximum number of rows can be
configured.
See “Configuring number of rows in a tabular report for email or export”
on page 17.

= Reports in the PDF, TSV, XML, or CSV formats are sent as email attachments.
= Avreport in the HTML format is sent as an inline message in email.
= Sorting for HTML-based reports (for example, Drive Utilization) is not supported.

= The default view that is selected is All My Views. All standard reports by default
show the data based on what you select for Report Template Default View.
The Report Template Default View can be specified in Settings > User
Preferences. The default value of Report Template Default View is All My
Views.

See “About Audit reports” on page 42.

See “About Backup reports in OpsCenter” on page 43.

See “About Catalog reports in OpsCenter” on page 186.

See “About Chargeback reports in OpsCenter” on page 186.
See “About Client reports in OpsCenter” on page 195.

See “About Disk and Tape Device Activity reports in OpsCenter” on page 238.
See “About Media reports in OpsCenter” on page 250.

See “About Performance reports in OpsCenter” on page 259.
See “About Policy reports in OpsCenter” on page 265.

See “About Restore reports in OpsCenter” on page 280.

See “About Storage Lifecycle Policy reports” on page 289.
See “Workload Analyzer report” on page 326.

About Audit reports

This section provides the reports for the NetBackup Audit Trails feature which
provide a record of all user-initiated actions for auditing NetBackup operational
changes.
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Audit Reports > Audit Trails Report

This section provides descriptions on the Audit Report Template available in
OpsCenter.

Audit trails is a record of all the user initiated activities. An audit trail consists of the
changes that are made in the NetBackup environment. For example, changes such
as creating a policy, deactivating a policy, or modifying a policy.

You can generate the Audit trails report through the reports tab. You can also create
a custom SQL. For example, enter a query: SELECT * FROM audit_record on SQL

query page.
See “Creating an OpsCenter report using a Report Template” on page 40.

See “Creating an OpsCenter report using SQL query” on page 346.

About Backup reports in OpsCenter

This section provides descriptions on all backup Report Templates available in
OpsCenter.

You can view the reports for all NetBackup backup operations including job activity,
deduplication rates, and overall backup status and success rates.

Deduplication > Deduplication Rates by See “Deduplication > Deduplication Rates by
Primary Server Primary Server” on page 46.

Deduplication > Deduplication Rates by Policy See “Deduplication > Deduplication Rates by
Type Policy Type” on page 48.

Deduplication > Deduplication Size Factor =~ See “Deduplication > Deduplication Size
Factor” on page 50.

Deduplication > Pre vs. Post Deduplication ~ See “Deduplication > Pre vs. Post
Size Deduplication Size report” on page 55.

Deduplication > Deduplication Size Savings See “Deduplication > Deduplication Size
Savings” on page 59.

Job Activity > Variance > About Throughput See “Variance > Throughput Variance”
Variance report on page 64.

Job Activity > Variance > About File Count  See “Job Activity > Variance > File Count
Variance report Variance report” on page 66.

Job Activity > Variance > About Backup See “Job Activity > Variance > Backup
Duration Variance report Duration Variance report” on page 67.



Job Activity > Variance > About Backup Job
Size Variance report

Job Activity > Backup Window > Job Count

Job Activity > Backup Window > Job Size

Job Activity > Backup Window > File Count

Job Activity > Job Count

Job Activity > Job Size

Job Activity > Client Count > Historical
Job Activity > Job Duration > Ranking
Job Activity > File Count

Job Browser > Tabular Backup Report
Planning Activity > Capacity Planning >
Forecasted Size

Planning Activity > Capacity Planning >
Historical Size

Planning Activity > Forecast > Job Count

Planning Activity > Forecast > Job Size

Planning Activity > Scheduled Job >
Scheduled Job

Planning Activity > Scheduled Job > Job
Count Scheduled Vs Actual

Planning Activity > Scheduled Job > Job
Count within Backup Window

OpsCenter reports
About Report Templates descriptions

See “Job Activity > Variance > Backup Job
Size Variance report” on page 67.

See “Job Activity > Backup Window > Job
Count report” on page 71.

See “Job Activity > Backup Window > Job
Size report” on page 74.

See “Job Activity > Backup Window > File
Count report” on page 74.

See “Job Activity > Backup Window > Job
Count report” on page 71.

See “Job Activity > Job Size” on page 80.
See “Job Activity > Client Count” on page 85.
See “Job Activity > Job Duration” on page 91.
See “Job Activity > File Count” on page 95.

See “Job Browser > Tabular Backup Report”
on page 100.

See “Planning Activity > Capacity Planning >
Forecasted Size report ” on page 105.

See “ Planning Activity > Capacity Planning
> Historical Size report ” on page 106.

See “Planning Activity > Forecast > Job Count
report ” on page 106.

See “Planning Activity > Forecast > Job Size”
on page 107.

See “Planning Activity > Scheduled Job >
Scheduled Job report” on page 111.

See “Planning Activity > Scheduled Job > Job
Count Scheduled Vs Actual report”
on page 112.

See “Planning Activity > Scheduled Job > Job
Count within Backup Window report”
on page 115.
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Planning Activity > Scheduled Jobs > Job
Details Scheduled Vs Actual

Planning Activity > Scheduled Job > All Jobs

Planning Activity > Stored Backup Images >
Valid Backup Images

Planning Activity > Stored Backup Images >
Duplicate Copies

Planning Activity > Stored Backup Images >
Stored Backup Images > Historical

Status & Success Rate > Status > Failed Job
Count

Status & Success Rate > Status > Partially
Successful Job Count

Status & Success Rate > Status > Successful
Job Count

Status & Success Rate > Status > All Failed
Backups

Status & Success Rate > Status >
Consecutive Failures

Status & Success Rate > Status > Week At
A Glance

Status & Success Rate > Status > Backup
Window Failures

Status & Success Rate > Status > Partially
Successful Job Details

Status & Success Rate > Status > Skipped
Files Summary

Status & Success Rate > Status > Job Exit
Status Detail

OpsCenter reports
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See “Planning Activity > Scheduled Jobs >
Job Details Scheduled Vs Actual report”
on page 117.

See “ Planning Activity > Scheduled Job > All
Jobs report” on page 120.

See “Planning Activity > Stored Backup
Images > Valid Backup Images report ”
on page 121.

See “Planning Activity > Stored Backup
Images > Duplicate Copies report”
on page 123.

See “Planning Activity > Stored Backup
Images > Stored Backup Images > Stored
Backup Images on Media” on page 124.

See “Status & Success Rate > Status > Failed
Job Count report ” on page 130.

See “Status & Success Rate > Status >
Partially Successful Job Count report”
on page 134.

See “Status & Success Rate > Status >
Successful Job Count report ” on page 138.

See “Status & Success Rate > Status > All
Failed Backups report” on page 142.

See “Status > Consecutive Failures”
on page 142.

See “Status & Success Rate > Status > Week
At A Glance report ” on page 147.

See “Status & Success Rate > Status >
Backup Window Failures report” on page 155.

See “Status & Success Rate > Status >
Partially Successful Job Details report”
on page 155.

See “Status & Success Rate > Status >
Skipped Files Summary report” on page 155.

See “Status & Success Rate > Status > Job
Attempt Status Detail report” on page 156.
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Status & Success Rate > Status > Job Details

Status & Success Rate > Status > Job
Summary by Status

Status & Success Rate > Status > Job Status
> Historical

Status & Success Rate > Status > Job Status
> Distribution

Status & Success Rate > Success Rate >
Success Rate — All Jobs

Status & Success Rate > Success Rate >
Advanced Success Rate

Status & Success Rate > Success Rate >
Success Rate All Attempts

Status & Success Rate > Success Rate >
Success Rate - First Attempt

Status & Success Rate > Success Rate >
Success Rate - Line

OpsCenter reports
About Report Templates descriptions

See “Status & Success Rate > Status > Job
Details report” on page 160.

See “Status & Success Rate > Status > Job
Summary by Status report” on page 160.

See “Status & Success Rate > Status > Job
Status > Historical report” on page 160.

See “Status & Success Rate > Status > Job
Status > Distribution report” on page 164.

See “Status & Success Rate > Success Rate
> Success Rate — All Jobs report ”
on page 168.

See “Status & Success Rate > Success Rate
> Advanced Success Rate report”
on page 171.

See “Status & Success Rate > Success Rate
> Success Rate - All Attempts report”
on page 174.

See “Status & Success Rate > Success Rate
> Success Rate - First Attempt report”
on page 178.

See “Status & Success Rate > Success Rate
> Success Rate - Line report” on page 182.

Deduplication > Deduplication Rates by Primary Server

This report provides the deduplication rates for each NetBackup primary server.

You can view the reports for NetBackup deduplication storage including deduplication

rates and storage space saved.

The following are the details that are associated with the beduplication Rates

by Primary Server report:

Report Name
Report Category Deduplication

Where to Locate

Deduplication Rates by Primary Server

Report > Report Templates > Backup > Deduplication >

Deduplication Rates by Primary Server
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Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled

Supported formats

OpsCenter reports
About Report Templates descriptions

Tabular report that shows deduplication rates for each
NetBackup primary server.

NetBackup, and Appliances
Primary Server, Media Server
Tabular

Yes.

Yes.

PDF, CSV, HTML, XML, TSV

You can edit the Deduplication Rates by Primary Server reportto show or
hide the columns that you are interested in. All the columns are shown by default.
You can also filter the report to view reports of specific primary servers. The following
table shows the filters for beduplication Rates by Primary Server reportand
how you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client Name
Client OS

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients

that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are

shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to

the OpsCenter console are shown in the Value dropdown list.

Select one or more clients to view data for the selected clients in

the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.
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Filter Column

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Job Job Type
Product Type

Job Transport
Type

Job Status

OpsCenter reports
About Report Templates descriptions

Description

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Deduplication > Deduplication Rates by Policy Type

This report provides the deduplication rates by NetBackup policy type.

The following are the details that are associated with the peduplication Rates
by Policy Type report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products

Deduplication Rates by Policy Type
Deduplication

Report > Report Templates > Backup > Deduplication >
Deduplication Rates by Policy Type.

Tabular report that shows deduplication rates for each
NetBackup primary server.

NetBackup, and Appliances
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Applicable View Primary Server, Media Server
Report Display Tabular

Drill down report Yes.

Can be scheduled Yes.

Supported formats PDF, CSV, HTML, XML, TSV

You can edit the Deduplication Rates by Policy Type report to show or hide

the columns that you are interested in. All the columns are shown by default. You
can also filter the report to view reports of specific primary servers. The following

table shows the filters for beduplication Rates by Policy Type reportand how
you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the clients

Server Server that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Media Media Server Select one or more media servers to view data for the selected
Server media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS
the OpsCenter console are listed.
Select one or more client OS to view data for the selected client
OS in the report.
Policy Policy Name Select one or more policy names to view data for the selected
Policy Type policies.
Policy Select one or more policy types to view data for the selected
Keyword policy types.
Policy Data :ele.ect c::e orlmotrfj rIJ(ollcy kgyword to view data for the policies
Classification M2Ving the selected keyword.
Name Select one or more policy data classification names like Gold,

Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.



OpsCenter reports
About Report Templates descriptions

Filter Column Description

Schedule Schedule/Level Select one or more schedule or level types to view the data for

Type the configured schedules.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.
Job Job Type Select one or more job types as Archive, Backup, or Restore to
Product Type view data for the selected job types.
Select one or more backup products to view data for the selected
Job Transport
products.
Type
Job Status Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Deduplication > Deduplication Size Factor

This report is usually the most talked about when it comes to deduplication since
it shows what the deduplication ratio is for each day over the last two weeks (the
time frame is modifiable). The deduplication ratio is calculated by taking the total
number of bytes that would normally be backed up and dividing it by the number
of bytes that have changed and were backed up. So if 100TB exists on all the
backups taking place but only 10TB were changed and therefore transferred, you
have a rate of 10. This report shows only deduplication jobs. The default Report
On parameter for this report is Primary Server. This report is available in a line-chart
format.

This report is available in historical and ranking views. The ranking report ranks the
top hosts in terms of which ones have the best deduplication ratio in bytes. These
hosts have the least amount of change and therefore you get the best benefit from
deduplication.

Figure 2-1 shows a sample view of Deduplication Size Factor Report.
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Figure 2-1 Deduplication Size Factor Report (Historical)
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Historical trending report showing deduplication factors. This report is valid for NetBackup, PureDisk and Appliances.

Shaw Chart as Table | Show Report Query

This deduplication report ranks the top hosts in terms of which ones have the best
deduplication ratio in bytes. These hosts have the least amount of change and
therefore you get the best benefit from deduplication.

Figure 2-2 shows a sample view of Deduplication Size Factor Report.
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Figure 2-2
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Deduplication Size Factor Report (Ranking)
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Historical trending report showing deduplication factors. This report s valid for NetBackup, PureDisk and Appliances

Show Chart as Table | Show Report Query

The following are the details that are associated with the Deduplication Size

Factor report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled

Supported formats

Deduplication Size Factor
Deduplication

Report > Report Templates > Backup > Deduplication >
Deduplication Size Factor.

Historical trending report showing savings deduplication
factors.

NetBackup, and Appliances
Primary Server, Client
Historical, Ranking

Yes. Drill down reports can be viewed at following four levels
depending on the selected parameter value. Level 1: Client
Name, Level 2: Job Type, Level 3: Schedule/Level Type, Level
4: Policy Name

Yes.

PDF, CSV, HTML, XML, TSV
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You can edit the beduplication Size Factor reportto show or hide the columns
that you are interested in. All the columns are shown by default. You can also filter
the report to view reports of specific primary servers. The following table shows the
filters for beduplication Size Factor reportand how you can use these filters
to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword
Policy Data

Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients
that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.
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Filter Column Description
Job Job Type Select one or more job types as Archive, Backup, or Restore to
Product Type view data for the selected job types.
Select one or more backup products to view data for the selected
Job Transport
products.
Type
Job Status Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the Duplication Size Factor report for a
specific client to view details for the specific clients.

Report Enhancements:

The following report enhancements have been made for the Duplication Size Factor
report:

= Drill down reports for following four levels have been added.
= Level 1: Client Name
s Level 2: Job Type
= Level 3: Schedule/Level Type
= Level 4: Policy Name

= The report now shows trendlines with customized average periods with option:
Show trendline with moving average period of 3. The value can be 1, 2, 3, 7,
14, or 30. The default value is 3. Example: 3 displays a trendline that, at each
interval, shows the average of the current data point and the two previous data
points.

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week total
= Hours of day Average

= Hours of day Total

54



OpsCenter reports
About Report Templates descriptions

= Minutes

= Month of year Average
= Month of year total

= Quarter of year Average
= Quarter of year total

The following filter enhancements have been made for the Duplication Size Factor
report:

= New columns Job Status (Complete Only) and Job Status(Complete and Partial
Only) are added to the Report On parameter.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are UNKNOWN.

= Job types which are not applicable for this report are removed from the filter.
The supported job types are Backup, Archive, Restore, Catalog Backup, Backup
from Snapshot, Snapshot, Duplicate, and Replication.

» The default selected value for Job Type column is changed to Backup.
= The default unit for Y1 axis is now GB.

= Value SAN is removed from the Job Transport Type filter.

Known Issues:

= The unit of data for Y axis/Y1 axis is one unit lower.

Deduplication > Pre vs. Post Deduplication Size report

The Pre vs. Post Deduplication Size report gives the comparison between the total
number of bytes that exist on all the backups as if they were normal full backups
and the number of bytes that have changed and therefore needed to be transferred.
This report shows only deduplication jobs. The default Report On parameter for
this report is All Primary Servers. This report is available in a line-chart format.

Figure 2-3 shows a sample view of Pre vs. Post Deduplication Size Report.
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Figure 2-3 Pre vs. Post Deduplication Size Report
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Historical trending report of prefpost deduplication size. This report is valid for NetBackup, PureDisk and Appliances.
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| Show Report Que

The following are the details that are associated with the Deduplication Size

Factor report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled

Supported formats

Pre vs. Post Deduplication Size report
Deduplication

Report > Report Templates > Backup > Deduplication > Pre
vs. Post Deduplication Size report.

Historical trending report of pre vs. post deduplication size.
NetBackup, and Appliances

Primary Server, Client

Historical

None

Yes

PDF, CSV, HTML, XML, TSV

You can edit the Pre vs. Post Deduplication Size reportto show or hide the

columns that you are interested in. All the columns are shown by default. You can
also filter the report to view reports of specific primary servers. The following table
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shows the filters for Pre vs. Post Deduplication Size reportand how you can
use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients
that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.
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Filter Column Description
Job Job Type Select one or more job types as Archive, Backup, or Restore to
Product Type view data for the selected job types.
Select one or more backup products to view data for the selected
Job Transport
products.
Type
Job Status Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.
Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the Pre vs. Post Deduplication Size report
for a specific client to view details for the specific clients.

The following report enhancements have been made for the Pre vs. Post
Deduplication Size report:

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last X years. You can also select Year from the top-right corner
of the report

= Drill down reports for following four levels have been added in OpsCenter.
= Level 1: Client Name
= Level 2: Job Type
» Level 3: Schedule/Level Type
= Level 4: Policy Name
= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total

= Quarter of year Average
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= Quarter of year total

The following filter enhancements have been made for the Pre vs. Post Duplication
Size report:

= New columns Job Status (Complete Only) and Job Status(Complete and Partial
Only) are added to the Report On parameter.

= UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are UNKNOWN.

= Job types which are not applicable for this report are removed from the filter.
The supported job types are Backup, Archive, Restore, Catalog Backup, Backup
from Snapshot, Snapshot, Duplicate, and Replication.

» The default selected value for Job Type column is changed to Backup.
= The default value of Report On is None.

= Value SAN is removed from the Job Transport Type filter.

Known Issues:

» The unit of data for Y axis/Y1 axis is one unit lower.

Deduplication > Deduplication Size Savings

Most NetBackup customers have either implemented some sort of deduplication
or plan to in the near future. This is the current trend as customers try to get control
of infrastructure and the amount of time backups take. Add to this the need for many
customers to protect remote offices across smaller WAN links and deduplication
becomes critical since only so much data can be pushed through a small pipe and
many times there is no one at the remote site who is capable of managing hardware.
In the data center, deduplication reporting helps to determine what the actual
deduplication rate is occurring at each PureDisk storage unit. Reporting can be
abstracted to view the protected size or stored size across all PureDisk environments
or drilled down in to one specific area. Common file or data types can then be
identified and matched with their ability to be deduplicated. The report below is a
simple dedupe report created using a Media Server Deduplication Pool. It is a very
basic report and shows how much data would have been backed up without
deduplication enabled. In large environments this would show the number of GB
or TB that is NOT being used due to deduplication. The other reports can contrast
the dedupe data savings vs. the actual deduped information however in this very
small test environment this report shows better information. OpsCenter and
OpsCenter Analytics provide the ability to report on the various forms of deduplication
available with NetBackup. It can provide reports that show things such as how much
deduplication is being done at a remote site before the data hits the WAN pipe.
Using the trending feature of OpsCenter Analytics can also help to understand if

59



OpsCenter reports
About Report Templates descriptions

the data is growing faster than the hardware or when the WAN bandwidth can be
expected to max out. This allows the company to make educated decisions on
when to add infrastructure proactively instead of waiting for things to fail. This report
shows the total number of bytes that do not need to be backed up because of
deduplication. There is no calculation or ratio in this number. It is the number of
bytes (MB, GB, TB etc.) that have not changed since the last backup and therefore
do not need to be backed up. This report shows only deduplication jobs. The default
Report On parameter for this report is Primary Server. This report is available in
Historical, and Ranking views. The ranking report groups the total number of bytes
saved per host being backed up to show the top five hosts in terms of deduplication
savings.

The historical report shows the total number of bytes that do not need to be backed
up because of deduplication. There is no calculation or ratio in this number. It is
the number of bytes (MB, GB, TB etc.) that have not changed since the last backup
and therefore do not need to be backed up. This report shows only deduplication
jobs. The default Report On parameter for this report is Primary Server

Figure 2-4 shows a sample view of Deduplication Size Savings Report.

Figure 2-4 Deduplication Size Savings Report (Historical)
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The ranking report shows the number of bytes that have not changed within the

time frame and therefore do not have to be backed up due to deduplication. The
report groups the total number of bytes saved per host being backed up to show
the top five hosts in terms of deduplication savings. This report shows only
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deduplication jobs. The default Report On parameter for this report is Primary
Server.

Figure 2-5 shows a sample view of Deduplication Size Savings Report.

Figure 2-5 Deduplication Size Savings Report (Ranking)
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The following are the details that are associated with the peduplication size
Savings report:

Report Name Deduplication Size Savings
Report Category Deduplication
Where to Locate Report > Report Templates > Backup > Deduplication >

Deduplication Size Savings.

Report Purpose Historical trending report showing savings in storage due to
deduplication.

Supported products NetBackup, and Appliances
Applicable View Primary Server, Client

Report Display Historical, Ranking



Drill down report

Can be scheduled

Supported formats

You can editthe beduplication Size Savings reportto show or hide the columns
that you are interested in. All the columns are shown by default. You can also filter
the report to view reports of specific primary servers. The following table shows the
filters for beduplication Size Savings report and how you can use these filters

OpsCenter reports
About Report Templates descriptions

Yes. Drill down reports can be viewed at following four levels
depending on the selected parameter value. Level 1: Client
Name, Level 2: Job Type, Level 3: Schedule/Level Type, Level
4: Policy Name

Yes

PDF, CSV, HTML, XML, TSV

to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients
that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.
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Filter Column Description

Schedule Schedule/Level Select one or more schedule or level types to view the data for

Type the configured schedules.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.
Job Job Type Select one or more job types as Archive, Backup, or Restore to

Product Type view data for the selected job types.

Select one or more backup products to view data for the selected
Job Transport

products.
Type

Select one or more transport types like FT, LAN, or Unknown to

Job Status
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the Duplication Size Savings report for a
specific client to view details for the specific clients

The following report enhancements have been made for the Duplication Size Savings
report:

» Drill down reports for following four levels have been added.
= Level 1: Client Name
= Level 2: Job Type
= Level 3: Schedule/Level Type
= Level 4: Policy Name

= The report now shows trendlines with customized average periods with option:
Show trendline with moving average period of 3. The value can be 1, 2, 3, 7,
14, or 30. The default value is 3. Example: 3 displays a trendline that, at each
interval, shows the average of the current data point and the two previous data
points.

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from TimeFrameGroupBy selection:

= Days of week Average
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= Days of week total

= Hours of day Average

= Hours of day Total

= Minutes

= Month of year Average
= Month of year total

= Quarter of year Average

= Quarter of year total

The following filter enhancements have been made for the Duplication Size Savings
report:

New columns Job Status (Complete Only) and Job Status (Complete and Partial
Only) are added to the Report On parameter.

UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are UNKNOWN.

Job types which are not applicable for this report are removed from the filter.
The supported job types are Backup, Archive, Restore, Catalog Backup, Backup
from Snapshot, Snapshot, Duplicate, and Replication.

The default selected value for Job Type column is changed to Backup.
The default unit for Y1 axis is now GB.

Value SAN is removed from the Job Transport Type filter.

Known Issues:

The unit of data for Y axis/Y1 axis is one unit lower.

Variance > Throughput Variance

This report shows client or policy level details on backup job throughput variations
between last full backup and recent averages.

Figure 2-6 shows a sample view of Throughput Variance Report.
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Figure 2-6 Throughput Variance Report
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The following are the details that are associated with the Throughput variance

report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

Throughput Variance
Backup

All Reports > Report Templates > Backup > Job Activity >
Variance > Throughput Variance report.

Client/Policy level detail on backup job throughput variations
between last full backup and recent averages.

NetBackup, NetBackup Primary Appliance
Primary Server, Client

Tabular

Yes. See Client Backup Details.

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Jobs > Throughput

Variance

You can edit the Throughput Variance report to show or hide the columns that

you are interested in. All the columns are shown by default. You can also filter the

report to view reports of specific primary servers. The following table shows the

filters for Throughput variance report and how you can use these filters to view

specific data in the report.
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Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the clients

Server Server that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Percentage Percentage  Select an appropriate value of variance percentage. By default,
all the variance percentages that are greater than 1 are displayed
in the Variance (%) column in the report.

Example of filter usage: You may run the Throughput Variance report for a specific
primary server to view details only for the specific primary server.

The following report enhancements have been made for the Job Duration report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The default Relative Timeframe for this report was 28 days now it is changes
to Previous 14 days.

Job Activity > Variance > File Count Variance report

You can view the detailed reports for NetBackup job activity statistics including file,
job, size, Clients, and job duration.

From Job Activity > Varience you can view the reports on NetBackup operational
ranges to identify statistical variances in backup sizes, throughputs, duration, and
file counts.

The Job Activity > Variance > File Count Variance report lets you investigate why
a particular full backup is different than usual. For example, a file server backup is
successful, but contains fewer files than usual for a full backup.

The report shows NetBackup jobs with significant differences in file counts from
the average count for a primary server, policy, and schedule.

If any variation calculation is greater than the selected value of variance when the
report is run, the server, client, policy, and schedule type combination is shown with
the actual file count variation. The table provides the percent variance (in file counts)
for each good job from the average for that server, policy, and schedule.

The Client Name column of the report provides a drilldown link to back up job
details for the specified time frame.
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Job Activity > Variance > Backup Duration Variance report

This report provides an indication of how backup time varies from the average
backup time. You can detect any anomalies if the variation is too high.

This report calculates the backup time variation of the last good backup with the
average backup time per client, policy, and schedule type. If any variation calculation
is greater than the selected value of variance when the report is run, the client,
policy, and schedule type combination is shown with the actual variation.

About client jobs for selected time frame report

This drilldown report from the Client Name column provides detailed job information
for the client for the selected time frame.

This drilldown report uses the run time parameters that are passed from the main
report.

Job Activity > Variance > Backup Job Size Variance report

This report provides an indication of how a backup size varies from the average
size. You can detect any anomalies if the variation is too high.

This report calculates the backup size variation of the last good backup with the
average backup size per a client, policy, and schedule type. If any variation
calculation is greater than the selected value of variance when the report is run,
the client, policy and schedule type combination is shown with the actual variation.

Size variance is calculated using the following formula: (the last backup size - the
average backup size) / the average backup size x 100.

Consider the following points before running a Backup Job Size Variance report:
= This report considers only full schedules.
= This report does not consider deduplication jobs.

= This report does not consider failed jobs. The report considers jobs with status
code like 0, 1 etc.

= [f you ran multiple jobs for the same client in the given time frame like 10 jobs
per the primary server, client, policy, and schedule combination then the report
calculates the difference between the last job and the average of the remaining
9 jobs.

= In case of multi-stream jobs, the report considers each stream as a different
job.

The Client Name column of the report provides a drilldown link to back up job
details for the specified time frame.
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Figure 2-7 shows a sample view of the Backup Job Size Variance report.

Figure 2-7 Backup Job Size Variance report
Backup Job Size variance
Last Good Full Last Backup Average X
Server Name  Client Name Policy Name Schedule Name Backup Prior Jobs Size(MB) Size(MB) Delta (MB) Variance (%)
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The following are the details that are associated with the Backup Job Size

Variance report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with NOM report

The following table lists the filters for Backup Job Size variance report and how

Backup Job Size Variance
Backup

Report > Report Templates > Backup > Job Activity > Variance
>Backup Job Size Variance

This report shows job size variance.
NetBackup, NetBackup Primary Appliance
Primary Server

Tabular

Yes

See “Client backup jobs” on page 69.
Yes
PDF, CSV, TSV, XML, HTML

Reporting > All Reports > Standard Reports > Jobs > Backup
Job Size Variance

you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .
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Filter Column Description

Percentage Percentage Select an appropriate value of variance percentage. By default,
all the variance percentages that are greater than 1 are displayed
in the Variance (%) column in the report.

Example of filter usage: You may run the Backup Job Size Variance report for
a specific primary server to view details only for the specific primary server.

The following report enhancements have been made for the Backup Job Size
Variance report:

= The unit Years has been added for Relative Timeframe selection.

You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Client backup jobs

The client Backup Jobs report shows details of the jobs run for a selected client.
This tabular report shows information like Job ID, Policy Name, Schedule Name,
Status Code, Number of files, Throughput (KB/Sec) etc.

Figure 2-8 shows a sample view of the client Backup Jobs report.

Figure 2-8 Client backup jobs report
Job Type z:;:s Policy Name ::':: " SariTime EndTime  Volume(KB) pumber of ‘T:;::c';wl
Backup 0 normalbkponHRAWRDUBD  FULL TG e oS 3212204 10 54080
Backup 0 normalbkponHRCHPINbUBD  FULL ;?:7:“245 E'or; & ;f';‘gi“s E'or; § 3212004 10 46,808
Backup 0 ACCbkponHitCrypinbusd  FULL éuf 7;2245 ﬁ: ’ éuf 3;2:'3 i‘: 5 3212224 10 319,497
Backup 0 anyavaliablebkpstu FULL j?'z"g?;? %Oh: & j‘“; ?;‘g %Oh: § 3212204 10 50,747
Backup 0 anyavaliablebkpstu FULL Jun24, 2015\ Jun 24,2018 554550, 10 300,117

43155 PM  4:33:03 PM

The following are the details that are associated with the client Backup Jobs
report:

Report Name Client backup jobs

Report Category Backup
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Where to Locate Report > Report Templates > Backup > Job Activity > Variance
>Backup Job Size Variance (drilldown on Client Name)
> Client backup jobs

Report Purpose This report shows details of the jobs run for a selected client.
Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server

Report Display Tabular

Drill down report No

Can be scheduled Yes

Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  Reporting > All Reports > Standard Reports > Jobs > Backup
Job Size Variance > Client Backup Job

The following table shows the filters for c1ient Backup Jobs report and how you
can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Client Client is Select Yes to view only Active Clients or No to view all the clients
Active in the report. By default, only Active Clients are shown in the
Client Name report.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Example of filter usage: You may run the client Backup Jobs report for more
than one primary server. Select Primary Server and then select specific primary
servers to view details for all the clients.

The following report enhancements have been made for the Backup Job Size
Variance report:

= The unit Years has been added for Relative Timeframe selection.
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You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Job Activity > Backup Window > Job Count report

The Job Activity > Backup Window provides the reports on NetBackup backup
window statistics including the number of jobs, job size, and file counts.

The Job Activity > Backup Window > Job Count report shows the total number
backup jobs in the last two weeks shown by the hour of the day in which each job
ends. It also renders a configurable backup window to help quickly identify if a lot
of jobs end in or outside of what your backup window is or should be. The report
can help you see if there are any hours within the backup window that are under
used and whether any load balancing is appropriate.

Figure 2-9 shows a sample view of the Job Count report.

Figure 2-9 Job Count report
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The following are the details that are associated with the Job Count report:

Report Name Job Count
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Report Category Backup

Where to Locate Report > Report Templates > Backup > Job Activity > Backup
Window > Job Count

Report Purpose This report shows job count by hour of day in which job ends.
Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server, Client

Report Display Historical (Chart)

Drill down report No

Can be scheduled Yes

Supported formats PDF, CSV, TSV, XML, HTML

The following table shows the filters for Job Count report and how you can use
these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Media Media server Select one or more media servers to view data for the specific

server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value drop-down list ..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.



Filter Column

Policy Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule Schedule/Level
Type

Schedule
Name

Job Job Status

Job Transport
Type

Job Type
Product Type

Attempt  Attempt
Status
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Description

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like CINC, Copy, Daily etc. to
view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

Select one or more backup products to view data for the selected
products.

The Attempt Status column can have two values i.e. Attempt or
Job. When Job Count is calculated, the report considers all
attempts if Attempt is selected.

By default, Job is selected. Number of attempts are not
considered when Job is selected.

Example of filter usage: You may run the Job Count report for a specific policy
to view job counts for the specific policy.

The following report enhancements have been made for the Job Count report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following Report On options have been added under Backup Job

Attributes:
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= Job Status (Complete and Partial only)
= Job Status (Complete only)

s The Schedule Name column is added under the Schedule filter to filter data
by schedule name.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are unknown. In earlier
versions of OpsCenter the unknown policy types were shown as blank. Now all
static columns like job type, schedule type, or policy type are shown as
UNKNOWN.

Job Activity > Backup Window > Job Size report

This report shows the total gigabytes backed up in the last two weeks shown by
the hour of the day in which each job ends. It also renders a configurable backup
window to help quickly identify if a lot of jobs end in or outside of what your backup
window is or should be. The report can help you see if there are any hours within
the backup window that are under used and whether any load balancing is
appropriate.

Job Activity > Backup Window > File Count report

This report shows the number of files that were backed up for each hour of the day.
The height of each bar on the graph represents the total number of files that are
backed up for that hour across the entire date range selected. A user defined backup
window is drawn in yellow for example to compare with what hours the files should
have been backed up in. Bars outside of the yellow window represent the activity
that occurred outside of the backup window. The report can also be used to see
what hours may have capacity to add more backups while still remaining in the
backup window.

Job Activity > Job Count

This report provides as a summary of backup job counts across products, domains,
clients, policies and business level views. There are three display options to see
this report. Historical report view shows the total amount of time spent while doing
backups each day for the past two weeks.

Figure 2-10 shows a sample view of Job Count Report.
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Figure 2-10 Job Count Report (Historical)
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Ranking view shows the top ten environments by ranking total number of jobs
performed by each media server during the last two weeks.

Figure 2-11 shows a sample view of Job Count Report.
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Figure 2-11 Job Count Report (Ranking)
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Distribution view gives a breakdown of number of jobs performed by each media
server and provides information if any type of load balancing is beneficial.

Figure 2-12 shows a sample view of Job Count Report.
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Figure 2-12 Job Count Report (Distribution)
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You can view historical, ranking and distribution report types in tabular format.

Figure 2-13 shows a sample view of Job Count Report.

Figure 2-13 Job Count Report (Tabular)

Media Server Total Job Count Percentage

nnpsid4 35873 91.95%
rappu2Sengnasitas:; .com 2,998 7.68%
nappis61 16 0.3%
UNKNOWN 27 0.07%

Total 4 Rows , 1 Page(s)

The following are the details that are associated with the Job count report:

Report Name Job Count
Report Category Backup
Where to Locate All Reports > Report Templates > Backup > Job Activity > Job

Count report.

Report Purpose Customizable report that shows total number of unique clients
backed up per day for the last two weeks, by each primary
server.
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Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server, Client

Report Display Historical, Ranking, Distribution

Drill down report Yes

You can view drill down reports for the selected parameter
value. These reports are available for NetBackup and
NetBackup appliance.

Example: For ranking type of report, you can view four levels
of drill down reports: Level 1: Client Name, Level 2: Job Type,
Level 3: Schedule/Level Type, Level 4: Policy Name

Can be scheduled Yes
Supported formats PDF, CSV, TSV, XML, HTML

Mapping with VBR report All Reports > Standard Reports > Backup > Activity Planning
> Job Count

You can edit the Job count report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report
to view reports of specific primary servers. The following table shows the filters for
Job Count report and how you can use these filters to view specific data in the
report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Media Media Server Select one or more media servers to view data for the selected
Server media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS }
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.



Filter Column

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type
Schedule
Name

Job Job Type
Product Type

Job Transport
Type
Job Status

Attempt  Attempt
Status
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Description

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

The Attempt Status filter can have two values i.e. Attempt or Job.
When Job Count is calculated, the report considers all attempts
if Attempt is selected.

Example of filter usage: To view a count of all job attempts in the Job Count report,
select Attempt Status as Attempt.

The following report enhancements have been made for the Job Count report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

» The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

The following filter enhancements have been made for the Job Count report:

=  UNKNOWN has been added as a value for Policy Typecolumn in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
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earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN as in VBR.

= Job Transport Type column has been added to the Job filter. For example,
you can view report data for jobs for which the Job transport type is FT or LAN.

Job Activity > Job Size

This report provides as a summary of backup job sizes across products, domains,
clients, policies and business level views. There are three display options to see
this report. Historical report view shows the total megabytes backed up each day
during the last two weeks.

Figure 2-14 shows a sample view of Job Size Report.

Figure 2-14 Job Size Report (Historical)
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Summary of backup job sizes across products, domains, clients, policies and business level views.

Ranking view shows the top 10 backup client ranking them on total megabytes
backed up for that client for last two weeks. The report provides an overview of top
consumers and whether those consumers are the expected ones.

Figure 2-15 shows a sample view of Job Size Report.
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Figure 2-15 Job Size Report (Ranking)
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Summary of backup job sizes across products, domains, clients, policies and business level views.

Distribution view gives a breakdown view about total megabytes they have been
backed up in the last two week, for each media server. It shows a clear distribution
of amount of data going to all the media servers and provides inputs if any type of
load balancing is beneficial.

Figure 2-16 shows a sample view of Job SizeReport.
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Figure 2-16 Job Size Report (Distribution)
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Summary of backup job sizes across products, domains, clients, policies and business level views.

You can view historical, ranking and distribution report types in tabular format.

Figure 2-17 shows a sample view of Job Size Report.

Figure 2-17 Job Size Report (Tabular)

Client Name Job Size (MB) Percentage

nbapp561 461,528,579.87 95.39%
nbur420-172 4116,417.18 0.85%
nburd20-51. engbmamzmmite. ccom 4.113,808.26 0.85%
nburd20-177 4.113,107.94 0.85%
nbur420-60 4112,007.4 0.85%
nburd20-56 4,110,906.87 0.85%
appesx23-3par02 81.412.31 0.02%
appesx23-3par15 74,399.94 0.02%
appesx23-3par24 69.730.43 0.01%
appesx23-3pard4 64,094.34 0.01%
appesx23-3pard0 60,571.8 0.01%

The following are the details that are associated with the Job size report:

Report Name Job Size
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Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with VBR report
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Backup

All Reports > Report Templates> Backup > Job Activity >Job
Size report

Customizable report about the total megabytes backed up for
each day during the last two weeks.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Historical, Ranking, Distribution

Yes. You can view drill down report for the selected parameter
value. These drill down reports are available for NetBackup
and NetBackup appliance.

Example: For ranking type of report, you can view three levels
of drill down reports: Level 1: Job Type, Level 2:
Schedule/Level Type, Level 3: Policy Name

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Backup > Activity Planning
> Job Size

You can edit the Job size report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report

to view reports of specific primary servers. The following table shows the filters for

Job size report and how you can use these filters to view specific data in the

report.
Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.
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Filter Column

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Job Job Type
Product Type

Job Transport
Type

Job Status

Example of filter usage: You may run the Job size report for specific policy data

OpsCenter reports
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Description

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

classification names to view details only for the specific policy classifications.

The following report enhancements have been made for the Job Size report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

s The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.

The following filter enhancements have been made for the Job Size report:
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=  UNKNOWN has been added as a value for Policy Typecolumn in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN as in VBR.

= Job Transport Type column has been added to the Job filter. For example,
you can view report data for jobs for which the Job transport type is FT or LAN.

= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week Total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year Total
= Quarter of year Average

= Quarter of year Total

Job Activity > Client Count

This report provides a summary of backup client counts across products, domains,
clients, policies and business level views. There are three display options to see
this report. Historical report view shows the total number of unique clients backed
up per day for the last two weeks, for each primary server. It can help in highlighting
potential problems by showing any variations in the number of clients that needs
to be backed up and how many are actually getting backed up.

Figure 2-18 shows a sample view of Client Count Report.
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Figure 2-18 Client Count Report (Historical)
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Ranking view shows the top ten environments by listing the number of unique clients
that got backed up per each media server during the last two weeks.

Figure 2-19 shows a sample view of Client Count Report.
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Figure 2-19 Client Count Report (Ranking)
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Summary of backup client counts across products, domains, clients, policies and business level views.

Distribution view gives you breakdown by each primary server of the number of
unique clients that got backed up in the last two weeks.

Figure 2-20 shows a sample view of Client Count Report.
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Figure 2-20 Client Count Report (Distribution)
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Summary of backup client counts across products, domains, clients, policies and business level views.

You can view historical, ranking and distribution report types in tabular format.

Figure 2-21 shows a sample view of Client Count Report.

Figure 2-21 Client Count Report (Tabular)

Number of Clients Backed
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Total € Rows , 1 Page(s)
The following are the details that are associated with the client count report:

Report Name Client Count

Report Category Backup
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Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with VBR report
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All Reports > Report Templates > Backup > Job Activity >
Client Count report.

Customizable report that shows total number of unique clients
backed up per day during last two weeks, by each primary
server.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Historical, Ranking, Distribution

Yes

You can view drill down reports for the selected parameter
value. These reports are available for NetBackup and
NetBackup appliance.

Example: For ranking type of report, you can view four levels
of drill down reports: Level 1: Client Name, Level 2: Job Type,
Level 3: Schedule/Level Type, Level 4: Policy Name

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Backup > Activity Planning
>Client Count

You can edit the client count report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report

to view reports of specific primary servers. The following table shows the filters for
Client Count reportand how you can use these filters to view specific data in the

report.
Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.
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Filter Column

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Job Job Type
Product Type

Job Transport
Type

Job Status

Example of filter usage: You may run the client count report for specific policy
data classification names to view details only for the specific policy classifications.
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About Report Templates descriptions

Description

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

The following report enhancements have been made for the Client Count report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

s The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.

The following filter enhancements have been made for the Client Count report:
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=  UNKNOWN has been added as a value for Policy Typecolumn in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN as in VBR.

= Thefollowing options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week Total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year Total
= Quarter of year Average

= Quarter of year Total

Job Activity > Job Duration

This report provides a summary of backup job durations across products, domains,
clients, policies and business level views. It shows you the top ten clients ranked
by the total amount of time consumed for the backup during last two weeks.

Figure 2-22 shows a sample view of Job Duration Report.



OpsCenter reports
About Report Templates descriptions

Figure 2-22 Job Duration Report
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Summary of backup job durations across products, domains, clients, policies and business level views.

In addition, you can view the report in tabular format.

Figure 2-23 shows a sample view of Job Duration Report.

Figure 2-23 Job Duration Report (Tabular)

Client Name Job Duration (Hours)

nbapp544 302.27
nbapp561 239.66
nbayop1Z.engbz==ma.ves.com £60.96
nbur420-60 15.62
nburd20-172 14.23
nburd20-177 13.63
nburd20-56 13.62
nburzz420:1 . engbi=sa. SET. com 13.6
nburd20-18 4.76
nbur420-176 4.46

Total 10 Rows , 1 Page(s)

The following are the details that are associated with the Job Duration report:

Report Name

Job Duration
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Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with VBR report
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Backup

All Reports > Report Templates > Backup > Job Activity > Job
Duration report.

Customizable report that shows top ten clients ranked by the
total amount of time for the backup during the last two weeks.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Ranking

Yes. You can view drill down reports for the selected
parameter value. These reports are available for NetBackup
and NetBackup appliance.

Example: For ranking type of report, you can view four levels
of drill down reports: Level 1: Job Type, Level 2:
Schedule/Level Type, Level 3: Policy Name

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Backup > Activity Planning
> Job Duration

You can edit the Job Duration report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report

to view reports of specific primary servers. The following table shows the filters for
Job Duration reportand how you can use these filters to view specific data in the

report.
Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.
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Filter Column

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Job Job Type
Product Type

Job Transport
Type

Job Status
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Description

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the Job Duration report for specific policy
data classification names to view details only for the specific policy classifications.

The following report enhancements have been made for the Job Duration report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

The following filter enhancements have been made for the Job Duration report:
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= UNKNOWN has been added as a value for Policy Typecolumn in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN as in VBR.

= Job Transport Type column has been added to the Job filter. For example,
you can view report data for jobs for which the Job transport type is FT or LAN.

Job Activity > File Count

This report provides the summary of backed up file counts across products, domains,
clients, policies and business level views. There are three display options to see
this report. Historical report view shows the total number of files that got backed up
for each day during the last two weeks for each primary server.

Figure 2-24 shows a sample view of File Count Report.

Figure 2-24 File Count Report (Historical)
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Summary of backed up file counts across products, domains, clients, policies and business level views

Ranking view shows the top ten backup clients ranking them on total numbers of
files that were backed up for them during the last two weeks.

Figure 2-25 shows a sample view of File Count Report.
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Figure 2-25 File Count Report (Ranking)
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Distribution view gives a breakdown for the number of files that got backed up in
the last two weeks, for each primary server.

Figure 2-26 shows a sample view of File Count Report.
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Figure 2-26 File Count Report (Distribution)
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You can view historical, ranking and distribution report types in tabular format.

Figure 2-27 shows a sample view of File Count Report.

Figure 2-27 File Count Report (Tabular)
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The following are the details that are associated with the File count report:

Report Name File Count
Report Category Backup
Where to Locate Report > Report Templates > Backup > Job Activity > File

Count
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Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with VBR report
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Customizable report showing the total number of files that are
backed up each day during the last two weeks.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Historical, Ranking, Distribution

Yes

You can view drill down reports for the selected parameter
value. These reports are available for NetBackup and
NetBackup appliance.

Example: For ranking type of report, you can view three levels
of drill down reports: Level 1: Job Type, Level 2:
Schedule/Level Type, Level 3: Policy Name

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports> Backup >Activity Planning
>File Count

You can edit the File count report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report

to view reports of specific primary servers. The following table shows the filters for

File count report and how you can use these filters to view specific data in the

report.
Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.
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Filter Column

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword

Policy Data
Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Job Job Type
Product Type

Job Transport
Type

Job Status

OpsCenter reports
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Description

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more backup products to view data for the selected
products.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the rile count report for specific policy

data classification names to view details only for the specific policy classifications.

The following report enhancements have been made for the File Count report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

s The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.

The following filter enhancements have been made for the File Count report:
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=  UNKNOWN has been added as a value for Policy Typecolumn in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN as in VBR.

= Job Transport Type column has been added to the Job filter. For example,
you can view report data for jobs for which the Job transport type is FT or LAN.

= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week Total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year Total
= Quarter of year Average

= Quarter of year Total

Job Browser > Tabular Backup Report

This section provides the reports on NetBackup job activity similar to the NetBackup
Activity Monitor.

You can view a detailed listing of all the backup activity performed for the specified
timeframe. The default timeframe is last two weeks. This report lets you view the
status for multiple job attempts (from Job Attempt Count and Status Code
columns). This report also lets you know the time it takes for backup or restore
operations to complete (from the Job Duration column). It thus helps you to quickly
identify details about the backup or restore jobs that take the maximum time.

You can also drill down from the Job Primary ID column in the report to know the
skip file details that are associated with the job. Only some jobs may have skipped
files associated with them. For jobs that do not have any skipped files, the drill-down
report is either blank or shows hyphens.

Figure 2-28 shows a sample view of the Tabular Backup Report.
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Figure 2-28 Tabular Backup Report
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The following are details associated with the Tabular Backup Report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Tabular Backup Report
Backup

Report > Report Templates > Backup > Job Browser > Tabular
Backup Report

Customizable tabular report of all backup data (size, start time,
status code etc.) by client.

NetBackup, NetBackup Appliance
Primary Server, Client
Tabular

Skip File Details

See “Skip File Details” on page 104.
Yes
CSV, HTML, PDF, XML, TSV

Backups > Job Browser > Scheduled Jobs > Tabular Backup
Report

You can edit the Tabular Backup Report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report
to show activity for a limited sample set, such as one or more policies, primary
servers, clients, views, product types, job status etc.

The following table shows the filters for Tabular Backup report and how you can
use these filters to view specific data in the report.
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Filter
View
Primary

Server

Media
server

Client

Policy

Schedule

Job

Column

Primary
Server

Media server

Client Name

Client OS

Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule/Level
Type

Schedule
Name

Job Status

Job Transport
Type

Product Type
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Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list ..

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the
selected data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like CINC, Copy, Daily etc.
to view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more products to view data for the selected
products.
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Example of filter usage: You may run the Tabular Backup report for a specific
primary server to view backup details only for the selected primary server. The

sample report view that is shown above shows data for a specific primary server.

Report The following report enhancements have been made:

Enhancements

Each Job primary ID is now a link. You can drill down from the Job
Primary ID column to know the skipped file details for a job.

The report now displays the seconds in Job End Time, Job Start
Time, and Expiration Time columns like 9:40:37 A.M. Earlier the
report used to display the time in hours and minutes only like 9:40
AM.

The report now shows data for all your views by default. All My Views
is the default view when you edit the report.

Fixed issues of data correctness and parity with VBR.

Additional The following additional columns are shown in the report. These columns
Columns are not displayed by default on the report. You need to edit the report to
manually add these columns and rerun the report.

Attempt Status

This column lets you know the status of the attempt; whether it was
successful or failed.

Product

This column shows the product that is associated with the job like
NetBackup, NetBackup Primary Appliance.

Job Directory

Path that is backed up by a job.

Policy Keyword

Policy keyword that is associated with the job

Storage Unit Name

Name of the storage unit that is associated with the job

Attempt Start Time

Shows the start date and time for the specific job attempt. A job may
require multiple attempts or retries due to resources not being
available etc. Ensure that the report always shows the Attempt Start
Time column. In case you remove Attempt Start Time column, the
report may show duplicate records.
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Filter The following filter enhancements are listed:

Enhancements The unit Years has been added for Relative Timeframe selection.

You can now view data for the last x years. You can also see the
Years tab on top-right corner of the Tabular Backup Report.

s The option Next has been removed from the drop-down menu for
Relative Timeframe. You now cannot enter a relative timeframe like
Next 2 weeks.

= UNKNOWN has been added as a value for Policy Type column in
the Policy filter. You can now filter report data for policy types that
are unknown. In earlier versions of OpsCenter the unknown policy
types were shown as blank. Now all static columns like job type,
schedule type, policy type, etc. are shown as unknown like in VBR.

= Job Transport Type column has been added to the Job filter. For
example, you can view report data for jobs for which the Job transport
type is FT or LAN.

Skip File Details

In the Tabular Backup report, you can drill down from the Job Primary ID column
to know the skip file details that are associated with the job. Only some jobs may

have the skipped files that are associated with them. For the jobs that do not have
any skipped files, the drill-down report is either blank or shows hyphens.

Note: The Skip File Details report is also available when you click a Job Primary
ID in the Week at a Glance Details report .

Figure 2-29 shows a sample view of the skip file details report that is obtained by
clicking the Job Primary ID column in Tabular Backup Report.

Figure 2-29 Skip file details
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The following are details associated with the Skip File Details report:

Report Name Skip File Details
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Report Category Backup

Where to Locate Report > Report Templates > Backup > Job Browser > Tabular
Backup Report (click the Job Primary ID link)

Report Purpose Lists the skip file details for the selected job.
Supported products NetBackup, NetBackup Appliance
Applicable View Primary Server, Client

Report Display Tabular

Drill down report None

Can be scheduled Yes

Supported formats CSV, HTML, PDF, XML, TSV

Mapping with VBR report Backups > Job Browser > Scheduled Jobs > Tabular Backup
Report > Skip File Details

You can edit the report to show or hide the columns that you are interested in. All
the columns are shown by default. You can also filter the report to show skipped
files for a specific job primary ID.

The following table shows the filter for Skip File Details report and how you can use
the filter to view specific data in the report.

Filter Column Description

Primary Job Job Primary ID Select a job primary ID to view skipped file details for the
selected job primary ID.

Planning Activity > Capacity Planning > Forecasted Size
report

Planning Activity provides reports on future NetBackup projected trends for storage
capacity needs, media consumption, job sizes, schedules, and counts.

Capacity Planning provides reports on historical NetBackup storage consumption
and projected future NetBackup storage needs.

The Planning Activity > Capacity Planning > Forecasted Size report shows the
supply vs. demand historically but also adds a forecast line for both supply and
demand that can show when in the future they may meet. The point that these two
lines intersect would be the date that new capacity (more disk or more backup
tapes) needs to be added. In the above example the supply is by far outgrowing
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the demand, which would suggest that more capacity does not need to be
purchased.

The default first view of this report shows the entire backup environment but for
actual use it should be filtered to a specific tape library since some libraries may
be closer to full capacity than others.

The EMM Server column has been removed from the Media filter. The Primary
Server filter can be used to view data for specific servers instead of the EMM Server
column.

Planning Activity > Capacity Planning > Historical Size
report

This report shows the historical supply vs. demand. Supply is defined as all available
free space on all the tape media in the backup application. This number is calculated
by taking the average size of all full media of the same tape type. That average is
then used for the predicted size of all other tapes that are not full of the same type.
Use of the average is necessary since tapes do not have an exact capacity and
are written to until the end of tape mark. On the demand side this is a calculation
of all backup jobs for the time period. The idea for this report is that the difference
between the two lines is the extra capacity that was not needed. In an ideal
environment these lines match the blue line, for example, being slightly under the
line showing that all the space for backups is used. This report can sometimes be
referred to as the “just in time inventory” report after the business theory by the
same name.

The default is to show the total environment but for operational use it would need
to be filtered down to individual storage locations since some can be closer to 100%
capacity than others. This change is easily made by clicking Edit Report at the top
of the report.

The EMM Server column has been removed from the Media filter. The Primary
Server filter can be used to view data for specific servers instead of the EMM Server
column.

Planning Activity > Forecast > Job Count report

The Forecast reports provide information on the future projected NetBackup job
sizes and job counts.

The Planning Activity > Forecast > Job Count report displays the total number of
backup jobs for each day in specified time frame. A linear regression forecast is
also performed to show you how many backups you can expect for the next three
days based on the current data.
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Planning Activity > Forecast > Job Size

This report shows you the total number of backup jobs for each day in specified
time frame. A linear regression forecast is also performed to show you how many
backups you can expect for the next three days based on the current data.

Figure 2-30 shows a sample view of Job Size — Forecast Report.

Figure 2-30 Job Size — Forecast Report (Historical)
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Forecast of future backup job sizes across products, domains, clients, policies and business level views.

This report is also available in tabular format.

Figure 2-31 shows a sample view of Job Size — Forecast Report.
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Job Size — Forecast Report (Tabular)
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The following are the details that are associated with the Job size - Forecast

report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported formats

Mapping with VBR report

Job Size — Forecast report
Planning Activity

Report > Report Templates > Backup > Planning Activity >
Forecast > Job Size - Forecast report.

Provides forecast of future backup job sizes across products,
domains, clients, policies and business level views.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Historical

Yes. Drill down reports can be viewed at following five levels
for the selected parameter value. Level 1: Primary Server,
Level 2: Client Name, Level 3: Job Type, Level 4:
Schedule/Level Type, Level 5: Policy Name

Yes
PDF, CSV, HTML, XML, TSV

All Reports > Standard Report > Backup > Activity Planning
> Forecast > Job Size - Forecast
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You can edit the Job size - Forecast reportto show or hide the columns that
you are interested in. All the columns are shown by default. You can also filter the
report to view reports of specific primary servers. The following table shows the
filters for Job size - Forecast report and how you can use these filters to view
specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Client Client Name

Client OS

Policy Policy Name
Policy Type

Policy
Keyword
Policy Data

Classification
Name

Schedule Schedule/Level
Type

Schedule
Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more media servers to view data for the selected
media servers in the report. All media servers that are added to
the OpsCenter console are shown in the Value dropdown list.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classiciation names.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more schedule names to view data for the selected
schedule names.
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Filter Column Description
Job Job Type Select one or more job types as Archive, Backup, or Restore to
Product Type view data for the selected job types.
Select one or more backup products to view data for the selected
Job Transport
products.
Type
Job Status Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.
Select one or more job status like Failed, Successful etc. to view
data for the selected job status.

Example of filter usage: You may run the Job Size — Forecast report for a specific
client to view details for the specific clients.

The following report enhancements have been made for the Job Size — Forecast
report:

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last X years. You can also select Year from the top-right corner
of the report.

= Drill down reports for following five levels have been added in OpsCenter.
= Level 1: Primary Server
= Level 2: Client Name
= Level 3: Job Type
» Level 4: Schedule/Level Type
= Level 5: Policy Name
= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average

= Month of year total
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= Quarter of year Average
= Quarter of year total

The following filter enhancements have been made for the Job Size — Forecast
report:

= New columns Job Status (Complete Only) and Job Status(Complete and Partial
Only) are added to the Report On parameter.

= UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are UNKNOWN.

s The default unit for Y1 axis is now GB.

= Value SAN is removed from the Job Transport Type filter.

Planning Activity > Scheduled Job > Scheduled Job report

Scheduled job provides reports on all future NetBackup scheduled operations to
plan workload capacity, backup windows, and compare against completed
operations.

The Planning Activity > Scheduled Job > Scheduled Job report is available in
Ranking Report view, which depicts how many jobs have been scheduled to run
in future. You can view the Scheduled Jobs per schedule, policy, primary server,
or client.

Note: By default, the Scheduled Jobs report shows job count per policy. If you want
to view the job count for clients, schedules, or primary servers, change the report
parameters.

There is more information available about how to change this report's parameters.

See “Changing the Planning Activity > Scheduled Job > Scheduled Job report
parameters” on page 111.

Changing the Planning Activity > Scheduled Job >
Scheduled Job report parameters

To change the report parameters
1 On the Scheduled Jobs report, click the Edit link.

2 Onthe Report Wizard, from the Report On drop-down list, select a Scheduled
Job attribute. For example: Client, Primary Server, Policy, or Schedule
Name.

3 Click Run.
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Note: To view job count for a specific client, policy, primary server, or schedule,
click Show Advanced Filters and select name of the client, policy, primary server,
or schedule, for which you want to view job count.

There is more information about the Planning Activity > Scheduled Job > Scheduled
Job report.

See “Planning Activity > Scheduled Job > Scheduled Job report” on page 111.

Planning Activity > Scheduled Job > Job Count Scheduled
Vs Actual report

This historical report depicts how many jobs were scheduled to run in future and
how many jobs are run. The report essentially shows the comparison between
Scheduled (Future) Job Count and Actual Job Count.

Using this report you can determine whether the jobs that were scheduled to run
in future have been run on schedule.

Figure 2-32 shows a sample view of the Job Count Scheduled Vs Actual report.

Figure 2-32 Job Count Scheduled Vs Actual report
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The following are details associated with the Job Count Scheduled Vs Actual report:



Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with VBR report
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Job Count Scheduled Vs Actual report
Backup

Report > Report Templates > Backup > Planning Activity >
Scheduled Job > Job Count Scheduled Vs Actual

This historical report compares actual and scheduled job
counts. This report is valid for NetBackup and NetBackup
Appliance.

NetBackup, NetBackup Appliance
Primary Server

Historical

None

Yes

PDF, CSV, TSV, XML, HTML

Backups > Activity Planning > Scheduled Jobs > Job Count
- Scheduled Vs Actual

You can view comparison between actual and scheduled job count for a specific

client, policy, primary server, or schedule by using filters. The following table shows

the filters for Job Count Scheduled Vs Actual report and how you can use these
filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Client Client Name

Policy Policy Name

Schedule Schedule
Name

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more policy names to view data for the selected
policies.

Select one or more schedule names to view data for the selected
schedule names.
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Filter Column Description
Scheduled Exclude By default the Actual Job Count includes manual jobs, which
Job Manual Jobs  were initiated manually. You can exclude manual jobs from the

actual job count, and view only the jobs that are of execution
type Scheduled. To exclude manual jobs in the report, select
Yes.

Example of filter usage: By default the Actual Job Count includes manual jobs,
which were initiated manually by the NetBackup admin. There is more information
available about how to exclude manual jobs from the actual job count.

See “Excluding manual jobs from the actual jobs in the Job Count Scheduled Vs
Actual report” on page 115.

The following enhancements have been made for this report:

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Year tab on top-right corner
of the report.

= The following units for Time Frame Grouping have been removed:

Day of week Average
Day of Week total

Hour of day Average
Hour of day total
Minutes

Month of year Average
Month of year Total
Quarter

Quarter of year Average

Quarter of year total

= The default value for Exclude Manual Jobs column in Scheduled Job filter is
now changed to No. Earlier the default value for Exclude Manual Jobs was
Yes.
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Excluding manual jobs from the actual jobs in the Job
Count Scheduled Vs Actual report

By default the Actual Job Count includes manual jobs, which were initiated manually
by NetBackup admin. To exclude manual jobs from the Actual Job count, and view
only those jobs that have execution type as Scheduled, do the following:

To exclude manual jobs from the actual jobs
1 On the Job Count-Scheduled Vs Actual report, click the Edit link.

2 On the Report Wizard, in the Filter Options section, select Yes from the
Exclude Manual Jobs drop-down list.

3 Click Run.

More information is available about the Planning Activity > Scheduled Job > Job
Count Scheduled Vs Actual report.

See “Planning Activity > Scheduled Job > Job Count Scheduled Vs Actual report”
on page 112.

Planning Activity > Scheduled Job > Job Count within
Backup Window report

This historical report depicts how many jobs were scheduled and how many jobs
have been run within the specified backup window. The report essentially shows
the comparison between Scheduled (Future) Job Count and Actual Job Count,
during the backup window.

Use this report to determine whether your backup windows are appropriate and are
properly used. Click Show Chart as Table link below the report to display report
details in a tabular format.

The Job Count within Backup Window report can show if jobs are finishing within
a specified backup window. This report is complemented with a graphical drawing
of the backup window for a quick analysis. You can quickly determine if all backup
activity is occurring within the defined window.

Furthermore, looking at window performance across broad timelines using intelligent
averaging is also necessary. Missing a window once or twice doesn’t necessarily

point to broader systematic problems and thus the averaging context needs to be
examined alongside the actual daily context.

The following are details associated with the Job Count within Backup Window
report:

Report Name Job Count within Backup Window

Report Category Backup



Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with VBR report

OpsCenter reports
About Report Templates descriptions

Report > Report Templates > Backup > Planning Activity >
Scheduled Job > Job Count within Backup Window

Comparison of actual vs scheduled NetBackup jobs across a
user-defined backup window against a 24-hour timeline.

NetBackup, NetBackup Appliance
Primary Server

Historical

None

Yes

PDF, CSV, TSV, XML, HTML

Backups > Activity Planning > Scheduled Jobs > Job Count
within Backup Window

Figure 2-33 shows a sample view of Job Count within Backup Window report.

Figure 2-33

Job Count within Backup Window report
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This report shows that backups occurred outside of the window shown in green

(18:00 - 09:00).
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The following table shows the filters for Job Count within Backup Window report
and how you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Client Client Name

Policy Policy Name

Schedule Schedule
Name

Scheduled Exclude
Job Manual Jobs

Example of filter usage: You may run the Job Count Window report for a specific

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more policy names to view data for the selected
policies.

Select one or more schedule names to view data for the selected
schedule names.

Select if you want to exclude manual jobs in the report. You can
select Yes or No.

primary server to view job count details only for the selected primary server.

The following enhancements have been made for this report:

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Years tab on top-right corner

of the report.

s The default value for Exclude Manual Jobs column in Scheduled Job filter is

now changed to No. Earlier the default value for Exclude Manual Jobs was

Yes.

Planning Activity > Scheduled Jobs > Job Details
Scheduled Vs Actual report

This tabular report shows the comparison between Scheduled Job count and Actual
Job count for each of the combinations of clients, policies, and schedules, for each

day.
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Job Details Scheduled Vs Actual

Date

Jun 24, 2016
Jun 24, 2016
Jun 24, 2016
Jun 24, 2016
Jun 24, 2016
Jun 25, 2016
Jun 25, 2016
Jun 25, 2016
Jun 25, 2016
Jun 25, 2016
Jun 25, 2016

Server Name

bnmBarhfriend
bnr@drhfriend
bnn@6rhfriend
bn@6rhiriend

beloit miiiliinems.com

bnmBsrhfriend

beloit miiirveri=s.com

bnn@6rhiriend
bnm@arhfriend
pnm@6rhfriend

beloit mimmitasss.com
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Note: By default, the Job Count Details-Scheduled Vs Actual report shows job
count per policy. If you want to view the job count per client or primary server,
change the filter parameters.

Figure 2-34 shows a sample view of the Job Details Scheduled vs Actual report.

Figure 2-34

Client Name

bnmB6rhiriend
bnr@6rhfriend
bnnB6rhiriend
bnrx@6rhiriend
shogun

bnr@6rhfriend
shogun

bnr@6rhiriend
bnrxE6rhiriend
bnrx@6rhfriend
shogun

The following are details associated with the Job Details Scheduled Vs Actual report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Job Details Scheduled Vs Actual report

Scheduled Job
Count

Policy Name Actual Job
Count
ACChbkponHtCryptnbuB0 7
anyavaliablebkpstu 6
normalbkponHRAWRbUSO 7
normalbkponHitCryptnbug0 7
san_test 0
ACCbkponHitCrypinbug0 18
Checkpoint 0
anyavaliablebkpstu 21 20
normalbkponHRAWNbUS0 18 18
normalbkponHitCryptnbuso 17 7
san_test 0 1

-
A @ o~~~

Job Details Scheduled Vs Actual report
Backup

Report > Report Templates > Backup > Planning Activity >
Scheduled Job > Job Details Scheduled Vs Actual

This is a tabular report comparing scheduled to actual job
counts grouped by date, primary server, client and policy. This
report is valid for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Appliance
Primary Server

Tabular

None

Yes

PDF, CSV, TSV, XML, HTML

Backups > Activity Planning > Scheduled Jobs > Job Details
- Scheduled Vs Actual
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The following table lists the filters for Job Details Scheduled Vs Actual report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report.
By default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected

Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Client Client Name  Select one or more clients to view data for the selected clients

in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Policy Policy Name  Select one or more policy names to view data for the selected
policies.
Schedule Schedule Select one or more schedule names to view data for the selected
Name schedule names.
Scheduled Exclude By default, the Actual Job Count includes manual jobs, which
Job Manual Jobs  were initiated manually. You can exclude manual jobs from the

actual job count, and view only the jobs that are of execution
type Scheduled. To exclude manual jobs in the report, select
Yes.

There is more information available about modifying the Planning Activity >
Scheduled Jobs > Job Details Scheduled Vs Actual report.

See “Modifying the Planning Activity > Scheduled Jobs > Job Details Scheduled
Vs Actual report” on page 119.

The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Years tab on top-right corner
of the report.

Modifying the Planning Activity > Scheduled Jobs > Job
Details Scheduled Vs Actual report

Note: By default, the Job Count Details-Scheduled Vs Actual report shows job
count per policy. If you want to view the job count per client or primary server,
change the filter parameters.
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To change the report parameters
1 On the Job Count Details-Scheduled Vs Actual report, click the Edit link.

2 On the Report Wizard, in the Define Viewable Columns section, select a
column name (Client or Primary Server) from the Available Columns list.

3 Click >> option.
Click Run.

Note: To view job count for a specific client, policy, primary server, or schedule, go
to the Filters section and select the name of the policy, primary server, or schedule
for which you want to view job count.

By default the jobs that were run (Actual Job Count) include manual jobs, which do
not have any schedule time associated with them as they are initiated manually.
You can exclude manual jobs from the actual job count, and view only the jobs that
are of execution type Scheduled.

To exclude manual jobs from the actual jobs
1 On the Job Count Details-Scheduled Vs Actual report, click the Edit link.

2 On the Report Wizard, in the Filter Options section, select Yes from the
Exclude Manual Jobs drop-down list.

3 Click Run.

The Job Count Details-Scheduled Vs Actual report shows comparison between
Scheduled Job count and Actual Job count. The Actual Job count includes Manual
Jobs.

There is more information available about the Planning Activity > Scheduled Jobs
> Job Details Scheduled Vs Actual report.

See “Planning Activity > Scheduled Jobs > Job Details Scheduled Vs Actual report”
on page 117.

Planning Activity > Scheduled Job > All Jobs report

This canned report shows jobs in a tabular form, which include the following:
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Manual Jobs

Scheduled Jobs

Planning Activity > Stored Backup Images > Valid Backup

Images report

Stored Backup Images provide reports on NetBackup backup, duplicate, expired,

OpsCenter reports
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These jobs are initiated manually, by NetBackup admin at his or
her discretion. Therefore, these jobs do not have schedule time
associated with them.

Note: While generating the Job Count-Scheduled Vs Actual report,
you have an option to exclude the manual jobs from the actual job
count and show only those jobs that are of execution type
Scheduled.

See “Planning Activity > Scheduled Job > Job Count Scheduled
Vs Actual report” on page 112.

These jobs are scheduled to run in future. Each Scheduled Job
information comprises a client, policy, schedule, and schedule time.
OpsCenter stores this information historically. Each Scheduled Job
when run on the specified schedule time becomes an actual job of
execution type Scheduled. Thus, a Scheduled Job has a
corresponding actual job entry in OpsCenter database. This
particular Scheduled Job can be identified by the unique
combination of client, policy, schedule, and schedule time. You can
compare the schedule time of this Scheduled Job with the
corresponding Job Start Time to determine whether that job was
run on scheduled time or not.

unexpired images and their sizes.

The Valid Backup Images report shows unexpired backup images across products,

domains, clients, policies, and business level views. This report is valid only for
NetBackup. This report is available in Ranking and Distribution views.

The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Years tab on top-right corner
of the Tabular Backup report.

The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks.

The following units for Time Frame Grouping have been removed:

Day of week Average

Day of Week total

Hour of day Average

Hour of day total
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Minutes

Month of year Average
Month of year Total
Quarter

Quarter of year Average

Quarter of year total

The default Report On parameter is None. Earlier it was Primary Server.

UNKNOWN has been added as a value for Policy Type column in the Policy filter.
You can now filter report data for policy types that are UNKNOWN. In earlier versions
of OpsCenter the unknown policy types were shown as blank. Now all static columns
like job type, schedule type, policy type, etc. are shown as UNKNOWN like in VBR.

The following values for Job Type have been removed:

Automatic Discovery and Protection
Cleaning

DB Recover
DQTS

Erase

Generic

Image Cleanup
Import
Inventory

Label

Media Contents
Migration

None
Reclamation
Replication
Report

Restore
Retention

Retrieve
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= Storage Pool Management
= Tape Eject

= Tape Formatting

= Tape Request

= Task Last

= TestRun

» Undefined

= Utility

= Vault

» Verify

The default value "All" for Job Type is not there now. The default-selected value is
Backup.

Add Scheduled Job filter. You can filter on the basis of Schedule Name or
Schedule/Level Type.

The default unit for Y axis is now GB. Earlier it was MB.
The following option has been added:

Show trendline with moving average period of 3. The value can be 1, 2, 3, 7, 14,
or 30.

The Distrbution and ranking view is part of another report in OpsCenter "Valid
Backup Images"

ImageExpirationTime with value NULL should also be considered as in VBR.

Planning Activity > Stored Backup Images > Duplicate
Copies report

The axis on the left is for the height of the blue bars for example that tells the number
of duplicate backup copies that exist overall. The yellow line for example is the axis
on the right and it shows the percentage of backup images that are copies. This is
a particularly useful report for situations where you want to make certain there is
always more than 1 backup copy. If two copies of a backup exist, the blue bar would
be a height of 1 (since there is 1 extra copy) and the line would show .5 for 50%
since half of the backup images are copies. The same situation for 3 copies would
be a blue bar height of 2 and a yellow line percentage of .66 or 66%. In operational
use you can filter this report down to specific policies or the clients that you want
to ensure always have a 50% or greater yellow line so that more than 1 backup
copy exists.
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Planning Activity > Stored Backup Images > Stored Backup
Images > Stored Backup Images on Media

This report shows you the total amount of data in gigabytes that was backed up
but has not expired yet for each of the days in the past two weeks. This report
shows results only for NetBackup and NetBackup Appliances. The report can now
also show trendlines with customized average periods.

Click Show Chart as Table link below the report to view tabular details.

You can also filter the report to show unexpired backed up data for a limited sample
set, such as one or more policies, clients, views, or job status. You can use
timeframe grouping filter. For example: If you want to view unexpired backup images
for the period between 1st Jan 2010 to 1st Feb 2010, in groups each of one week,
select 1 Week from the Group by drop-down list. On the report, you can see data
in four stacked bars, one per week. Using the Report On parameter, you can select
report grouping attribute from the drop-down list, which you want to view the report
for. For example: Backup Job Attributes, Backup Image Attributes etc.

The following are details associated with the Stored Backup Images on Media
report:

Report Name Stored Backup Images on Media
Report Category Backup
Where to Locate Report > Report Templates > Backup > Planning Activity >

Stored Backup Images on Media

Report Purpose Historical report of unexpired image sizes across products,
domains, clients, policies, and business level views.

Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server

Report Display Historical

Drill down report None

Can be scheduled Yes

Supported formats PDF, CSV, TSV, XML, HTML

Mapping with VBR report Backups > Activity Planning > Scheduled Jobs > Stored
Backup Images
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Deviation from VBR The data for this report from VBR and OpsCenter does not

match as OpsCenter points to expiration time from
Image_Copy table while VBR used expiration time from
Image_fragment table. This change was introduced in
OpsCenter 7.1 to correct the behavior of the report and also
improve the performance.

Figure 2-35 shows a sample view of the Stored Backup Images on Media report.

Figure 2-35 Stored Backup Images on Media report
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Historical report of unexpirec image sizes across products, domains, clients, policies and business level views.

The following table shows the filters for Stored Backup Image on Media report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report.

By default All My Views is selected.
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Filter

Primary
Server

Media
server

Client

Policy

Schedule

Job

Column

Primary
Server

Media server

Client Name

Client OS

Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule/Level
Type

Schedule
Name

Job Status

Job Transport
Type

Job Type
Product Type
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Description

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list ..

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the
selected data classification names.

Select one or more policy keywords to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like Full, Incremental etc. to
view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

Select one or more products to view data for the selected
products.
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Example of filter usage: You may run the Stored Backup Images on Media report
for a specific policy to view unexpired image sizes for the specific policy.

The following enhancements have been made in the Stored Backup Images on
Media report:

Report The following report enhancements have been made:

Enhancements The report now also shows trendlines with customized average

periods.
The following option has been added:
Show trendline with moving average period of 3. The value can
be 1,2, 3,7, 14, or 30. The default value is 3.
Select Show trendline with moving average checkbox and use the
drop-down list to specify the number of data points to factor into the
average. At each interval on the graph, the trendline shows a moving
average of the most recent data points. Example: 3 displays a
trendline that, at each interval, shows the average of the current data
point and the two previous data points.

= Fixed issues of data correctness and parity with VBR.
Image Expiration time with value NULL is now considered in the
report.
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Filter
Enhancements



OpsCenter reports | 129
About Report Templates descriptions

The following filter enhancements are listed:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years. You can also select Year
from the top-right corner of the report.

s The option Next has been removed from the drop-down menu for
Relative Timeframe. You now cannot enter a relative timeframe like
Next two weeks.

= The following units for Time Frame Grouping have been removed:
= Day of week Average
= Day of Week total
s Hour of day Average
= Hour of day total
= Minutes
= Month of year Average
= Month of year Total
»  Quarter
= Quarter of year Average
= Quarter of year total

» The default Report On parameter is now None. Earlier it was Primary
Server.

= UNKNOWN has been added as a value for Policy Type column in
the Policy filter. You can now filter report data for the policy types
that are unknown. In earlier versions of OpsCenter the unknown
policy types were shown as blank. Now all static columns like job
type, schedule type, policy type, etc. are shown as UNKNOWN like
in VBR.

» The following values for Job Type column have been removed for
the Jobs filter:

= Automatic Discovery and Protection
= Cleaning

= DB Recover

=« DQTS

= Erase

= Generic

= Image Cleanup
= Import

= Inventory

= Label

= Media Contents
= Migration

= None

= Reclamation
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= Replication
= Report
= Restore
= Retention
= Retrieve
= Storage Pool Management
= Tape Eject
s Tape Formatting
s Tape Request
s Task Last
s TestRun
= Undefined
= Utility
= Vault
n  Verify
= The Job Type column is mandatory and the default-selected value
for Job Type column is Backup. Earlier the Job Type column was
not applied by default.
= Anew filter called Scheduled Jobs has been added. You can now
filter on the basis of Schedule Name or Schedule/Level Type.
= The default unit for Y1 axis is now GB. Earlier it was MB.

The Distribution view and Ranking view for this report is part of Valid Backup Images.

Status & Success Rate > Status > Failed Job Count report

Status & Success Rate provides reports of both basic and advanced success and
failure rates across NetBackup operations in both per backup window and
week-at-a-glance views.

The Success Rate provides advanced reporting on the NetBackup job success
rates including the ability to filter out retry attempts and partially successful jobs for
both Full and Incremental job schedules.

The Failed Job Count report aggregates failed jobs and shows these across a
timeline. In reality, this report is the same as “all jobs” as no distinction on whether
the failed job was first or last one is made. It provides visualization of whether a
problematic trend exists. It can be reported on against any view or level within a
view along with any of the key backup infrastructure components (backup server,
media server) and attributes (policy, policy type, schedule, OS, product, transport
type). Filtering is available on all components and attributes. The primary use case
of the report is verification of whether actions taken to correct persistent failures
produce results and reversing trends. The report can now also show trendlines with
customized average periods.
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Figure 2-36 shows a sample view of the Failed Job Count report.

Figure 2-36
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Historical trends of failed job counts by products, domains, clients, policies and business level views.

Show Chart as Table | Show Report Query

The following are details associated with the Failed Job Count report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Failed Job Count
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Failed Job Count

This report shows the failed job density over time.
NetBackup, NetBackup Appliance

Primary Server, Client

Historical

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Status > Failed Job Count
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The following table shows the filters for Failed Job Count report and how you can
use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Media Media server Select one or more media servers to view data for the specific

server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value drop-down list ..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS
the OpsCenter console are listed.
Select one or more client OS to view data for the selected client
OS in the report.
Policy Policy Data  Select one or more policy data classification names to view data
Classification for the selected policy data classification names.
Name Select one or more policy keyword to view data for the policies
Policy having the selected keyword.
Keyword

Select one or more policy names to view data for the selected
Policy Name policies.

Policy Type  Select one or more policy types to view data for the selected

policy types.

Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to
Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.

Job Job Transport Select one or more transport types like FT, LAN, or Unknown to
Type view data for the jobs that have the selected transport type.
Job Type By default, Backup jobs are shown in the report. You can select

one or more job types like Archive, Backup, Restore etc. to view

Product Type
P data for the selected job types.

Select one or more backup products to view data for the selected
products.
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Filter Column Description
Attempt  Attempt The Attempt Status filter can have two values i.e. Attempt or Job.
Status When Job Count is calculated, the report considers all attempts

if Attempt is selected.

By default, Job is selected. Number of attempts are not
considered when Job is selected.

Example of filter usage: To view a count of all job attempts in the Failed Job Count
report, select Attempt Status as Attempt.

The following report enhancements have been made for Failed Job Count report:

The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

The following options have been removed from Time Frame Group By selection:
= Days of week Average

= Days of week total

= Hours of day Average

= Hours of day Total

= Minutes

= Month of year Average

= Month of year total

= Quarter

= Quarter of year Average

= Quarter of year total

The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)

= Job Status (Complete only)

The Schedule Name column is added under the Schedule filter to filter data by
schedule name.

The report now also shows trendlines with customized average periods.
The following option has been added:
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Show trendline with moving average period of 3. The value can be 1, 2, 3,
7, 14, or 30. The default value is 3.

Select Show trendline with moving average checkbox and use the drop-down
list to specify the number of data points to factor into the average. At each interval
on the graph, the trendline shows a moving average of the most recent data
points. Example: 3 displays a trendline that, at each interval, shows the average
of the current data point and the two previous data points.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are unknown. In earlier
versions of OpsCenter the unknown policy types were shown as blank. Now all
static columns like job type, schedule type, policy type, etc. are shown as
UNKNOWN like in VBR

Status & Success Rate > Status > Partially Successful Job
Count report

This report aggregates partially successful jobs and shows these across a timeline.
It provides a visualization of job volume trends that skip the files that are open during
the backup job. It can be reported on against any view or level within a view along
with any of the key backup infrastructure components (backup server, media server)
and attributes (policy, policy type, schedule, OS, product, transport type). Filtering
is available on all components and attributes. The primary use case of the report
is verification of whether actions taken to correct the open file situation by moving
the scheduling of the client or policies produce results and reversing trends.

Figure 2-37 shows a sample view of the Partially Successful Job Count report.
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Partially Successful Job Count report
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The following are details associated with the Partially Successful Job Count report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

OneTine
o Treed
W paondr

Partially Successful Job Count
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Partially Successful Job Count

This report shows the partially successful jobs density over
time.

NetBackup, NetBackup Appliance
Primary Server, Client

Historical

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Status > Partially Successful Job Count
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The following table shows the filters for Partially Successful Job Count report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Media Media server Select one or more media servers to view data for the specific

server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value drop-down list ..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS
the OpsCenter console are listed.
Select one or more client OS to view data for the selected client
OS in the report.
Policy Policy Data  Select one or more policy data classification names to view data
Classification for the selected policy data classification names.
Name Select one or more policy keyword to view data for the policies
Policy having the selected keyword.
Keyword

Select one or more policy names to view data for the selected
Policy Name policies.

Policy Type  Select one or more policy types to view data for the selected

policy types.

Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to
Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.

Job Job Transport Select one or more transport types like FT, LAN, or Unknown to
Type view data for the jobs that have the selected transport type.
Job Type By default, Backup jobs are shown in the report. You can select

one or more job types like Archive, Backup, Restore etc. to view

Product Type
P data for the selected job types.

Select one or more backup products to view data for the selected
products.
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Filter Column Description
Attempt  Attempt The Attempt Status column can have two values i.e. Attempt or
Status Job. When Job Count is calculated, the report considers all

attempts if Attempt is selected.

By default, Job is selected. Number of attempts are not
considered when Job is selected.

Example of filter usage: You may run the Partially Successful Job Count report
for a specific policy to view partially successful jobs for the specific policy.

The following report enhancements have been made for Partially Successful Job
Count report:

s The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)

s The Schedule Name column is added under the Schedule filter to filter data
by schedule name.

= The report now also shows trendlines with customized average periods.
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The following option has been added:

Show trendline with moving average period of 3. The value can be 1, 2, 3,
7, 14, or 30. The default value is 3.

Select Show trendline with moving average checkbox and use the drop-down
list to specify the number of data points to factor into the average. At each interval
on the graph, the trendline shows a moving average of the most recent data
points. Example: 3 displays a trendline that, at each interval, shows the average
of the current data point and the two previous data points.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are unknown. In earlier
versions of OpsCenter the unknown policy types were shown as blank. Now all
static columns like job type, schedule type, policy type, etc. are shown as
UNKNOWN like in VBR

Status & Success Rate > Status > Successful Job Count
report

This report aggregates successful jobs and shows these across a timeline. It
provides a visualization of job volume trends. It can be reported on against any
view or level within a view along with any of the key backup infrastructure
components (backup server, media server) and attributes (policy, policy type,
schedule, OS, product, transport type). By default backup jobs are shown in the
report. Filtering is available on all components and attributes. The primary use case
of the report is verification of trends and the days that are exception to the norm.
The report is highly effective for presenting long-term historical data on one of the
most fundamental metrics of managing a backup operation.

Figure 2-38 shows a sample view of the Successful Job Count report.
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Figure 2-38 Successful Job Count report
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The following are details associated with the Successful Job Count report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Successful Job Count
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Successful Job Count

This report shows the successful jobs density over time.
NetBackup, NetBackup Appliance

Primary Server, Client

Historical (Chart)

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Status > Successful Job Count
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The following table shows the filters for Successful Job Count report and how you
can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Media Media server Select one or more media servers to view data for the specific

server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value drop-down list ..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS
the OpsCenter console are listed.
Select one or more client OS to view data for the selected client
OS in the report.
Policy Policy Data  Select one or more policy data classification names to view data
Classification for the selected policy data classification names.
Name Select one or more policy keyword to view data for the policies
Policy having the selected keyword.
Keyword

Select one or more policy names to view data for the selected
Policy Name policies.

Policy Type  Select one or more policy types to view data for the selected

policy types.

Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to
Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.

Job Job Transport Select one or more transport types like FT, LAN, or Unknown to
Type view data for the jobs that have the selected transport type.
Job Type By default, Backup jobs are shown in the report. You can select

one or more job types like Archive, Backup, Restore etc. to view

Product Type
P data for the selected job types.

Select one or more backup products to view data for the selected
products.



OpsCenter reports
About Report Templates descriptions

Filter Column Description
Attempt  Attempt The Attempt Status column can have two values i.e. Attempt or
Status Job. When Job Count is calculated, the report considers all

attempts if Attempt is selected.

By default, Job is selected. Number of attempts are not
considered when Job is selected.

Example of filter usage: You may run the Successful Job Count report for a specific
policy to view successful job counts for the specific policy.

The following report enhancements have been made for the Successful Job Count
report:

The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

The following options have been removed from Time Frame Group By selection:
= Days of week Average

= Days of week total

= Hours of day Average

= Hours of day Total

= Minutes

= Month of year Average

= Month of year total

= Quarter

= Quarter of year Average

= Quarter of year total

The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)

= Job Status (Complete only)

The Schedule Name column is added under the Schedule filter to filter data
by schedule name.

The report now also shows trendlines with customized average periods.
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The following option has been added:

Show trendline with moving average period of 3. The value can be 1, 2, 3,
7, 14, or 30. The default value is 3.

Select Show trendline with moving average checkbox and use the drop-down
list to specify the number of data points to factor into the average. At each interval
on the graph, the trendline shows a moving average of the most recent data
points. Example: 3 displays a trendline that, at each interval, shows the average
of the current data point and the two previous data points.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are unknown. In earlier
versions of OpsCenter the unknown policy types were shown as blank. Now all
static columns like job type, schedule type, policy type, etc. are shown as
UNKNOWN like in VBR

Status & Success Rate > Status > All Failed Backups report

This report is one of three using the advanced success or failure calculation logic
around the notion of first, all and last job. They require schedule and window
parameters enabling a precise definition of timeframes. Additionally, these reports
have aggregation levels of job and client. The first job success or failure is the first
job for a client/policy/schedule combination in its defined backup window and last
job is the opposite. As failed jobs are rerun one or more times, the “last job”
represents the last of the reruns within the window. This report produces the details
of the failed jobs based on which one of the three (first or all or last) methods is
chosen. The main use case for this report is based on last job where failure
notification to users is based around last job and failures leading up to the last one
is ignored.

Status > Consecutive Failures

This report is the second of three using the advanced success or failure calculation
logic around the notion of first, all and last job. The main use case is the calculation
of two or more consecutive failures based around Last Job Success/Failure. It
applies intricate logic to pick off the last failed job and in turn to determine that the
last job failures are indeed consecutive. This report can be best verified through
the Client Risk Analysis report. In this report, if three consecutive failures with 24
hour windows were chosen, the client or the policy combination should also appear
on the risk report as not having a successful backup in 72 or more hours.

Jobs that fail consecutively appear in the Consecutive Failures report. The period
for which they fail consecutively is configurable.

Figure 2-39 shows a sample view of Consecutive Failures Report.
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Figure 2-39

Consecutive Failures Report
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Consecutive Failures Report

Policy Name
appesx15_ALUA

appesx15_ALUA
appesx15_ALUA
appesx15_ALUA
appesx15_ALUA

appesx15_ALUA

Schedule Name  Job ID

109686

109961

110269

110377

110429

110457

Start Time
Jul 1,2018
203:15PM
Jul 1, 2016
237:01PM
Jul 1, 2016
2:54:54 PM
Jul 1, 2016
312:01PM
Jul 1,2018
327110 PM
Jul 1,2018
3:39:40 PM

The following columns are displayed in the report:

End Time

Jul 1,2018
2:36:02 PM
Jul 1, 2016
25354 PM
Jul 1, 2016
311:02PM
Jul 1, 2016
31424 PM
Jul 1,2018
3:38:42 PM
Jul 1, 2018
3:44:02 PM

Status Code

143



Node Name

Client Name
Policy Name
Schedule Name
Job ID

Start Time

End Time
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Value in the Node Name column depends on the Report On parameter
that you select. The default value of Report On parameter is Primary
Server. So the value in Node Name column by default shows the primary
server name.

When you select a view from the Filters section while editing the report,
the Report On parameter drop-down list also shows the view levels.
Based on the levels that you select from the Report On drop-down list,
value in the Node Name column changes.

For example, if there is a view like Location with two levels:
Location (View name)

-uUs

-- Client1

-- Client2

-- Client3

- India

-- Client4

-- Clients

-- Client6

The following selections are possible:

= Select this view called Location from the Filters section and select
the Report On parameter as Primary Server (default selection).
The Node Name column displays the primary server.

s Select this view called Location from the Filters section and select
the Report On parameter as Level 1. The Node Name column
displays US and India

= Select this view called Location from the Filters section and select
the Report On parameter as Level 2. The Node Name column
displays the clients (clients 1-6).

Name of the client

Policies associated with the client and node name

Schedules associated with the client

Job IDs associated with the policy and schedule that fail consecutively.
Date and Time when the job started

Date and time when the job ended.
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Status Code Status code for the job ID. You can also filter the report to see details
of only a particular status code by using the Job > Status Code filter and
selecting the specific status codes.

Note that jobs with status code 0 (successful) may also appear in the
report. This usually happens in case of multi-streaming jobs. Job IDs
with status code 0 appear because if any of the sub-jobs of a
multi-streaming job fail, it is considered a complete failure. Generally
the Start Time for the multistreaming jobs would be very close.

The following are the details that are associated with the consecutive Failures
report:

Report Name Consecutive Failures
Report Category Status and Success Rate
Where to Locate Report > Report Templates > Backup > Status and Success

Rate > Status > Consecutive Failures report.

Report Purpose Provides tabular view showing clients that had consecutive
job failures.

Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server, Client

Report Display Tabular

Drill down report None

Can be scheduled Yes

Supported formats PDF, CSV, HTML, XML, TSV

Mapping with VBR report All Reports > Standard Report > Backup > Status >
Consecutive Failures

You can edit the Consecutive Failures reportto show or hide the columns that
you are interested in. All the columns are shown by default. You can also filter the
report to view reports of specific primary servers. The following table shows the
filters for consecutive Failures report and how you can use these filters to view
specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.
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Filter

Primary
Server

Policy

Job

Success
Rate

Column

Primary
Server

Policy Name

Job Types

Status Code

Aggregation
Level

Metric Type

Full Days

Full Window
Parameter

Count Partial
Successful
job as
Successful

Full for
Duration of
(In Hours)

Consecutive
Failures

Increment
Window
Parameter
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Description

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Select one or more policy names to view data for the selected
policies.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more status codes to view data for the selected
status codes.

Select different parameters for criteria definition about success
rate of the jobs. Select All Jobs Success Rate, First job Success
Rate, Last Job Success Rate. Select Aggregation Level to
consider the kind of jobs for the specified time frame. For example,
if you select First Job Success Rate then the report shows only
the first job for the combination of primary server, client, policy,
and schedule.

Select Metric Type to calculate the success rate based as jobs.

Select Full Days to specify the list of days to be considered for
Full backups.

Select Full Window Parameter to specify the start time for the
full backup window.

Select Count Partially Successful Job as Successful to count
partially successful jobs as successful.

Select Full for Duration of (In Hours) to calculate the end time
for the incremental backup window. Backup window end time is
equal to the duration from the start time of the backup window.

Select how many consecutive failures should be included in the
report.

Select Increment Window Parameter to specify the start time
for the incremental backup window.

Schedule/Level Select the schedule of jobs is Full or Increment or All.

Type
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Filter Column Description

Increment for Select Increment for Duration of (In Hours) to calculate the end

Duration of  time for the incremental backup window. Backup window end

(In Hours) time is equal to the duration from the start time of the backup
window.

Increment Select Increment Days to specify the list of days to be considered
Days for Incremental backups.

Example of filter usage: You may run the report for specific policy names to view
details only for that specific policy.

Status & Success Rate > Status > Week At A Glance report

This report summarizes activity for a week by symbolically displaying the result of
each job for each client under the day of the week. The symbols are the blue
(Success) and yellow (Partial Success) men and failures that are denoted by a red
“X”. This report provides quick and comprehensive verification that all is well in the
data protection solution using symbols. A drill-down capability to the job level details
(i.e Job ID, Start/End Time, Size etc.) is provided. You can drill down to any server
on any day and get the job level detail.

It can be reported on against any view or level within a view along with any of the
key backup infrastructure components (backup server, media server) and attributes
(policy, policy type, schedule, OS, product, transport type). Filtering is available on
all components and attributes. The report provides a visualization of job status for
the most current data and how that compares to the previous six days.

This report can be used for automated report generation and email features where
different report filters can be used to show specific systems and then that data
emailed to the relevant parties once a week. It is recommended that you use filters
in large environments. This is because the report shows every primary server and
client by default.

Week at a Glance Report’s performance declines as the data to be displayed in
the report increases. For example, running a two-month report is slower than running
a two-week report.

Note: The Week at a Glance report displays icons when it is exported or emailed
in an HTML format. Earlier in OpsCenter 7.0.x, the Week at a Glance report could
not display icons when exported or emailed in an HTML format. This issue has
been fixed in OpsCenter 7.1 and later versions.

Figure 2-40 shows a sample view of the Week at a Glance report.
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Figure 2-40 Week at a Glance report
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This i a graphical report of the backup status for each protected dient. A blue icon represents a successful backup, 2 yellow icon
represents a partially successful backup, and a red icon represents a faded backup. & gresn background indecates a full backup. A light
blue background represents an incremental backup.

This report shows that there were a number of failures and also quickly shows that
most of the backups completed successfully. Using this report you can see if backups
ran each day of the week and the status of that backup. This report can be scheduled
to be emailed or exported weekly which saves a great deal of time.

The following are details associated with the Week at a Glance report:

Report Name Week at a Glance
Report Category Backup
Where to Locate Report > Report Templates > Backup > Status & Success

Rate > Week At a Glance

Report Purpose This is a graphical report of the backup status for each
protected client. A blue icon represents a successful backup,
a yellow icon represents a partially successful backup, and a
red icon represents a failed backup. A green background
indicates a full backup. A light blue background represents an
incremental backup.



Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats
Mapping with VBR report

Deviations from VBR

The following table shows the filters for Week at a Glance report and how you can
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NetBackup, NetBackup Primary Appliance
Primary Server, Client
Tabular

Week at a Glance Detail
See “Week at a Glance Detail report” on page 151.

The Week at a Glance Details report further drills down to Skip
File Details.

Yes
CSV, TSV, XML, HTML
Backups > Status > Week At a Glance

If one client is backed up by two primary servers, two rows
are shown in OpsCenter while one row is displayed in VBR.

use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client Name
Client OS

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.
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Filter

Policy

Schedule

Job

Column

Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule
Name

Job Status

Job Transport
Type

Job Type
Product Type
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Description

Select one or more policy data classification names like Gold,
Silver, Bronze etc. to view data for the policies having the selected
data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

Select one or more products to view data for the selected
products.

Example of filter usage: You may run the Week at a Glance report for a specific

primary server to view backup status for the clients protected by the specific primary
server. Further if you are interested in knowing about the status of say only Backup

jobs (and no other jobs like Restore or archive jobs), you can use the Job Type
filter and select Backup.

The following enhancements have been made in the Week at a Glance report:
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Report The following report enhancements have been made:

Enhancements The Week at a Glance report can now show the files and directories

that are backed up for each client. The following checkbox has been
added on the Modify Display Options pane when you edit the report:
Show the files and directories backed up for each client
If you check this option and click Run Report, you can view the client
name and the backed up directory in the Client Name column of
Week at a Glance report.

= You can drill down from the Client Name column in the Week at a
Glance report to view Week at a Glance Details report. This was also
available earlier.
Now an additional level of drill down is available from the Week at a
Glance Details report. You can now further drill down from the Job
Primary ID column in Week at a Glance Details report to view Skip
File Details report.

= The Client Name column in the Week at a Glance report is now
sorted by default.

= Earlier if you selected Rolling 8 days column in the Week
Information filter, the Week at a Glance report displayed one day
less than VBR. This issue has now been fixed.

Filter The following filter enhancements are listed:

Enhancements For Week Information filter, the value list for Week of the year column

has been updated. The values staring from 17 Weeks Ago to 30
Weeks Ago have been added. Earlier the value selections were
limited from current week to 16 Weeks Ago.
By selecting these additional values, you can view older data in the
report.
=  UNKNOWN has been added as a value for Policy Type column in
the Policy filter. You can now filter report data for policy types that
are UNKNOWN. In earlier versions of OpsCenter the unknown policy
types were shown as blank. Now all static columns like job type,
schedule type, policy type, etc. are shown as UNKNOWN like in VBR.
= Schedule filter has been added to the list of filters for this report. You
can now view report data for jobs that have a specific schedule name.

Week at a Glance Detail report

In the Week at a Glance report, you can drill down from the Client Name column
to know the job details that are associated with the client in the selected week. You
can also click on a job icon to see job details for the selected day for the specific
client.

Figure 2-41 shows a sample view of the Week at a Glance Details report that is
obtained by clicking the Client Name column in Week at a Glance report.
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Figure 2-41

Week At A Glance Detail

Job Primary
ID

15811

Job
Secondary ID
G460

12278
12319
12783
12797
12803
12829
12846
128595

12912

Total 1,575 Rows , 32 Page(s) M |4 1

Policy Name

AFS-pol

backup-2-disk

Policy-2-backup-
data

backup-2-disk
multi_copy_7
multi_copy_3
multi_copy_9
multi_copy_6&
multi_copy_8

multi_1

multi_copy_5

OpsCenter reports

About Report Templates descriptions

Week at a Glance Detail report
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You can click a Job Primary ID to view skipped file details for the job. A new drilldown
report named Skip File Details has been added.

The following are details associated with the Week At A Glance Details report:

Report Name

Report Category

Where to Locate

Report Purpose

Supported products

Applicable View

Week at a Glance Details

Backup

Report > Report Templates > Backup > Status & Success
Rate > Week At a Glance (click the Client Name link or any

icon)

Backup status for the selected client.

NetBackup, NetBackup Primary Appliance

Primary Server, Client

n

-



Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

OpsCenter reports
About Report Templates descriptions

Tabular

Skip File Detail

See “Skip File Details” on page 104.
Yes
PDF, CSV, TSV, XML, HTML

Backups > Status > Week At a Glance > Week at a Glance
Details

You can edit the report to show or hide the columns that you are interested in. All
the columns are shown by default. You can also filter the report to show jobs for a
specific product or primary server.

The following table shows the filters for Week at a Glance Details report and how
you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client Name
Client OS

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value dropdown list..

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

153



OpsCenter reports | 154
About Report Templates descriptions

Filter Column Description
Policy Policy Data Select one or more policy data classification names like Gold,
Classification ~ Silver, Bronze etc. to view data for the policies having the
Name selected data classiciation names.
Policy Select one or more policy keywords to view data for the policies
Keyword having the selected keyword.
Policy Name  Select one or more policy names to view data for the selected
Policy Type policies.
Select one or more policy types to view data for the selected
policy types.
Schedule Schedule/Level Select one or more schedule types like Full, Incremental etc. to
Type view data for the selected schedule types.
Job Job Status Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
Job Transport it
Type report.
Job Type Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.

Product Type . ) .
Select one or more job types like Archive, Backup, Restore etc.

to view data for the selected job types.

Select one or more products to view data for the selected
products.

Example of filter usage: You may run the Week at a Glance Details report for a
specific policy to view backup details for the specific policy. Further if you are
interested in knowing about the status of say only Full schedule types, you can use
the Schedule filter and select Full.

The following enhancements have been made in the Week at a Glance Details
report:

= The Job Primary ID column in the Week at a Glance Details report is now a
link and you can drill down to Skip File Details report. Use the Skip File Details
report to view the skipped files that are associated with a job.

= The Primary Server OS column has been removed from the Primary Server
filter.

s The Media Server OS column has been removed from the Media Server filter.
s The Client Architecture column has been removed from the Client filter.

= The Policy Domain column has been removed from the Policy filter.
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= The Job Type, Job Transport Type, and Product Type columns have been
added to the Job filter. You can now filter this report on the basis of job type,
job transport type or product type.

Status & Success Rate > Status > Backup Window Failures

report

This report lists the jobs which were scheduled to run but failed because the
scheduled backup window was no longer open (the NetBackup status code is 196).

Status & Success Rate > Status > Partially Successful Job

Details report

This report provides details for all NetBackup partially successful jobs. Partially
successful jobs have an exit status of 1. The table in the report is organized by job

ID, server name, and client name.

Status & Success Rate > Status > Skipped Files Summary

report

The information in this report is presented using a set of linked reports. The main
report that is organized by primary server, displays clients and policies, and the
corresponding number of files that were skipped.

Skipped file details for client report

Skipped file details for policy report

Skipped file details for policy and client
report

This drilldown report from the Client Name column
identifies risks to the client because of any skipped
files.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Policy Name column
identifies risks to the client due to any skipped files.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the No. of Skipped Files
column provides the names of all skipped files.

This drilldown report uses the run time parameters
that are passed from the main report.
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Status & Success Rate > Status > Job Attempt Status Detail
report

This report provides information about the completion status for a NetBackup job.
The report table provides a count of jobs having a particular status code on a specific
day. The table is organized by server name and date. This report was earlier named
as Job Exit Status Detail report.

A drilldown report is available from the Number of Occurrences column of the
table of the main report. This drilldown report shows job details, such as job type
and policy name. The table includes all jobs having a particular status code on a
given day.

Note: This report may provide inaccurate output when a Job ID is reset in NetBackup
like for catalog recovery or via manual resetting of the Job ID. In case the Job ID
is reset, you must delete the NetBackup primary server from the OpsCenter console
and add it again.

Figure 2-42 shows a sample view of the Job Attempt Status Detail report.

Figure 2-42 Job Attempt Status Detail report
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The following are details associated with the Job Attempt Status Detail report:



Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report

The following table shows the filters for Job Attempt Status Detail report and how
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About Report Templates descriptions

Job Attempt Status Detail
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Job Attempt Status Detail

This report shows the successful jobs density over time.
NetBackup, NetBackup Appliance

Primary Server, Client

Tabular

Yes

See “Job details by attempt status” on page 158.
Yes
CSV, HTML, PDF, XML, TSV

Standard Reports > Job > Job Attempt Status Detail

you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Job Job Type

Example of filter usage: You may run the Job Attempt Status Detail report for a

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

specific job type like Backup to view status code details for the backup jobs.

The following report enhancements have been made for the Job Attempt Status

Detail report:

= The unit Years has

been added for Relative Timeframe selection.

You can now view data for the last x years.
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= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= This report was earlier named Job Exit Status Detail. This has been renamed

to Job Attempt Status Detail report.

Job details by attempt status

A drilldown report named Job details by attempt status is available when you click
the Number of Occurrences column in Job Attempt Status Detail report. This
drilldown report shows job details, such as job type and policy name. The table
includes all jobs that have a particular status code on a given day.

This tabular reports shows job information i.e. Job Type, Job End time etc by its

attempt numbers.

Figure 2-43 shows a sample view of the Job details by attempt status report.

Figure 2-43 Job details by attempt status report

ol cheteda by attemgh hafan

Eereer Mok Scbedule  AMen

L IV L

U TS, 3 I

Fii T J_:-:" ot put cadry 1 UREMTNN 1
.
E

muesne PN g L i | e L
]
Sipld,

wncyp b . ;

BHOEHT e’ Btken | v Tttt b - !
L]
mipId

P

TRIEE re B hd edaseieancs — e :
£
npas,

spiney DN o B | e e

PRSI fpve DR e Desneeiua s el e L
C]
pE,

Dcsal [idoald Bahiuy E:;;‘.. Eraplip BTk oot cdry 3 URGMTWN i
£
=pas,

wgian DR s it bgn, T AR | B S Y I 1
)
Sepid,

w i T [!.."L"" Bachsn ;'I_”_. prm b, ek s | wl_pots sary 1 wRewe 1

Sradige

Harbar Printity Uak

0t sk 11

[LIETEE TR

0 s o 1

0 w01}

LI

0 w0 18

LI

) 1h_aute_ 39

The following are details associated with the Job details by attempt status report:

Report Name Job details by attempt status

Report Category Backup
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Where to Locate Report > Report Templates > Backup > Status & Success
Rate > Status > Job Attempt Status Detail (drill down from
Number of Occurrences column) > Job details by attempt

status
Report Purpose This report shows job information by job attempt.
Supported products NetBackup, NetBackup Appliance
Applicable View Primary Server
Report Display Tabular
Drill down report No
Can be scheduled Yes

Supported export formats CSV, HTML, PDF, XML, TSV

Mapping with NOM report ~ Standard Reports > Job > Job Attempt Status Detail (drill down
from Number of Occurrences column) > Job Details By
Status for

The following table shows the filters for Job details by attempt status report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Job Job Type Select one or more job types like Archive, Backup, Restore etc.

Status Code to view data for the selected job types.

Select one or more status codes to view data for the selected
status codes.

Example of filter usage: You may run the Job details by attempt status report for
a specific job type like Backup to view job attempt details for the backup jobs.

The following report enhancements have been made for the Job details by attempt
status report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.
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= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Status & Success Rate > Status > Job Details report

This report provides detailed information about NetBackup jobs.

Status & Success Rate > Status > Job Summary by Status
report

Status Report provides information on basic NetBackup job status including
successful, partially successful, skipped files, and failed backup attempts.

The Job Summary by Status report summarizes NetBackup jobs based on the job
exit status for a specified time interval. You can use this report to provide trend
information.

The bar chart shows a count of successful, partially successful, and failed jobs per
a given date.

Status & Success Rate > Status > Job Status > Historical
report

A Job Status report in red (failure), yellow (partial success) and green (success)
displayed in stacked bar format that is grouped by hour, day, week, month, or year
across any timeframe. The report is a count of jobs for each of the three outcomes.
The simplicity of the presentation helps easily identify both positive and negative
trends as well as one-off deviations. For NetBackup environments, the report can
also be generated where attempts rather than jobs are counted. In NetBackup, jobs
can be configured for x many attempts before a job exits with a status. The report
can be filtered across a selection that includes views, backup and media servers,
backup level, policies, schedules, transport types, Operating Systems, and business
classifications.

Figure 2-44 shows a sample view of the Job Status (Historical) report.
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Job Status (Historical) report
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The following are details associated with the Job Status (Historical) report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Job Status
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Job Status

This report shows job density over time.
NetBackup, NetBackup Primary Appliance
Primary Server, Client, Policy

Historical

No

Yes

CSV, HTML, PDF, XML, TSV

Backup > Status and Success Rate > Status > Job Status
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The following table shows the filters for Job Status report and how you can use
these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Media Media Server Select one or more media servers to view data for the specific

Server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS ]
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Policy Policy Data  Select one or more policy data classification names to view data
Classification for the selected policy data classification names.

Name Select one or more policy keyword to view data for the policies
Policy having the selected keyword.
Keyword

Select one or more policy names to view data for the selected
Policy Name policies.

Policy Type  Select one or more policy types to view data for the selected

policy types.
Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to
Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected

Name schedule names.
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Filter Column Description

Job Job Status Select one or more job status like Failed, Successful etc. to view
Job Transport data for the selected job status.
Type Select one or more transport types like FT, LAN, or Unknown to
Job Type view data for the jobs that have the selected transport type.

By default, Backup jobs are shown in the report. Select one or
more job types like Archive, Backup, Restore etc. to view data
for the selected job types.

Product Type

Select one or more backup products to view data for the selected
products.

Example of filter usage: You may run the Job Status report for a specific policy
to view job counts for the specific policy.

The following report enhancements have been made for the Successful Job Count
report:

s The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)
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= The Schedule Name column is added under the Schedule filter to filter data
by schedule name.

= The report now also shows trendlines with customized average periods.
The following option has been added:
Show trendline with moving average period of 3. The value can be 1, 2, 3,
7,14, or 30. The default value is 3.
Select Show trendline with moving average checkbox and use the drop-down
list to specify the number of data points to factor into the average. At each interval
on the graph, the trendline shows a moving average of the most recent data
points. Example: 3 displays a trendline that, at each interval, shows the average
of the current data point and the two previous data points.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.
Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN like in VBR

Status & Success Rate > Status > Job Status > Distribution
report

A job status report in red (failure), yellow (partial success) and green (success)
displayed in pie chart format. The report is a count of jobs for each of the three
outcomes. The main use cases of the report are typically short-term verification
(i.e. last 24 — 48 hours) of backup job status and long term (i.e. 1+ months)
management level reporting requiring high-level status summaries. The report can
be filtered across a selection that includes views, backup and media servers, backup
level, policies, schedules, transport types, Operating Systems, and business
classifications.

Figure 2-45 shows a sample view of the Job Status (Distribution) report.
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Job Status (Distribution) report

Historical redivellow/green type status count report across products, domains, clients, policies and business level views.
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The following are details associated with the Job Status (Distribution) report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Job Status
Backup

Report > Report Templates > Backup > Status & Success
Rate > Status > Job Status

This report shows job density over time.
NetBackup, NetBackup Primary Appliance
Primary Server, Client, Policy

Distribution

No

Yes

CSV, HTML, PDF, XML, TSV

Backup > Status and Success Rate > Status > Job Status
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The following table shows the filters for Job Status report and how you can use
these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Media Media Server Select one or more media servers to view data for the specific

Server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Client Client Name Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in

Client OS ]
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Policy Policy Data  Select one or more policy data classification names to view data
Classification for the selected policy data classification names.

Name Select one or more policy keyword to view data for the policies
Policy having the selected keyword.
Keyword

Select one or more policy names to view data for the selected
Policy Name policies.

Policy Type  Select one or more policy types to view data for the selected

policy types.
Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to
Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected

Name schedule names.
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Filter Column Description

Job Job Status Select one or more job status like Failed, Successful etc. to view
Job Transport data for the selected job status.
Type Select one or more transport types like FT, LAN, or Unknown to
Job Type view data for the jobs that have the selected transport type.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types. By default, only Backup
is selected.

Product Type

Select one or more backup products to view data for the selected
products.

Example of filter usage: You may run the Job Status report for a specific policy
to view job counts for the specific policy.

The following report enhancements have been made for the Successful Job Count
report:

s The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)
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The Schedule Name column is added under the Schedule filter to filter data
by schedule name.

UNKNOWN has been added as a value for Policy Type column in the Policy

filter. You can now filter report data for policy types that are UNKNOWN. In
earlier versions of OpsCenter the unknown policy types were shown as blank.

Now all static columns like job type, schedule type, policy type, etc. are shown
as UNKNOWN like in VBR

Status & Success Rate > Success Rate > Success Rate —
All Jobs report

This last of the single-line success rate reports give the highest number since it
shows at least one success per client stream. Meaning as long as one job is
successful despite any number of retries, it is a 100% success. This report typically
shows overall exposure to someone outside the backup team. A 100% on this report
indicates that everything was backed up even though it may have taken a number
of retries.

Figure 2-46 shows a sample view of the Success Rate-All Jobs report.

Figure 2-46 Success Rate — All Jobs report
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The following are details associated with the Success Rate — All Jobs report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Success Rate - All Jobs
Backup

Report > Report Templates > Backup > Status & Success
Rate > Success Rate > Success Rate - All Jobs

This report shows the Success rate by job level across
products, domains, clients, policies and business level views.

NetBackup, NetBackup Appliance
Primary Server, Client

Historical (Chart)

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Success Rate > Success Rate - At Least 1 Success
Per Client

The following table shows the filters for Success Rate — All Jobs report and how
you can use these filters to view specific data in the report.

Filter Column
View

Primary  Primary
Server Server

Media Media Server
Server

Client Client Name

Client OS

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.
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Filter

Policy

Schedule

Job

Success
Rate

Example of filter usage: Run the Success Rate - All Jobs report for a specific backup

Column

Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule/Level
Type

Schedule
Name
Job Status

Job Transport
Type

Job Type
Product Type

Consider
Partially
Successful
Job as
Successful
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Description

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like CINC, Copy, Daily etc. to
view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

The value selection for Job Type is mandatory. By default, Backup
jobs are shown in the report. You can select one or more job
types like Archive, Backup, Restore etc. to view data for the
selected job types.

Select one or more backup products to view data for the selected
products.

The default selection is Yes.

Select No if you do not want to consider partially successful jobs
as successful.

Selecting Yes or No may impact the Success Rate percentage
that is shown in the report. Consider a policy that has 5 successful
jobs, 3 partially successful jobs, and 2 failed jobs. If you select
the value as Yes, the Success Rate is 80%. However if you
select the value as No, the Success Rate is 50%.

product to get an idea of the success rate for backup jobs.

The following report enhancements have been made for Success Rate — All Jobs

report:

170



OpsCenter reports
About Report Templates descriptions

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)
= Two new filters called Schedule and Success Rate have been added.

= A new checkbox named Target Performance has been added in the Modify
Display Options page under Timeline Chart Properties. You can use the
Target Performance option to specify where a report draws the target line, with
which you can compare the actual performance shown. The Target Performance
option allows you to specify the target for Y1 axis. In case you set a value of
say 100 for Y1 axis and run the report, you will see a straight line parallel to
X-axis and the value as 100 on Y1 axis. Using this option, you can easily
compare the actual performance with the target performance.

Status & Success Rate > Success Rate > Advanced
Success Rate report

This report uses the advanced success or the failure calculation logic around the
notion of first, all and last job. It collects all information around both successes and
failures and presents the results that are grouped by (day or month) timeframe for
either client or the job success rate. Client success rate is a count of successful
clients where all policies that are defined to the client must be successful to declare
the client successful. Thus a client is either 0% or 100% and no intermediate state.
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Job success rate is derived from all jobs and separated out by first, all and last and
a specific client can have a job success rate that can range between 0% and 100%.
End-user and customer typically get Last Job Success for job and client whereas
backup architects and administrators examine all three. These reports work well
with views and can be reported on at any level with robust filtering capabilities.

This report simply aggregates jobs according to success rate and shows these
across a timeline. It can be reported on against views and view levels, along with
any of the key backup infrastructure components (primary server etc) and attributes
(policy, policy, job etc). Filtering is available on all components and attributes. The
primary use case of the report is verification of trends and the days that are exception
to the norm. The report is highly effective for presenting long-term tabular data on
one of the most fundamental metrics of managing a backup operation.

Figure 2-47 shows a sample view of the Advanced Success Rate report.

Figure 2-47 Advanced Success Rate report

Advanced Success Rate

S Node Successful Failed J-I:E::al ::tzcess Size(MB)
Name Jobs Jobs Count (%)
2OM05 purandar 412 80 a2 83.74  737.94
29109 purandar 413 78 491 | 84.11 | 20,462.7
2915 purandar aa4 74 518 8571 2,770.32
M09 purandar 4213 153 4366 96.5 | 6,541.72
2OM0 pirandar 4213 72| 4285 9832 676.57
29H10 purandar 4211 74| 4285 | 98.27 856.5
SOM10° purandar 4211 71 4282 98.34 856.5
S&r&ﬁim 18117 602 | 18719 96.78 | 32,902.27

The following are details associated with the Advanced Success Rate report:

Report Name Advanced Success Rate
Report Category Backup
Where to Locate Report > Report Templates > Backup > Status & Success

Rate > Success Rate > Advanced Success Rate



Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

OpsCenter reports
About Report Templates descriptions

This report shows the primary server, number of backups that
were successful and failed, the success rate and total amount
processed for each day.

NetBackup, NetBackup Appliance
Primary Server, Client

Tabular

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Status > Daily Summary of Backup Activity

The following table shows the filters for Advanced Success Rate report and how
you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Policy Policy Name

Job Job Type
Status Code

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more policy names to view data for the selected
policies.

You can select one or more job types like Archive, Backup,
Restore etc. to view data for the selected job types. By default,
Backup jobs are shown in the report.

Select one or more status codes to view data for the selected
status codes.
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Success
Rate

Example of filter usage: Run the Advanced Success Rate report for a one week

Column

Aggregation
Level

Full Days

Full Window
Parameter

Metric Type

Full for
Duration of
(In Hours)

Increment
Days

Increment
Window
Parameter

Increment for
Duration of
(In Hours)

Consider
Partially
Successful
Job as
Successful
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Description

Select Aggregation Level to consider the kind of jobs for the
specified time frame. For example, if you select First Job
Success Rate then the report shows only the first job for the
combination of primary, client, policy, and schedule.

Select Full Days to specify the list of days to be considered for
Full backups.

Select Full Window Parameter to specify the start time for the
full backup window.

Select Metric Type to calculate the success rate based on clients
or jobs.

Select Full for Duration of (In Hours) to calculate the end time
for the incremental backup window. Backup window end time is
equal to the duration from the start time of the backup window.

Select Increment Days to specify the list of days to be considered
for Incremental backups.

Select Increment Window Parameter to specify the start time
for the incremental backup window.

Select Increment for Duration of (In Hours) to calculate the end
time for the incremental backup window. Backup window end
time is equal to the duration from the start time of the backup
window.

Select Count Partially Successful Job as Successful to count
partially successful jobs as successful while calculating the
Success Rate.

timeframe and for a single primary server.

The default Relative Timeframe is now changed to Previous 15 days. Earlier the
report showed data for the Previous 14 days by default.

Status & Success Rate > Success Rate > Success Rate -
All Attempts report

This report shows success rate as it is aggregated at the attempt ( “try”) level. Jobs

can be configured for x many attempts before exiting with a status. If for example
the attempt setting is two and success is attained on the second attempt, this
translates into a 50% attempt rate and 100% job success rate. This metric is only

supported for backup applications in which attempt level data is available. A target

line is also supported providing for an effective visual presentation on when the
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target is exceeded. It can be reported on against any view or level within a view
along with any of the key backup infrastructure components (backup server, media
server) and attributes (policy, policy type, schedule, OS, product, transport type).
Filtering is available on all components and attributes. Main use case is long-term
historical data on one of the key performance indicators.

Figure 2-48 shows a sample view of the Success Rate All Attempts report.

Figure 2-48 Success Rate — All Attempts report
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Success rate by all job attempt level across products, domains, clients, policies and business level views.

The following are details associated with the Success Rate — All Attempts report:

Report Name Success Rate - All Attempts
Report Category Backup
Where to Locate Report > Report Templates > Backup > Status & Success

Rate > Success Rate > Success Rate - All Attempts

Report Purpose This report shows the success rate by all job attempt level

across products, domains, clients, policies and business level
views.

Supported products NetBackup, NetBackup Appliance



Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

OpsCenter reports
About Report Templates descriptions

Primary Server, Client
Historical (Chart)

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Success Rate > Success Rate - All Attempts

The following table shows the filters for Success Rate — All Attempts report and
how you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client Name
Client OS

Policy Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.
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Schedule

Job

Success
Rate

Column
Schedule/Level
Type
Schedule
Name

Job Status

Job Transport
Type

Job Type
Product Type

Consider
Partially
Successful
Job as
Successful
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Description

Select one or more schedule types like CINC, Copy, Daily etc. to
view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

The value selection for Job Type is mandatory. By default, Backup
jobs are shown in the report. You can select one or more job
types like Archive, Backup, Restore etc. to view data for the
selected job types.

Select one or more backup products to view data for the selected
products.

The default selection is Yes.

Select No if you do not want to consider partially successful jobs
as successful.

Selecting Yes or No may impact the Success Rate percentage
that is shown in the report. Consider a policy that has 5 successful
jobs, 3 partially successful jobs, and 2 failed jobs for all job
attempts. If you select the value as Yes, the Success Rate is
80%. However if you select the value as No, the Success Rate
is 50%.

Examples of filter usage: You can run this report for a few primary servers for
which you want to view the success rate for all attempts.

The following report enhancements have been made for Success Rate - All Attempts

report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

» The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:

= Days of week Average

= Days of week total
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= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)
= Two new filters called Schedule and Success Rate have been added.

= A new checkbox named Target Performance has been added in the Modify
Display Options page under Timeline Chart Properties. You can use the
Target Performance option to specify where a report draws the target line, with
which you can compare the actual performance shown. The Target Performance
option allows you to specify the target for Y1 axis. In case you set a value of
say 100 for Y1 axis and run the report, you will see a straight line parallel to
X-axis and the value as 100 on Y1 axis. Using this option, you can easily
compare the actual performance with the target performance.

Status & Success Rate > Success Rate > Success Rate -
First Attempt report

This report shows success rate as it is aggregated at the attempt (known as “try”)
level. Specifically, it zooms in on the measurement of the first attempt for each job.
Jobs can be configured for x many attempts before you exit with a status. If for
example the attempt setting is two and success is attained on the second attempt,
this data translates into a 50% All Attempt rate and 0% First Attempt rate and 100%
job success rate. This metric is only supported for backup applications in which
attempt level data is available. A target line is also supported providing for an
effective visual presentation on when the target is exceeded. Filtering is available
on all components and attributes. Main use case is to use this report and the All
Attempts report together to see how often success is attained on the first attempt
as opposed to second, third etc. attempts.

Figure 2-49 shows a sample view of Success Rate - First Attempt report.
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Figure 2-49 Success Rate - First Attempt report
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Success rate by first job attempt level across products, domains, clients, policies and business level views.

The following are details associated with the Success Rate — First Attempt report:

Report Name Success Rate - First Attempt
Report Category Backup
Where to Locate Report > Report Templates > Backup > Status & Success

Rate > Success Rate > Success Rate - First Attempt

Report Purpose This report shows the success rate by first job attempt level
across products, domains, clients, policies and business level
views.

Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server, Client

Report Display Historical (Chart)

Drill down report No

Can be scheduled Yes

Supported export formats CSV, HTML, PDF, XML, TSV
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Backups > Success Rate > Success Rate - First Attempt

The following table shows the filters for Success Rate — First Attempt report and
how you can use these filters to view specific data in the report.

Filter

View

Primary
Server

Media
Server

Client

Policy

Schedule

Column

Primary
Server

Media Server

Client Name

Client OS

Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule/Level
Type

Schedule
Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value dropdown list..

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.
Select one or more schedule types like CINC, Copy, Daily etc. to

view data for the selected schedule types.

Select one or more schedule names to view data for the selected
schedule names.
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Job

Column

Job Status

Job Transport
Type

Job Type
Product Type

Success Consider
Rate

Partially
Successful
Job as
Successful
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Description

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

The value selection for Job Type is mandatory. By default, Backup
jobs are shown in the report. You can select one or more job
types like Archive, Backup, Restore etc. to view data for the
selected job types.

Select one or more backup products to view data for the selected
products.

The default selection is Yes.

Select No if you do not want to consider partially successful jobs
as successful.

Selecting Yes or No may impact the Success Rate percentage
that is shown in the report. Consider a policy that has 5 successful
jobs, 3 partially successful jobs, and 2 failed jobs for the first job
attempt. If you select the value as Yes, the Success Rate is 80%.
However if you select the value as No, the Success Rate is
50%.

Examples of filter usage: You can run this report for a few primary servers for
which you want to view the success rate for the first attempt.

The following report enhancements have been made for Success Rate - First
Attempt report:

The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.

The following options have been removed from Time Frame Group By selection:

Days of week Average

Days of week total

Hours of day Average

Hours of day Total

Minutes
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= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)
= Two new filters called Schedule and Success Rate have been added.

= A new checkbox named Target Performance has been added in the Modify
Display Options page under Timeline Chart Properties. You can use the
Target Performance option to specify where a report draws the target line, with
which you can compare the actual performance shown. The Target Performance
option allows you to specify the target for Y1 axis. In case you set a value of
say 100 for Y1 axis and run the report, you will see a straight line parallel to
X-axis and the value as 100 on Y1 axis. Using this option, you can easily
compare the actual performance with the target performance.

Status & Success Rate > Success Rate > Success Rate -
Line report

This report is a historical report that shows success rate across products, domains,
clients, policies, and business level views. This report simply aggregates jobs
according to success rate and shows these across a timeline. Filtering is available
on all components and attributes. The primary use case of the report is verification
of trends and the days that are exception to the norm. The report is highly effective
for presenting long-term historical data on one of the most fundamental metrics of
managing a backup operation.

Figure 2-50 shows a sample view of the Success Rate Line report.
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Figure 2-50 Success Rate - Line report
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Historical trending report showing success rate across products, domains, dients, policies and business level views.

The following are details associated with the Success Rate Line report:

Report Name Success Rate Line report

Report Category Backup
Where to Locate Report > Report Templates > Backup > Status & Success
Rate > Status > Success Rate Line

Report Purpose This report shows job success rate density over time.
Supported products NetBackup, NetBackup Appliance
Applicable View Primary Server, Client

Report Display Historical (Chart)

Drill down report

No
Can be scheduled Yes
Supported formats PDF, CSV, TSV, XML, HTML
Mapping with VBR report

Backups > Success Rate > Success Rate Line
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The following table shows the filters for Success Rate Line report and how you can
use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Policy Policy Name Select one or more policy names to view data for the selected
policies.
Job Job Type Select one or more job types like Archive, Backup, Restore etc.

Status Code to view data for the selected job types.

Select one or more status codes to view data for the selected
status codes.
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Success Aggregation
Rate Level

Full Days

Full Window
Parameter

Metric Type

Full for
Duration of
(In Hours)

Increment
Days

Increment
Window
Parameter

Increment for
Duration of
(In Hours)

Consider
Partially
Successful
Job as
Successful
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Description

Select Aggregation Level to consider the kind of jobs for the
specified time frame. For example, if you select First Job
Success Rate then the report shows only the first job for the
combination of primary server, client, policy, and schedule.

Select Full Days to specify the list of days to be considered for
Full backups.

Select Full Window Parameter to specify the start time for the
full backup window.

Select Metric Type to calculate the success rate based on clients
or jobs.

Select Full for Duration of (In Hours) to calculate the end time
for the incremental backup window. Backup window end time is
equal to the duration from the start time of the backup window.

Select Increment Days to specify the list of days to be considered
for Incremental backups.

Select Increment Window Parameter to specify the start time
for the incremental backup window.

Select Increment for Duration of (In Hours) to calculate the end
time for the incremental backup window. Backup window end
time is equal to the duration from the start time of the backup
window.

Select Count Partially Successful Job as Successful to count
partially successful jobs as successful while calculating the
Success Rate.

Example of filter usage: Run the Success Rate Line report for a specific job type
like Restore to get an idea of the success rate for restore operations.

The following report enhancements have been made for the Success Rate Line

report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative

Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This

is because the report does not support any futuristic data.
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About Catalog reports in OpsCenter

This section describes catalog reports for all NetBackup Catalog backup operations
for both NetBackup and NetBackup Appliances..

Cold catalog backup report

This report shows the count of cold NetBackup catalog backups and information
about the media that NetBackup uses for offline backups.

Tool tips in the bar chart show the report name and backup count. The table in the
report also lists the media that NetBackup uses for the backups for each primary
server.

About Chargeback reports in OpsCenter

This section provides descriptions of chargeback reports for estimating the specific
costs of providing backup services and storage consumed (with and without
deduplication) to provide chargeback billing of these costs.

Deduplication Chargeback report See “Deduplication Chargeback report”

on page 186.
Cost Tabular report See “Cost Tabular report” on page 191.
Chargeback report See “Backup Chargeback report” on page 191.

Deduplication Chargeback report

This report shows the savings that is achieved because of the deduplication
technology.

To generate this report, you first need to have a cost variable of Protected Job Size.

The deduplication technology can identify files and the data segments that contain
identical data and treats them as a single instance of the file, which it backs up only
once. For example, PureDisk has backed up 100 MB data , in which 20 MB of data
is duplicate or identical. PureDisk protects the same data but eliminates the duplicity
using deduplication. Therefore, the data that is protected is 100 MB, but the actual
data that is backed up by PureDisk is 80 MB, as 20 MB of data is duplicate data.
This results in saving 20 MB of data. You can generate the Deduplication
Chargeback report that shows the amount you have saved using deduplication.

The Deduplication Chargeback report is available in Distribution, Historical, and
Ranking views.
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Figure 2-51 shows a sample distribution view of the Deduplication Chargeback
report.

Figure 2-51 Deduplication Chargeback - Distribution view
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Figure 2-52 shows a sample historical view of the Deduplication chargeback report.
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Figure 2-52 Deduplication Chargeback - Historical View
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Figure 2-53 shows a sample ranking view of the Deduplication chargeback report.



Figure 2-53
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Deduplication Chargeback - Ranking View
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The following are details associated with the Deduplication Chargeback Report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Deduplication Chargeback Report
Chargeback Reports

Report > Report Templates > Chargeback > Deduplication
Chargeback Report

This report shows the savings that is achieved because of the
deduplication technology.

NetBackup, NetBackup Appliance
Primary Server, Client

Distribution, Historical, and Ranking
No

Yes

CSV, HTML, PDF, XML, TSV

Costs > Saving Reports
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The following table shows the filters for Deduplication Chargeback report and how
you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Example of filter usage: Run the Deduplication chargeback report for a specific
primary server to view the cost savings for the specific primary server.

The following report enhancements have been made for Deduplication Chargeback
report:

s The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total
= The following Report On options have been added under Backup Job Attributes:
= Job Status (Complete and Partial only)
= Job Status (Complete only)

= The Primary Server Operating system filter has been removed.
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= The following Report On options have been removed:

Backup Image Copy Is Currently Expired
Backup Image Copy Media Server

Backup Image Encryption State

Backup Image Fragment Is Currently Expired
Backup Image Is Currently Expired

Backup Image Type

Data Classification Primary Server

Data Classification Name

Cost Tabular report

This report shows the chargeback of your backup services in a tabular form.

OpsCenter provides organizations with a tool to evaluate the cost of the IT services
they consume, which is called Chargeback. You can create cost variables and the
formulas that enable you to run the reports that show costs of backup services.

To generate the Cost report you need to have a cost formula created.

Backup Chargeback report

This report shows the chargeback of your backup services in Historical and Ranking
views. You need to have a cost formula created to generate this report.

Figure 2-54 shows a sample Historical view of the Backup Chargeback report:
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Figure 2-54 Backup Chargeback report - Historical View
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Figure 2-55 shows a sample Rankings view of the Backup Chargeback report.



Figure 2-55
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Backup Chargeback report - Rankings view
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Backup Chargeback

The following are details associated with the Backup Chargeback Report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Backup Chargeback Report
Chargeback Reports

Report > Report Templates > Chargeback > Backup
Chargeback Report

This report shows the chargeback of your backup services.
NetBackup, NetBackup Appliance
Primary Server, Client

Historical, Ranking
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Drill down report No
Can be scheduled Yes
Supported export formats CSV, HTML, PDF, XML, TSV

Mapping with VBR report Costs > Cost Reports

The following table shows the filters for Backup Chargeback report and how you
can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

Example of filter usage: Run the Backup Chargeback report for a specific primary
server to view the cost savings for the specific primary server

The following report enhancements have been made for Backup Chargeback report:

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks.

= The following options have been removed from Time Frame Group By selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total
= Quarter
= Quarter of year Average
= Quarter of year total

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years.
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= The following Report On options have been added under Backup Job Attributes:

Job Status (Complete and Partial only)
Job Status (Complete only)

The following Report On options have been removed:

Backup Image Copy Is Currently Expired
Backup Image Copy Media Server

Backup Image Encryption State

Backup Image Fragment Is Currently Expired
Backup Image Is Currently Expired

Backup Image Type

Data Classification Primary Server

Data Classification Name

= The Primary Server Operating System filter has been removed.

About Client reports in OpsCenter

This section provides and describes the status reports of all NetBackup Clients
(physical and virtual) including at risk vs unprotected vs protected Clients and Bare
Metal Recovery (BMR) status.

Risk Analysis > Client Risk Analysis See “Risk Analysis > Client Risk Analysis

report” on page 196.

Risk Analysis > Client Coverage See “Risk Analysis > Client Coverage report”

on page 199.

Risk Analysis > Recovery Point Objective See “Risk Analysis > Recovery Point

Objective report” on page 207.

About clients not backed up report See “Clients Not Backed up report”
on page 211.
Virtual Client Summary See “Virtual Client Summary report”
on page 213.
About job success by client report See “Job Success by Client report”
on page 217.
About client summary dashboard report See “Client summary dashboard report”

on page 223.
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About BMR client configuration backup See “BMR client configuration backup failures
failures report report” on page 224.

About jobs by application report See “Jobs by application report” on page 225.
SAN client jobs report See “ SAN client jobs report” on page 225.

Risk Analysis > Client Risk Analysis report

Risk Analysis provides reports on the NetBackup Clients at risk for being
un-protected or under-protected based on their Recovery Point Objectives (RPO’s).

The Client Risk Analysis report identifies the backup clients that have gone without
a successful backup for a specified period of time and hence are at risk from a
restore standpoint or recoverability standpoint. The “specified period of time” is
user- defined along with several other variables for filtering purposes. The report
is interpreted as all client or policy combinations that have gone x hours, days,
weeks, or months without a successful backup.

The level of granularity is at a client level or policy level and exposes the clients
that have multiple backup policies where one of them may repeatedly fail. The
primary use case is to show that all clients have been backed up as of the last x
hours and all clients have a full backup not more than x days ago. The report also
has an “Is Active” filter to include only those that are currently active as well as the
capability to count partial successes as success and vice versa.

Figure 2-56 shows a sample view of the Client Risk Analysis report.
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Client Risk Analysis report
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The following table provides details on each column that is displayed in the report:

Client Name

Server Name

Policy Name

Name of the client that is at risk because of unsuccessful
backup.

Name of the server associated with this client.

Name of the associated policy.

Last Successful Job Ended Date and time when this client was successfully backed up.

Last Full Job Ended

Date and time when the last full backup job ended.
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Last Incremental Job Ended Date and time when the last incremental backup job ended.

Schedule Name

Status

Online At

Name of the schedule for the last successful backup of this
client. This column is blank if the client was not successfully
backed up anytime.

Status of the client; whether it is online or offline.

If the client is offline, this column displays when the client will
be online again. This column is blank if the client is already
online.

The following are details associated with the Client Risk Analysis Report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

Client Risk Analysis Report
Client Reports

Report > Report Templates > Client Reports > Client Risk
Analysis Report

The report takes a look at all of the clients configured and
determines if the client has had a full successful backup in
the time frame specified. If not, it will be called out as a Risk
so that action can be taken to get a successful full backup.

NetBackup, NetBackup Appliance
Primary Server, Client

Tabular

No

Yes

CSV, HTML, PDF, XML, TSV

Backups > Risk Analysis > Client Risk Analysis

The following table shows the filters for Client Risk Analysis report and how you
can use these filters to view specific data in the report.

Filter Column

View

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.
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Filter Column Description
Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added

to the OpsCenter console are shown in the Value dropdown list.

Client Client is The default selection is Yes. By default, active clients are
Active displayed in the report. Hence the clients that are not actively
backed up are omitted by default. Select No if you want to view
the report for all the clients.

Schedule Schedule Select one or more schedule types like Full, Incremental etc. to
/Level Type view data for the selected schedule types.

Job Job Status Select a Job Status like Successful or Partially Successful or both
to view data for the selected job status in the report.

Example of filter usage: Run the Client Risk Analysis report to include all clients
(both active and non-active) by selecting Client is Active as No.

The following enhancements have been made in the Client Risk Analysis report:

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks.

» Earlier there was a Host filter with Host is Active column. The Host filter has
been removed. The Host is Active column is now renamed as Client is Active
column and exists under the Client filter. The default value of Client is Active
column is Yes.

= The default value of Job Status column under Job filter has been changed to
Successful.

Risk Analysis > Client Coverage report

This is a report where a .CSV file can be imported and compared to the existing
backup solution to determine if there are systems that are not being protected
correctly. The purpose of this report is to show what hosts are not backed up
because the backup application is not even aware of them. The report compares
what OpsCenter hosts are known to be backed up with an external list that is fed
in by .csv file. The list can come from a content management database (CMDB),
DNS listings or any other authoritative source of what hosts should be backed up.
The report works across all backup applications and shows you what backup
application and policy executed the backup and the time of the last full or incremental
backup.
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The Client Coverage report tells you whether all clients in your environment are
being backed up or not. OpsCenter can only report on clients that have already
been defined and configured for backups. This report helps you to identify the clients
that are a part of your environment but are not known to OpsCenter. These clients
may not be getting backed up because of backup software not being installed or
the clients not being configured for backups.

To run this report, you must specify a CSV file (comma-separated value) that
contains a complete and authoritative inventory of all servers across the enterprise.
Some of the independent sources of server inventory across the enterprise which
can be used to generate a CSV file are the following:

= Configuration Management Database (CMDB)
= Asset Management System

= Domain Name System (DNS)

= Homegrown databases

s Spreadsheet

OpsCenter imports data from the CSV file and compares the list of clients (available
in CSV) with the clients known to OpsCenter. The clients which are present in CSV
but not in OpsCenter can be easily identified from this report.

Figure 2-57 shows a sample view of the Client Coverage report.

Figure 2-57 Client Coverage report
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Note: The CSV file must be located on the machine from where you are running
the Client Coverage report. See “About comparison of clients listed in CSV and
OpsCenter” on page 206. for more information on how the comparison takes place.
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The following table provides details on each column that is displayed in the report:

External Client

Backed Up Client

Message

Product

Policy Full Name

Last Full Job Time

Policy Name

Incremental

Last Incremental
Job Time

OpsCenter reports
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Name of the client that appears in the CSV file.

Note: A client may be known by multiple names and all the names
may be documented in the CSV file. The name that appears in the
External Client column is the first name that is documented in the CSV
file. For example, if a CSV file lists multiple names for a client such as,
myhost, myhost.vtas.com, myhost.veritas.com, then myhost appears
in the External Client column.

Name of the backed up client in OpsCenter

The result of comparison. The following are the possible messages:

= Match - Direct
= Match - FQDN vs. Short name
= In External List And Not In Backup

The Client Coverage report helps you to identify these clients which
are present in your environment but are not known to OpsCenter. You
must verify if these clients are being backed up.

See “About comparison of clients listed in CSV and OpsCenter”
on page 206.

A list of backup products used for backing up the client, such as,
NetBackup.

The backup policy associated with the client when the last full backup
was successful

This is the time when the last full backup was successful for the specific
client.

The backup policy associated with the client when the last incremental
backup was successful.

This is the time when the last incremental backup was successful for
the specific client.

The following are details associated with the Client Coverage report:

Report Name
Report Category

Where to Locate

Client Coverage
Client

Report > Report Templates > Client Reports > Risk Analysis
> Client Coverage
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Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with VBR report

OpsCenter reports
About Report Templates descriptions

This report shows a comparison of the list of clients being
backed up against an independently-sourced list (like CMDB,
third party and homegrown asset management systems) of
clients.

NetBackup, NetBackup Primary Appliance
Client

Tabular

No

No

PDF, CSV, TSV, HTML, XML

Backups > Risk Analysis > Client Risk Analysis > Client
Coverage

The following table shows the filters for Client Coverage report and how you can
use these filters to view specific data in the report.

View Selection

Additional Parameters

Select a view from the Select View Name
drop-down list. This can be done to view the
report for a specific location, department etc.
In case you select a specific view, you must
create the CSV file that contains the clients
in the particular view only. For example, if you
want to see the Client Coverage report for
HR department in Canada, then the CSV file
must contain the client list specific to the HR
department in Canada.

202



OpsCenter reports | 203
About Report Templates descriptions

Client Selection Criteria
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All

= All: This is selected by default.
Comparison results for all the clients are
displayed.

= In external list but was never backed
up: Select this option if you want to view
the clients that are present in your
environment but are not known to
OpsCenter. You must verify if these clients
are being backed up.

= Getting backed up but not in external
list: Select this option if you want to view
the clients that are known to OpsCenter
but not present in the CSV file. This may
be due to several reasons like machine
not being available in the network or
machine not registered in the DNS, and
SO on.

= Is matching (Direct): Select this option
if you want to view the clients for which
host name in CSV is exactly the same as
the host name in OpsCenter. For example,
myhost.vtas.com in CSV and
myhost.veritas.com in OpsCenter.

= Is matching (FQDN vs Short Name) :
Select this option if you want to view the
clients for which the host name is an
FQDN in CSV and a short name in
OpsCenter or a short name in CSV and
an FQDN in OpsCenter. For example, if
the CSV file contains myhost.veritas.com
and OpsCenter contains myhost, then the
comparison result is Match - FQDN vs.
Short Name. Similarly, if the CSV file
contains myhost and OpsCenter contains
myhost.veritas.com, then the client is
displayed in the report.

= Was getting backed up but not in
external list: Select this option if you want
to view the clients that were being backed
up earlier but not present in the CSV file.

= Was matching (Direct): Select this option
if you want to view the clients for which
host name in CSV was exactly the same
as the host name in OpsCenter. For
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Display Options
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example, myhost.vtas.com in CSV and
myhost.veritas.com in OpsCenter.

= Was matching (FQDN vs Short Name)
: Select this option if you want to view the
clients for which the host name was an
FQDN in CSV and a short name in
OpsCenter or a short name in CSV and
an FQDN in OpsCenter.

You can specify a part of the backed up client
name so that the report shows data only for
the specific backed up clients that are of your
interest. For example, to see details of all
backed up servers running Oracle which are
known to have a string "ora" somewhere in
the host name, you can type the following:

»  %ora% - Include or exclude all backed up
clients with ‘ora’ anywhere in the host
name

= ora - Include or exclude all backed up
clients named ora.

» ora% - Include or exclude all backed up
clients whose names start with ora.

m  %ora - Include or exclude all backed up
clients whose names end with ora.

= Similarly, you can specify multiple search
strings as follows:

n  %ora%, %syb% - Include or exclude
all OpsCenter hosts with Ora or Syb
anywhere in the backed up client
name.

Note: This search is applicable only for
Backed up clients and not the External
Clients.

Note: The search is not case-sensitive. For
example, if you search for Ora, you may find
results like ora, Ora, oRa, and so on.

Type a report description.

Select the number of rows you want displayed
on a single page.
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Example of filter usage: To view details of all backed up servers running VMWare
that are known to have 'vm' somewhere in the host name, type %vm% in the Wild
Card text box.

About CSV formats

The CSV file required as an input to the Client Coverage report can be created
using a text editor or Microsoft Excel application.

A typical CSV file format is as follows:
Host1_name1,Host1_name2,Host1_name3,Host1_name4
Host2

Host3

Note: Host1_name1,Host1_name2,Host1_name3,Host1_name4 are multiple names
of the same machine. Multiple names for the same machine may exist due to many
reasons like because of a machine having multiple Network Interface Cards etc.

Note: Each host machine exists in a new line. For example, Host1, Host2, and
Host3 all exist in three separate lines.

Here is a sample CSV format:
css-bin3,css-bin3.veritas.com
macy.veritas.com,macy,macy.vtas.com

css-bin10.veritas.com

Note: There is no space after the comma in the CSV file.

About comparison of clients listed in CSV and OpsCenter

OpsCenter imports data from the CSV file and compares the list of clients (available
in CSV) with the clients known to OpsCenter.

The Client Coverage report shows any or all of the following outcomes after
comparison:
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Clientis in External This means that a client exists in both the CSV file and OpsCenter
Client and Backed database.

Up Client list Note: In case multiple names for a system are present in CSV and

OpsCenter, then all the names present in CSV are compared with each
name in OpsCenter till a match is obtained.

The comparison results in this case may be one of the following:

= Match - Direct: This happens when the host name in CSV is exactly
the same as the host name in OpsCenter. For example,
myhost.veritas.com in CSV and myhost.vtas.com in OpsCenter.

s Match - FQDN vs. Short Name: This happens when the host name
is an FQDN in CSV and a short name in OpsCenter or a short name
in CSV and an FQDN in OpsCenter. For example, if the CSV file
contains myhost.veritas.com and OpsCenter contains myhost, then
the comparison result is Match - FQDN vs. Short Name. Similarly,
if the CSV file contains myhost and OpsCenter contains
myhost.veritas.com, then the comparison result is Match - FQDN
vs. Short Name.

In External List The Client Coverage report helps you to identify these clients which
And Not In Backup are present in your environment but are not known to OpsCenter. You
must verify if these clients are being backed up.

In Backup And Not This happens when the host name is known to OpsCenter but not

In External List present in the CSV file. This may be due to several reasons like
computer not being available in the network or computer not registered
in the DNS, and so on.

Risk Analysis > Recovery Point Objective report

Recovery Point Objective (RPO) and Recovery Time Objective (RTO) have emerged
as generally accepted metrics for client recoverability. This report ranks all clients
by the amount of time that is elapsed since their last successful backup. The report
shows how long it has been since each system has had a successful backup and
therefore would have difficulty meeting a Recovery Point. In larger environments

being able to run this report on a weekly basis will quickly show where there is risk
due to systems that have not been backed up in a pre-determined amount of time.

In contrast to the Client Risk Analysis report, the level of granularity is the client
level and thus clients with multiple backup policies are represented by the policy
with most recent success. It is recommended that this report not be used for
multi-policy clients. The client “IsActive” filter allows for those hosts that are not
actively being backed up to be omitted. The elapsed time in the report is always
between now and the last successful backup. The report is effective in its graphical
rankings format placing the clients with longest elapsed time at the top.
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Figure 2-58 shows a sample view of the Recovery Point Objective report.

Figure 2-58 Recovery Point Objective report
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In the example, no backups have been run for nearly 10 hours for all the clients.
This means that for the five systems on the report, the best RPO possible would
be nearly 10 hours. If you have committed to an 8 hour RPO, then these systems
need to be backed up quickly to be able to meet that SLA.

The following are details associated with the Recovery Point Objective report:

Report Name Recovery Point Objective
Report Category Client Reports
Where to Locate Report > Report Templates > Client Reports > Risk Analysis

> Recovery Point Objective

Report Purpose User-configurable threshold-based rankings report of clients
exceeding their recovery point objectives.

Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server, Client

Report Display Rankings (Chart)
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Drill down report

Can be scheduled

Supported export formats

Mapping with VBR report
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No
Yes
PDF, CSV, TSV, HTML, XML

Backups > Risk Analysis > Recovery Point Objective - RPO

The following table shows the filters for Recovery Point Objective report and how
you can use these filters to view specific data in the report.

Filter
View
Primary

Server

Media
Server

Client

Policy

Column

Primary

Server

Media Server

Client is
Active

Client Name

Client OS

Policy
Keyword

Policy Name

Policy Type

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down list

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in the
Value drop-down list.

The default selection is Yes. By default, Active Clients are
displayed in the report. Hence the clients that are not actively
backed up are omitted by default. Select No if you want to view
the report for all the clients.

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.
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Filter Column Description

Schedule Schedule/Level Select one or more schedule types like CINC, Copy, Daily etc. to

Type view data for the selected schedule types.
Schedule Select one or more schedule names to view data for the selected
Name schedule names.
Job Job Status Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
Job Transport
report.
Type

Select one or more transport types like FT, LAN, or Unknown to

Job Type } )
view data for the jobs that have the selected transport type.

The value selection for Job Type is mandatory. By default, Backup
jobs are shown in the report. You can select one or more job
types like Archive, Backup, Restore etc. to view data for the
selected job types.

Example of filter usage: You may run the report for specific primary servers to
view details for the clients backed up by specific primary servers.

The following enhancements have been made in the Stored Backup Images on
Media report:

= You can now click (drill down) the bar for each client and view Recovery Point
Objective report for job type, schedule/level type and policy name.

= The Job Type column has been added under the Job filter.
= For the Policy filter, the following columns have been added:
= Policy Keyword
= Policy Type
= The Schedule filter has been added.
= The following Report On parameters have been added:
= Job Type
= Policy Name
= Schedule/Level Type

s Earlier there was a Host filter with Host is Active column. The Host filter has
been removed. The Host is Active column is now renamed as Client is Active
column and exists under the Client filter. The default value of Client is Active
column is Yes.
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Clients Not Backed up report

This report provides a list of NetBackup clients that have not been backed up or
clients for which all backups failed during the reporting period.

You can determine if all jobs of a policy and client combination have failed or have
not been initiated during the reporting period. You can filter by type of policy like
SharePoint, Oracle, Windows NT and so on.

The client name is displayed multiple times in the report if the client has multiple
NetBackup policies that are associated with it and none of the policies are run during
the reporting period. The report shows details like policy name, schedule name,
and date of the last successful backup.

You can now view data in this report for a specific client view by selecting a client
view from the View filter. Earlier you could only filter the report data for a primary
server view.

Figure 2-59 shows a sample view of the Clients not backed up report.

Figure 2-59 Clients Not Backed up report

Clienls Mol Backed ms

Clist Last
S hedale
Server Mame  Clienl Name Gperating I::dr:are Pulicy Hame = Successul
Fpatzm

MBLI_SSE_Aarver  pasrmilier, vini il dvslied 8 Snrd Aclaiie el _paboy_pisnder ckere  Tulls

oEmi-ge-d  AUWEIAFLICAL RICTINTCLCRG Wningan - (LA WINTOOISRY. VEEACFD] | [Dasdy] i
opwae-d  AUWEIAR1CALRIGTINTOWAG wningwn - OLALWINIDIISAVNEEACFD] | [Montih] Seeenpai
CobwA-da-d | AUWELAR1.CALRECTINTOLOAS wkraan BLALWINIGISRVVESACRO] [weekl] oo b 0L
ooE-Aln-ga-d AUSEIFILEL CAL SIOTINTOORS kAT - (0L WINIOIISRV VERACFD] [Dasly] ?:M:q :\:0:5']"
oof-An-ge-d SUEIFILELCAL SIOTINTQORS nkngan - L0123 WINFORIERV VER ACFDY  [Monthly)

wop-ainge-d AUGTIT LD DAL RIGTINTOORS Binkrigam - CELAEWINGDEISAV.VERACHD] [Weekly]

cop-Al-ga-d HUWTIMP L CAL ZI0TINTOORG Unkrzan - L1 L WINSODRSA Y VEE ADRD] (o]

cop-min-qa-i ALVSEIMPYCAL EIDTINTOORG Uninawn = (1L WINGOMESAY.VS5.A000] [E0M] raa
ssp-min-ga-4 AUTIHMP L CALEICTIRTOORG wningan - LIRSS AR [wenr] e
cop-min-ga-d ALWEISRTLCAL SIDTINTO.ORG Unkrizan - {0197 WINIDIISAV.VEEAORD] | [Dady] mf‘ifg’

Totel 48 Baws, 2Papels) (1] 4 1 2 [ [
Lists o the chanis rot Backed up mERen glven tmas irsme,

The following are details for the Clients Not Backed up report:

Report Name Clients Not Backed up

Report Category Client Reports
Where to Locate Report > Report Templates > Client Reports > Clients Not

Backed up



Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report

Deviation from NOM

OpsCenter reports
About Report Templates descriptions

This report lists all the clients that are not backed up in the
selected timeframe.

NetBackup, NetBackup Primary Appliance
Primary Server, Client

Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Clients Not Backed
up

Last Successful Backup column shows the job end time in
OpsCenter. However, this column shows the job start time in
NOM.

The following table shows the filters for Clients not backed up report and how you
can use these filters to view specific data in the report.

Filter Column

View

Policy Policy Type

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more policy types like NDMP, FlashBackup etc. to
view data for the selected policy types.

Example of filter usage: You may run the Clients not Backed up report for a specific
policy type like FlashBackup to view backup details for the specific policy type.

The following enhancements have been made in the Clients Not Backed up report:

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Years tab on top-right corner
of the Tabular Backup Report.

=  UNKNOWN has been added as a value for Policy Type column in the Policy
filter. You can now filter report data for policy types that are unknown. In earlier
versions of OpsCenter, the unknown policy types were shown as blank.
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Virtual Client Summary report

The Virtual Client Summary report shows details of all virtual clients of a NetBackup
primary server. Using this report, you can determine whether these virtual clients
were backed up by NetBackup or not. Thus, you can report on the virtual clients
that need to be protected. It also shows at a glance that last time the client was
backed up. .

You can also drill down in this report to see the job details of a specific virtual client.

OpsCenter can poll the vCenter or Hyper-V server to determine what systems have
been configured and compare that with the NetBackup policies that have been
created. This helps to track those virtual machines that are not being protected by
any NetBackup polices.

Note: Cheking that the virtual machine is added in the is possible opnly when the
policy is manually created or when successful backup has happened for the virtual
machine.

Figure 2-60 shows a sample view of the Virtual Client Summary report.

Figure 2-60 Virtual Client Summary report

Virtual Client Summary

Backup Policy  Job

VM Name (NetBackup) VM Display Name (Viware/Hyper.V) Status Type D Hypervisor Host or Cluster
vi2n-host-16.punin.semi.mteczz:com smb3.0_vm Successful HyperV 89 hyper16_win-1.pne.venuwits. acom
hyper-auto-3 punin_senyzsnaiiteccom  win2003_hyper_v_vm_w_iso =smymac 20 .com - Hyper-V/ -  hyper16_win-1 pne ven erits: com

The sample report shows an example of vCenter server that has a number of VMs
configured. Most of the virtual clients do not exist in any NetBackup policy and need
to be added or protected. It also shows at a glance the last time the system was
backed up (from the Last Successful Backup Time column).

The Virtual Client Summary report shows the following columns:
Virtual Server Name Name of the virtual server host such as VMware

or Hyper-V server

Data Store Data store associated with the virtual client. Data
Store is where virtual machine configuration files
are stored.

Host Name of the backup host.



Virtual Client Name

uuiD

VM Host Name
Instance ID

IP Address

Type

Server Name

Exists in a Policy

Last Backup Time
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Display name of the virtual client running on a
virtual server.

Multiple virtual clients may have the same IP
address. But they can be identified by their UUIDs.
UUID is a unique identifier of a virtual client.

Note: Click the virtual client name link to view its
job details.

BIOS UUID for the virtual client.

IP address of the virtual client

Type of the virtual server that this client belongs
to, such as VMware or Hyper-V

Name of the NetBackup Primary Server, which
backs up this virtual client

This field is shown blank if this virtual client is not
backed up by any NetBackup primary server

This status field that describes whether backing
up this virtual client is defined in any NetBackup
policy or not

If a NetBackup Primary Server backs up this client,
this field displays “Yes”. If it shows “No”, it means
that this client should be backed up and be
protected.

Time when this virtual client was backed up last

This field displays '-' if the client is not defined in
a backup policy or it is yet to be backed up.

The following are details for the Virtual Client Summary report:

Report Name
Report Category

Where to Locate

Virtual Client Summary
Client Reports

Report > Report Templates > Client Reports > Virtual Client
Summary
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Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report
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This report shows details of the VMware or Hyper-V servers
that you have configured with NetBackup. It also shows
whether these virtual machines are protected by NetBackup
or not.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Tabular

Yes

See “Virtual Client Job Details” on page 215.
Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Virtual Client
Summary

The following table shows the filters for Virtual Client Summary report and how you
can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value dropdown list.

Example of filter usage: You may run the Virtual Client Summary report for a
specific client view to view details for the specific clients.

Virtual Client Job Details

This drilldown report is obtained when you click a virtual client name (link) from the
Virtual Summary report. This report shows details for a virtual client like policies,
schedules, backup start and end time, data backed up etc.

Figure 2-61 shows a sample view of the Virtual Client Job Details report.
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Figure 2-61 Virtual Client Job Details
Virtual Client Job Details
. . Data
Server Client Policy Schedule Status Start End
Job ID _ _ Backed
Name Name Name Name Code Time Time
up(GB)
Sep 21, | 5ep2i,
opscenter- | vbr-pd-1 . 2011 2011
win2k3 [pds.2.0] 55 |VMware | UNKNOWN 156 153328 2:33:53 0
PM PM
Sep 21, |Sep?1,
opscenter- vbr-pd-1 X 2011 2011
win2k3 [pds.2.0] 23 |WhIErE | URIEIE 150 5.35:37  3:09:53 C
PM PM
Sep 21, | 5ep2i,
opscenter- | vbr-pd-1 . 2011 2011
win2k3 [pds.2.0] 57 |VMware | Full 150 15035:51 | 3:29:43 20.33
PM PM

The following are details associated with the Virtual Client Job Details report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

Virtual Client Job Details
Client Reports

Report > Report Templates > Client Reports > Virtual Client
Summary (click the virtual client name) > Virtual Client Job
Details

This report shows the details of selected virtual machine.
NetBackup, NetBackup Appliance

Primary Server, Client

Tabular

None

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Virtual Client
Summary (click the virtual client name)

The following table shows the filters for Virtual Client Job Details report and how
you can use these filters to view specific data in the report.



Filter

View

Primary
Server

Client

Column

Primary
Server

Client Name
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Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Example of filter usage: You may run the Virtual Client Job Details report for a
specific client to view details for the specific clients.

Job Success by Client report

This report shows the rate of success for client jobs.

The bar chart shows totals for successful, partially successful, and failed jobs for

each client that is backed up by the selected primary servers. Tool tips in the bars
show these job counts. The tool tips for each client also include links to a drill-down

report showing details for all job types.

Click Show Chart as Table link to display job counts of successful, partially
successful, or failed jobs for each client in the selected timeframe.

Figure 2-62 shows a sample view of the Job Success by Client report.
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Job Success by Client report
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The following are details for the Job Success by Client report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report

Job Success by Client
Client Reports

Report > Report Templates > Client Reports > Job Success
by Client

This report shows the job success by client. This report is valid
for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance
Primary Server, Client

Historical (Chart)

Job Details by Client

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Job Success by
Client
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The following table shows the filters for Job Success by Client report and how you
can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the clients

Server Server backed up by the selected primary servers in the report. All
primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Example of filter usage: You may run the Job Success by Client report for a
specific primary server to view job success details for the clients that are protected
by the specific primary server.

The following enhancements have been made for the Job Success by Client report:

= You can now drill down by clicking the bars in the report. A drill-down report
called Job Details by Client is available.

= The Report On parameter that let you group the report by Exit Status has been
removed from the Modify Display Options page.

Job Details by Client

This report can be drilled down either by clicking the bar charts in Jobs Success
by Client report or from the Client Name column in Jobs Success by Client (Tabular)
report. This drilldown report lists details of all the jobs for the selected client and
time frame.

The table includes details like Job type, status code, and media server name.
The report now also displays the Media Server column.

Figure 2-63 shows a sample view of the Job Details by Client report.
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Figure 2-63 Job Details by Client

Job Details By Client
Johb Job Status Schedule
o Server Name Client Name Type Code Media Server Policy Name Name
17795 MNBU_&56_Server MNBU_ 856 Server Backup 0 ocs-sol-ge-11 testd fulllo
17794 | NBU_656_Server MNBU_E56_Server Backup 0 | MBU_B56_Server |bestl full1o
17793 MNBU_S55_Server NBU_G56_Server Backup 0  ces-sol-ge-11 pol_auto_copy_d4 | fulllD
17792 | NBU_656_Server NBU_E56_Server Backup 0  ces-sol-ge-11 pol_aute_copy_8 | fulllD
17791 | NBU_655_Server NBU_65&6_ Server Backup 0  MEU_&56_Server | pol_auto_copy_7 | fulllD
17790 | NBU_S55_Server NBU_ES&_Server Backup 0 NBU_B56_Server | pol_auto_copy_2 |fulll0
4 1] |2

Total 5,465 Rows , 55Page(s) M| [+ 1 2 3 2 s 8 7z &8 2 10 [ [0

Job Details By Client. This report iz valid for NetBackup and NetBackup Appliance.

The following is more information on the Job Details by Client report:

Report Name

Report Category

Where to Locate

Report Purpose

Supported products

Applicable View

Job Details by Client

Client Reports

Report > Report Templates > Client Reports > Job Success
by Client (click the bar chart) or Job Success by Client
(Tabular) (click the Client Name column)

This report lists job details for client. This report is valid for
NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance

Primary Server, Client



Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report
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Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Job Success by
Client > Job Details by Client

The following table shows the filters for Job Details by Client report and how you
can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Client Client Name

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients
backed up by the selected primary servers in the report. All
primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Select one or more clients to view data for the selected clients in
the report. All clients that are protected by the primary servers in
the OpsCenter console are listed.

Example of filter usage: You may run the Job Details by Client report for specific
clients or primary servers.

Job Success by

Client (Tabular) report

This report shows the rate of success for client jobs. The tabular report shows totals

for successful, partially

successful, and failed jobs for each client that is backed up

by the selected primary servers.

You can also drill-down from the following columns in the table:

s Client Name

=  Number of Successful Jobs

= Number of Partially Successful Jobs

=  Number of Failed Jobs

Figure 2-64 shows a sample view of the Job Success by Client (Tabular) report.
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Figure 2-64 Job Success by Client (Tabular) report

Chart as Table tad
Client Name Job Count - Successful Job Count - Failed
mnlinecldvm0 1 pRe VEas aiirom 18 7
1021018 5 1
sash__win2k3r2_nfs_rd_(zositm) tintzmam 0 2

Total 3 Rows , 1 Page(s)

The following are details for the Job Success by Client (Tabular) report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report

Job Success by Client
Client Reports

Report > Report Templates > Client Reports > Job Success
by Client (Tabular)

This report shows the job success by client. This report is valid
for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance
Primary Server, Client
Tabular

Job Details for Client

Successful Job Details for Client
Partially Successful Job Details for Client
Failed Job Details for Client

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Job Success by
Client

The following table shows the filters for Job Success by Client report and how you
can use these filters to view specific data in the report.
Filter

Column Description

View Select a view to show data for the selected view in the report. By

default All My Views is selected.
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Filter Column Description
Primary  Primary Select one or more primary servers to view data for the clients
Server Server backed up by the selected primary servers in the report. All

primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Client Client Name Select one or more clients to view data for the clients.

Example of filter usage: You may run the Job Success by Client (Tabular) report
for specific clients to view job success details for the selected clients.

Client summary dashboard report

This report summarizes several parameters for each client for the selected server
context and acts as a dashboard of NetBackup activities. You can use drilldown
links to view client detail reports for many of the columns in the table.

The drilldown reports provide information about the client and answer the following
questions:

=  What is the server name, IP address, and operating system type?

= How much volume for a client is backed up?

= How many successful, partially successful, and failed jobs for the client?
= What is the number of restore jobs that run for the client?

=  What is the average job throughput?

You can now view data in this report for a specific client view by selecting a client
view from the View filter. Earlier you could only filter the report data for a primary
server view.

The report can also be used as a tool to monitor the health of backup activities for
your managed clients.

Total jobs for client report This drilldown report from the Number of Total
Jobs column lists all the jobs for the selected client
and time frame. The job details include policy
name, schedule name, and throughput (KB/sec).

This drilldown report uses the run time parameters
that are passed from the main report.



Successful jobs for client report

Partially successful jobs for client report

Failed jobs for client report

Restore jobs for client report
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This drilldown report from the Number of
Successful Jobs column lists the successful jobs
for the selected client and time frame. The report
lists job details, such as, job type, policy name,
start and end times, and job duration.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Number of Partial
Successful Jobs column shows the partially
successful jobs for the selected client and time
frame. The report lists job details, such as, job type,
policy name, start and end times, and job duration.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Number of Failed
Jobs column lists the failed jobs for the selected
client and time frame. Any jobs with an exit status
other than 0 or 1 are considered to be failed jobs.

The report lists job details, such as, job type, policy
name, start and end times, and job duration.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Number of Restore
Jobs column lists restores job details for the
selected client. It provides details like policy name,
schedule name, and throughput (KB/sec).

This drilldown report uses the run time parameters
that are passed from the main report.

BMR client configuration backup failures report
If a NetBackup policy has the Collect BMR Info flag set, the job backs up BMR

(Bare Metal Restore) client configuration. This job type starts one or more dependant

jobs to back up the client data.

This report shows all jobs that failed to completely back up a BMR client

configuration, but their related child jobs (client data backup jobs) were partially or

fully successful.

You can now view data in this report for a specific client view by selecting a client

view from the View filter. Earlier you could only filter the report data for a primary

server view.
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Jobs by application report

This report uses the NetBackup policy type to simulate an application level report.
For example, an Oracle policy type implies an Oracle application. The report then
lets you see all Oracle backups.

The table in this report organizes jobs in the table by server, client, and application
and includes the backup size in MBs and the number of files. The Application (policy
type) column provides a drilldown link to job details for the respective application.

There is a drilldown report available from the Application column of the table of
the main report. This drilldown report lists all the jobs for the selected client and
policy type. The table includes job details such as, job ID, exit status, and job start
and end times, and a count of files.

This drilldown report uses the run time parameters that are passed from the main
report.

SAN client jobs report

This report shows all the jobs for selected Fiber Transport (FT) media servers and
selected SAN clients.

The report answers the following questions and provides the following information:
= Did the job run on a LAN or an FT pipe?

= Are two different clients backed up by a single media server, thus reducing the
throughput?

s Alist of all the FT media servers

s Alist of all the SAN clients.

About Cloud reports

Cloud reports provide information for the NetBackup data written to a cloud storage
location including storage forecasting, trending, throughput performance, and
chargeback costs of storing NetBackup data in a specific cloud storage provider.

Cloud reports are only for NetBackup servers that have Cloud configured on them.

OpsCenter supports the following cloud providers:
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Note: Among all Amazon S3-compatible cloud providers that NetBackup supports,
OpsCenter supports monitoring and reporting of Amazon (S3) and Amazon
GovCloud (S3) providers only.

If you have configured cloud storage servers for AT&T or Rackspace providers and
upgraded to 8.1.2, stale information is displayed in cloud reports for AT&T and
Rackspace providers.

The following Cloud reports are available:

Job Success Rate See “Job Success Rate report” on page 226.
Data Expiring in Future See “Data Expiring in Future” on page 229.
Cloud Metering See “Cloud Metering” on page 231.

Average Data Transfer Rate See “Average Data Transfer Rate” on page 233.

Cloud Metering Chargeback See “Cloud Metering Chargeback” on page 236.

Job Success Rate report

This report gives the success rate of backup jobs on the Cloud for each configured
Cloud storage provider. It also helps you to compare job success rates for different
Cloud storage providers.

You can also view the Success Rate (%) for a specific job end date or time in a
tabular format. Click Show Table to view the details in a tabular format.

The X-axis shows the Job end time and date and Y-axis shows the Job Success
Rate in percentage. The Legend defines different colors for specific storage
providers.

Click Show Chart as Table to view details in the tabular format.

Figure 2-65 is a sample view of the Job Success Rate report.
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Figure 2-65 Job Success Rate report
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Success rate by job level across products, domains, clients, policies and business level views.

The following are details associated with the Job Success Rate report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled

Supported formats

Job Success Rate
Cloud Reports

Report > Report Templates > Cloud Reports > Job Success
Rate

Success rate by job level across products, domains, clients,
policies and business level views.

NetBackup, NetBackup Primary Appliance
Primary Server, Client

Historical

None

Yes

PDF, CSV, TSV, XML, HTML
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You can edit the report and configure the timeframe or run the report for specific
views, clients, or primary servers.

The following table shows the filters for Job Success Rate report and how you can
use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client is Active
Client Name
Client OS

Policy Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule Schedule/Level
Type

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list.

The default selection is Yes. By default, Active Clients are
displayed in the report. Hence the clients that are not actively
backed up are omitted by default. Select No if you want to view
the report for all the clients.

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like CINC, Copy, Daily etc.
to view data for the selected schedule types.
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Filter Column

Job Job Status

Job Transport
Type

Product Type

Success Client Name
Rate
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Description

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more backup products to view data for the selected
products.

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Example of filter usage: You may run the Job Success Rate report for specific
clients to view details only for the specific clients.

You can also select time interval for which you want to group the records. For
example, if you select 1 month as the Time Frame and 10 days as the Group By
interval, the report shows records in three chunks of data grouped by 10 days.

Data Expiring in Future

The report shows how much data on the Cloud is going to expire for each Cloud

provider. By default, the report shows the data expiring each day for the next seven

days.

The report shows the total expired backup size and also the number of images that

are going to expire in the next seven days for each Cloud provider. The Y1 axis

gives the total expired backup size and the Y2 axis indicates the number of images

that are going to expire. Click Show Chart as Table to view the data in a tabular

format.

The following details are associated with the Data Expiring in Future report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products

Data Expiring in Future
Cloud Reports

Report > Report Templates > Cloud Reports > Data Expiring
in Future

This report shows the data expiring each day for the next 7
days.

NetBackup, NetBackup Primary Appliance
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Report Display
Drill down report
Can be scheduled

Supported formats
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Primary Server
Historical

None

Yes

PDF, CSV, TSV, XML, HTML

You can edit the report and configure the timeframe or run the report for specific
views, clients, or primary servers.

The following table shows the filters for Data Expiring in Future report and how you

can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server
Server

Client Clientis Active
Client Name

Client OS

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list.

The default selection is Yes. By default, Active Clients are
displayed in the report. Hence the clients that are not actively
backed up are omitted by default. Select No if you want to view
the report for all the clients.

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.
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Filter Column

Policy Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule Schedule/Level
Type
Job Job Status

Job Transport
Type

Job Type
Product Type

Example of filter usage: You may run the Data Expiring in Future report for specific

OpsCenter reports
About Report Templates descriptions

Description

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule types like CINC, Copy, Daily etc.
to view data for the selected schedule types.

Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
report.

Select one or more transport types like FT, LAN, or Unknown to
view data for the jobs that have the selected transport type.

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

Select one or more backup products to view data for the selected
products.

clients to view details only for the specific clients.

Cloud Metering

This report shows the data written to the cloud. It also shows forecast and trend.

Figure 2-66 shows a sample view of the Cloud Metering report.
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Figure 2-66 Cloud Metering report
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The following are

Report Name

Report Category
Where to Locate
Report Purpose

Supported products

Applicable View
Report Display
Drill down report
Can be scheduled

Supported formats

details associated with the Cloud Metering report:

Cloud Metering

Cloud Reports

Report > Report Templates > Cloud Reports > Cloud Metering
Historical view of data written to cloud per Cloud Provider.
NetBackup

Note: NetBackup Appliance is not supported.

Primary Server

Historical

None

Yes

PDF, CSV, TSV, XML, HTML

You can edit the report and configure the timeframe or run the report for specific
views or media servers.
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The following table shows the filters for the Cloud Metering report and how you can
use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report.
By default All My Views is selected.

Media Media Server Select one or more media servers to view data for the specific

Server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list.

Example of filter usage: You may run the Cloud Metering report for specific media
servers to view details only for the specific media servers.

Average Data Transfer Rate

You can see the Cloud job count and throughput in KB/sec. The bars represent job
count while the lines represent throughput.

This report gives an insight on the throughput for each Cloud Provider. If you are
using services from multiple Cloud providers, you can compare and identify the
Cloud provider that is providing a better throughput.

Figure 2-67 shows a sample view of the Average Data Transfer Rate report.

233



OpsCenter reports
About Report Templates descriptions

1,200

1,000

800

G00

(28s/gy) INcuBnouy L

400

200

Figure 2-67 Average Data Transfer Rate report

10

08

§D.5

8

3

04

02

0o
’6\& el ”{)\E} ’R;\lb ’6\& p {S\E: ’a;\b ’a\i} ,{;\b ’6\& ~ d\b ”{i\i} ,&)\b
CHRRCI  YC C R  G

P S R GO

Job Count

Throughput (KB/sec)

Date

The following are details associated with the Average Data Transfer Rate report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled

Supported formats

Average Data Transfer Rate
Cloud Reports

Report > Report Templates > Cloud Reports > Average Data
Transfer Rate

Data expiring each day for the next 7 days.
NetBackup, NetBackup Primary Appliance
Primary Server

Historical

None

Yes

PDF, CSV, TSV, XML, HTML

You can edit the report and configure the timeframe or run the report for specific
views, clients, or primary servers.
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The following table shows the filters for Average Data Transfer Rate report and
how you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Media Media Server

Server

Client Client is Active
Client Name
Client OS

Policy Policy Data
Classification
Name

Policy
Keyword

Policy Name

Policy Type

Schedule Schedule
Name

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more media servers to view data for the specific
media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list.

The default selection is Yes. By default, Active Clients are
displayed in the report. Hence the clients that are not actively
backed up are omitted by default. Select No if you want to view
the report for all the clients.

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Select one or more client OS to view data for the selected client
OS in the report.

Select one or more policy data classification names to view data
for the selected policy data classification names.

Select one or more policy keyword to view data for the policies
having the selected keyword.

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Select one or more schedule names to view data for the selected
schedules.
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Filter Column Description
Job Job Status Select one or more Job Status like Failed, Missed, Partially
Successful etc. to view data for the selected job status in the
Job Transport t
Type report.
Product Type Select one or more transport types like FT, LAN, or Unknown to

view data for the jobs that have the selected transport type.

Select one or more backup products to view data for the selected
products.

Example of filter usage: You may run the Average Data Transfer Rate report for
specific primary servers to view details only for the specific primary servers.

Cloud Metering Chargeback

This report is valid for OpsCenter Analytics (a licensed version of OpsCenter). To
run this report, you need a cost formula based on a cost variable that uses the
Storage Server variable metric. To do this, first create a cost variable based on a
variable metric named Storage Size and then create a cost formula based on this
cost variable. Only the cost formulae that are based on the Storage Server variable
metric appear in the Cost Formula drop-down list.

The Cloud Metering Chargeback report calculates how much you need to pay to
the Cloud provider on a specific date. The forecast and trendlines help you
understand how much you are going to spend on a particular Cloud provider in the
future.

The Ranking view shows the amount you pay to each Cloud-provider. From the
Ranking view, you can compare the price that you pay to each Cloud provider.

Figure 2-68 shows a sample view of the Cloud Metering Chargeback report.
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Figure 2-68 Cloud Metering Chargeback report
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The following are details associated with the Cloud Metering Chargeback report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products

Applicable View
Report Display
Drill down report
Can be scheduled

Supported formats

Cloud Metering Chargeback

Cloud Reports

Report > Report Templates > Cloud Reports > Cloud Metering

Chargeback
Metering Chargeback

NetBackup

Note: NetBackup Appliance is not supported.

Primary Server
Historical, Ranking
None

Yes

PDF, CSV, TSV, XML, HTML
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You can edit the report and configure the timeframe or run the report for specific
views or media servers.

The following table shows the filters for the Cloud Metering Chargeback report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report.
By default All My Views is selected.

Media Media Server Select one or more media servers to view data for the specific

Server media servers in the report. All media servers that are attached
to the primary servers in the OpsCenter console are shown in
the Value drop-down list.

Example of filter usage: You may run the Cloud Metering Chargeback report for
specific media servers to view details only for the specific media servers.

About Disk and Tape Device Activity reports in OpsCenter

Disk and tape device activity reports provide information for all the NetBackup disk,
tape, and SAN Client storage units showing utilization and free space available in
each storage device for each primary server

Current Disk Pool Usage report See “Disk and Tape Device Activity > Current
Disk Pool Usage Report” on page 239.

NetBackup Disk Pool Capacity report See “NetBackup Disk Pool Capacity report”
on page 240.
NetBackup Disk Pool Size vs. Percentage  See “NetBackup Disk Pool Size vs.
Full report Percentage Full report” on page 241.
Library Summary report See “Library Summary report” on page 241.
Library Capacity Forecast report See “ Library Capacity Forecast report”
on page 241.
Drive Throughput report See “Disk and Tape Device Activity > Tape

Drive Throughput” on page 242.

Drive Utilization report See “Disk and Tape Device Activity > Tape
Drive Utilization Report” on page 245.

Disk Usage report See “Disk Usage report” on page 247.

Storage Unit Usage report See “Storage Unit Usage report” on page 249.
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Disk and Tape Device Activity > Current Disk Pool Usage
Report
This report shows a comprehensive utilization of disk by pool and type for each

primary server that has configured disk pools. It provides details about the disk pool
usage and also about the free space available in the disk pool.

Note: The following properties do not apply to cloud storage disk pools: Total
Capacity (MB), Used Space (MB), Free Space (MB), and Potential Free Space
(MB).

All these values are derived from the storage capacity, which cannot be fetched
from the cloud provider.

Figure 2-69 shows a sample view of Current Disk Pool Usage Report.

Figure 2-69 Current Disk Pool Usage Report

Total Used Space Potential Free  Configured for

Disk Pool Disk Pool Type Capacity(MB) (M8) Free Space (MB) Space (MB) Snapshots Replication
dp_adv_nbapp544  AdvancedDisk 10,485,760 04248 10,483 117.52 0 No Mone
dp_disk_nbapp125 PureDisk 299430422 568.16 2,993,735.06 0 No MNaone
dp_disk_nbapp544 PureDisk 44309981058 2575646031 41734334128 0 No MNone
dp_adv_nbapp166 AdvancedDisk 1,048,576 353.34 1,048,222.66 0 No MNone
dp_adv_nbapp561 AdvancedDisk 10,485,760 64248 10,485117.52 0 No MNone
dp_disk_nbapp166 PureDisk 37.812436.78 203948 37810,397.3 0 No MNone
dp_disk_nbapp561 PureDisk 675,080,278.28 34531782363 329,762454.65 0 No MNaone

Total 7 Rows , 1 Page(s)

The following are the details that are associated with the current Disk Pool
Usage report:

Report Name Current Disk Pool Usage
Report Category Disk and Tape Device Activity
Where to Locate Report > Report Templates > Disk and Tape Device Activity

> Current Disk Pool Usage report.

Report Purpose Comprehensive utilization report by disk pool and disk type
for each primary server for NetBackup and NetBackup
Appliance.

Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server

Report Display Tabular
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Drill down report None
Can be scheduled Yes
Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  All Reports > Standard Reports > Disk Based Data Protection
> Current Disk Pool Usage

You can edit the current Disk Pool Usage reportto show or hide the columns

that you are interested in. All the columns are shown by default. You can also filter
the report to view reports of specific primary servers. The following table shows the
filters for current Disk Pool Usage report and how you can use these filters to
view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Current Disk Pool Usage report for a specific
primary server to view the used disk space for that primary server.

The following report enhancements have been made for the Current Disk Pool
Usage report:

= Job Transport Type column has been added to the Job filter. For example,
you can view report data for jobs for which the Job transport type is FT or LAN.

= The column heading Server Type has been modified to Disk Type.

= New columns Configured for Snapshots and Replication are added in the
report table.

NetBackup Disk Pool Capacity report

The basic version of this report shows the total amount of space that is occupied
by backups across all NetBackup Disk Pools that include OpenStorage Devices,
SharedDisk, or even AdvancedDisk pools. Along with usage the average of the
high and the low water mark is taken for each disk pool and drawn on the graph.
Since this is an average it should not be used for planning purposes but rather
estimation. In actual usage this report should be filtered on a specific Disk Pool to
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show the exact high and low water mark. Finally the forecast is shown so that it
can be determined when capacity needs to be added or backups expired to maintain
operations.

NetBackup Disk Pool Size vs. Percentage Full report

A Disk Pool may be an OpenStorage device, a SharedDisk, or a group of local or
network disk volumes that are pooled together. The bars represent the total number
of available bytes across all disk pools with the colors representing the total amount
of space per disk pool. The lines represent the percentage full each disk pool is.
So this report can help identify how much disk space is used for backups, which
pools are the largest, which ones are near capacity and how the backup environment
is load balancing across disk storage.

Library Summary report

This report provides a current point in time inventory of library capacity. The reports
list the libraries name, Volume DB Server, used/available/total slot count, and used
or available or total capacity. Two calculated columns show the % utilization of slots
and library capacity. The report provides a rich selection of filters enabling users
with a diverse tape library environment to zoom in on any segment of their tape
library population.

Note: The Library Summary report might display some negative values. These
negative values are a result of negative slot counts. If the user added -1 NetBackup
is unable to connect to the media. If the slot count is 0 NetBackup only calculates
data for TLD and TLD8 media leading to negative values in the report. The user
must enter the media slot count from Settings > Configuration > Tape Library.

Library Capacity Forecast report

This report provides a capacity forecast of Tape Libraries. A libraries’ capacity is
calculated by multiplying Slot Count by Slot Capacity. Slot capacity is the capacity
of the tape in the slot. As no standard exists for measuring library capacity, the
report enables several methods by which an individual tapes capacity is determined.
These consist of using the maximum, the minimum and the average size of full
tapes to determine tape capacity. Additionally, user-defined capacity for tape types
is available in the report parameter selection Ul. The report extrapolates out the
trend line through the forecast period using classic linear regression and also plots
the libraries capacity. At the date in which the library capacity line intersects the
capacity forecast line is when the libraries capacity is reached.
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Disk and Tape Device Activity > Tape Drive Throughput

This report shows the speed (KB/Sec) at which data backups flow through the tape
drives. The report uses the “heat map” concept and depicts ranges of speeds (slow
to fast) through configurable shades of green color. Reports are generated based
on either Hours-of-Day or Days-of-Week. Advanced averaging logic is used to
determine the throughput values for each cell in the report. The averaging is done
at an image fragment level ensuring granularity and precision in calculations. The
reports can be aggregated and filtered at the Tape Library, Media Server, Drive
Type, Logical Drive, and Physical Drive levels. The sort options allow intuitive
presentation of voluminous data. These reports are important sources of information
for performance analysis and capacity planning activities.

As an example on the analysis that can be performed on this report, suppose you
look at an LTO4 drive that can run at 120+MB/sec, having a report that shows only
5 -6 MB/sec would indicate that the drives are not even close to being at the
maximum capacity. Adding drives in an environment such as this would not impact
the backup window. We see a lot of money being spent on new tape drives when
customers have trouble pushing tape drives from years ago. If you cannot push an
LTO2 drive, then upgrading to an LTO4 will not benefit you (unless you wanted the
hardware encryption option of course). These reports are important sources of
information for performance analysis and capacity planning activities.

Note that the Tape Drive Throughput report displays data only till 1 A.M. and not
till the time when you run the report. This is because OpsCenter collects data for
Tape Drive Throughput report once per day at 1 A.M..after midnight. Therefore the
Tape Drive Throughput report is only able to report on data up until 1 AM on that
day, even when run with a relative timeframe of Previous 24 hours. Similarly if you
run Tape Drive Throughput report at 2 P.M. in the afternoon, the reports display
data collected till 1 A.M. only.

Note: It is recommended that you configure the retention period of error logs in
NetBackup as more than 1 day. If the retention period of error logs is less than 24
hours, it may result in data loss for some reports like Drive Throughput.

Figure 2-70 shows a sample view of Drive Throughput Report.
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Figure 2-70 Tape Drive Throughput Report
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The following are the details that are associated with the Tape Drive Throughput
report:
Report Name Tape Drive Throughput
Report Category Disk and Tape Device Activity
Where to Locate Report > Report Templates > Disk and Tape Device Activity
> Tape Drive Throughput report
Report Purpose A heat-map report showing drive throughput by library, media
server, tape drive and drive type. Darker the color, higher is
the throughput for that particular time, for NetBackup servers.
Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server
Report Display Tabular
Drill down report None
Can be scheduled Yes
Supported formats HTML

Mapping with VBR report All Reports > Standard Reports > Backups > Tape Devices >
Drive Throughput

You can edit the brive Throughput report to show or hide the columns that you
are interested in. All the columns are shown by default. You can also filter the report
to view reports of specific primary servers. The following table shows the filters for
Drive Throughput report and how you can use these filters to view specific data
in the report.
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Filter Column

View

Primary  Primary
Server Server

Policy Policy Name

Schedule Schedule/Level

Type
Job Job Type
Drive Drive

Tape Tape Library
Library Serial
Number
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Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Select one or more policy names to view data for the selected
policies.

Select one or more schedule or level types to view the data for
the configured schedules.

Select one or more job types as Archive, Backup, or Restore to
view data for the selected job types.

Select one or more drives to view the specific data on those
drives.

Select one or more tape library serial numbers to view the data
specific for those tapes.

Example of filter usage: You may run the report for specific policy data
classification names to view details only for the specific policy classifications. You

may run the report for a specific job type like Backup to view drive throughput details

for the backup jobs.

The following report enhancements have been made for the Drive Throughput

report:

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like next 2 weeks. This
is because the report does not support any futuristic data.

The following filter enhancements have been made for the Drive Throughput report:

= Job types which are not applicable for this report are removed from the filter.
The supported job types are Backup, Archive, Restore, Backup from Snapshot,
Snapshot, Duplicate, and Replication.

=  UNKNOWN has been added as a value for Schedule Level/Type column in the
Schedule filter. You can now filter report data for Schedule Level/Type that is

UNKNOWN.
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Disk and Tape Device Activity > Tape Drive Utilization
Report

Tape drives are still very popular as backup destinations and are moderately
expensive especially if new drives are purchased each time a new update is available
such as moving from LTO3 to LTO4. Many times when backup windows are not
being met the first thing suggested is more tape drives. What we have found is that
in most cases customers are under-utilizing the tape drive investment either due
to time of day considerations — i.e. backups cannot run during the day due to
performance issues — or they simply have too few Media Servers. OpsCenter and
OpsCenter Analytics have a number of drive utilization and throughput reports that
can show at a glance when tape drives are being used, and if there are large gaps
in usage that could be filled up with changes to the backup Policies. This can help
not only fully utilize the drives, but defer a hardware purchase since it is easy to
see when the drives have open cycles.

This report shows the utilization (0 — 100%) of tape drives. The report uses the
“heat map” concept and depicts ranges of utilization (low to high) through
configurable shades of blue for example. Reports are based on either Hour-Of-Day
or Day-of- Week. Advanced logic is used to determine the utilization values for each
cell in the report. Utilization is calculated off a per minute basis ensuring precision
in calculations versus traditional methods of periodic polling of the devices. The
reports can be aggregated and filtered at the Tape Library, Media Server, Drive
Type, Logical Drive, and Physical Drive levels. The sort options allow for intuitive
presentation of voluminous data. These reports are important sources of information
for performance analysis and capacity planning activities.

Note that the Tape Drive Utilization report displays data only till 1 A.M. and not till
the time when you run the report. This is because OpsCenter collects data for Tape
Drive Utilization report once per day at 1 A.M..after midnight. Therefore the Tape

Drive Utilization report is only able to report on data up until 1 AM on that day, even
when run with a relative timeframe of Previous 24 hours. Similarly if you run Tape
Drive Utilization report at 2 P.M. in the afternoon, the reports display data collected
till 1 A.M. only.

Figure 2-71 shows a sample view of Tape Drive Utilization Report.
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Figure 2-71 Drive Utilization Report
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The following are the details that are associated with the brive Utilization report:

Report Name Tape Drive Utilization
Report Category Disk and Tape Device Activity
Where to Locate Report > Report Templates > Disk and Tape Device Activity

> Tape Drive Utilization.

Report Purpose A heat-map report showing drive utilization by library, media
server, tape drive and drive type. Darker colour signifies higher
utilization of drive for a particular time.

Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server

Report Display Tabular

Drill down report None

Can be scheduled Yes

Supported formats HTML

Mapping with VBR report All Reports > Standard Report > > Backups > Tape Device
Activity > Drive Utilization

You can edit the prive Utilization reportto show or hide the columns that you
are interested in. All the columns are shown by default. You can also filter the report
to view reports of specific primary servers. The following table shows the filters for
Drive Utilization reportand how you can use these filters to view specific data
in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.
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Filter Column Description
Primary  Primary Select one or more primary servers to view data for the virtual
Server Server clients that are backed up by the selected primary servers in the

report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Policy Policy Name Select one or more policy names to view data for the selected
policies.
Job Job Type Select one or more job types as Archive, Backup, or Restore to

view data for the selected job types.

Drive Drive Select one or more drives to view the specific data on those
drives.
Tape Tape Library  Select one or more tape library serial numbers to view the data
Library Serial specific for those tapes.
Number

Example of filter usage: You may run the report for specific policy names to view
the details only for a specific policy. You may run the report for tape drive utilization
for a specific job type like Backup to view the details.

The following report enhancements have been made for the Drive Utilization report:

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like next 2 weeks. This
is because the report does not support any futuristic data.

The following filter enhancements have been made for the Tape Drive Utilization
report:

= Job types which are not applicable for this report are removed from the filter.
The supported job types are Backup, Archive, Restore, Backup from Snapshot,
Snapshot, Duplicate, and Replication.

=  UNKNOWN has been added as a value for Schedule Level/Type column in the
Schedule filter. You can now filter report data for Schedule Level/Type that is
UNKNOWN.

Disk Usage report

This report shows disk usage for the selected server and time frame. The table in
the report provides details such as total number of jobs, total volume processed
(KB), average throughput (KB/sec), duration of activity, and percentage utilization
in terms of duration.

Figure 2-72 shows a sample view of the Disk Usage report.
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Figure 2-72
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The Disk Name and Media Server Name columns of the table contain drilldown
links to detailed throughput and disk usage reports.

Disk Throughput

Disk Usage Details

This drilldown report from the Disk Name column
shows the data transfer rate (throughput) for a disk
storage unit for the selected server or server
groups.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Media Server Name
column shows the usage details for all the disk
storage units for the selected media server.

This drilldown report uses the run time parameters
that are passed from the main report.

The Disk cell in each row of the report table is a
link to a drill-down report. The rest of the cells
indicate whether the disk was in use or not during
the time slot.

The following are the details that are associated with the Disk Usage report:

Report Name
Report Category

Where to Locate

Disk Usage

Performance Reports

Report > Report Templates > Performance Reports > Disk

Usage
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Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report
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This report shows the disk usage of a primary server.
NetBackup, NetBackup Appliance

Primary Server

Tabular

Yes

Yes

PDF, CSV, TSV, XML, HTML

Reporting > All Reports > Standard Reports > Performance
Report > Disk Usage

The following table shows the filters for Disk Usage report and how you can use
these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view disk usage for the
selected primary servers in the report. All primary servers that
are added to the OpsCenter console are shown in the Value
dropdown list.

Example of filter usage: You may run the Disk Usage report for specific primary
servers to view the disk usage of the specific primary servers.

The following report enhancements have been made for the Successful Jobs of a

Server report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Storage Unit Usage report

This report shows storage unit usage for a selected primary server and time frame.
The first column of each row of the report table lists a storage unit. The storage unit
name is also a drilldown link to a detailed report. The media server name in the
second column is also a drilldown link.
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The rest of the row provides details such as total number of jobs, total volume
processed (KB), average throughput (KB/sec), duration of activity and percentage

of utilization in terms of duration.

Storage unit throughput report

Storage unit usage details for media
server report

About Media reports in OpsCenter

This drilldown report from the Storage Unit column
shows the data transfer rate (throughput) of the
selected storage unit.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Media Server Name
column shows the usage details for all of the
storage units of the selected media server.

This drilldown report uses the run time parameters
that are passed from the main report.

The Storage unit column of the report table is a
link to a drilldown throughput report. The rest of
the cells indicate whether the storage unit was in
use or not during the time slot.

This section describes media reports that provide information for all the NetBackup
media status, expiration, and availability, including tape, disk, Appliances, and the
optional NetBackup Vault feature for offsite media tracking.

Media State report

Available Media report
Drives in Use report
Full Media Capacity report

Media Summary by Media Server report

Media Utilization report

Tape Count report

Tapes Expiring in Future report

See “Media Reports > Media State”
on page 251.

See “Available Media report” on page 252.
See “Drives in Use report” on page 252.
See “Full Media Capacity report” on page 252.

See “Media Summary by Media Server report”
on page 253.

See “Media Reports > Media Utilization”
on page 253.

See “Tape Count report” on page 255.

See “Tapes Expiring in Future report”
on page 255.



TapesExpiring Now report

Vault Media Usage report

Media Expiration Schedule report
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See “Tapes Expiring Now report” on page 255.
See “Vault Media Usage report” on page 255.

See “Media Reports > Media Expiration
Schedule” on page 256.

Media Reports > Media State

This report displays the media status and count (per media type) for each primary

server and media server combination. Media state can be frozen, active, off-site,

and so on.

Figure 2-73 shows a sample view of Media State Report.

Figure 2-73 Media State Report
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The following are the details that are associated with the Media state report:

Report Name
Report Category
Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled

Supported formats

Media State

Media Reports

Report > Report Templates > Media Reports > Media State.

Lists number of media in each media status per media type
and per media server.

NetBackup, NetBackup Primary Appliance

Primary Server

Tabular

None

Yes

PDF, CSV, TSV, XML, HTML
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Mapping with NOM report  All Reports > Standard Report > Media and Devices > Media
State

You can edit the Media state report to show or hide the columns that you are
interested in. All the columns are shown by default. You can also filter the report
to view reports of specific primary servers. The following table shows the filters for
Media State report and how you can use these filters to view specific data in the
report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Media State report for a specific primary server
to view the media state for that primary server.

Available Media report

This report lists the media that is available for use by NetBackup for each primary
server that is selected.

The report table provides information, such as, media server, media status, robot
type, volume group and pool, and the time assigned.

Drives in Use report

This report shows the drive usage for the selected server. The report table provides
details for the drive, for example, drive name and type, robot number and type, and
assigned host.

Full Media Capacity report

This report shows the average amount of protected data (in kilobytes) on a tape
for each primary server and media type. These are the tapes that NetBackup marked
as full.

The bar chart depicts the amount of data (in kilobytes) per media type.

The report table is organized by server, media type and count, and shows the size
and number of images on the tape.

252



OpsCenter reports
About Report Templates descriptions

Media Summary by Media Server report

For each media server, this report provides the number of tapes and images, the
last written date, and amount of data on the tapes. The name of the media server
is also a drilldown link to a detailed report for media.

Media summary by media status fora  This drilldown report from the Media Server column

media server report provides a media status summary for a selected
media server. This report displays media status,
number of tapes and images, the last written date,
and amount of data on tapes.

This drilldown report uses the run time parameters
that are passed from the main report.

Media details of media status for a This drilldown report from the Media Status column

media server report provides media details for the selected media
server and selected media status. Media status
can be Active, Frozen, Full, Invalid, or Suspended.

This drilldown report uses the run time parameters
that are passed from the main report.

The report displays media ID, type, volume pool,
last written date, expiration date, number of
images, and the amount of data on tape.

Media Reports > Media Utilization

This report shows the number of media in use for a server per date. The columns
in the table show assigned, unassigned, frozen, full, off-site, or suspended media
states. The data for this report is only calculated once in a day. So the report shows
the summary till the previous date. The data for today reflects in the report that you
generate tomorrow. The table in the report is organized by date and server, and
shows counts for each media state.

Figure 2-74 shows a sample view of Media Utilization Report.

Figure 2-74 Media Utilization Report
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The following are the details that are associated with the Media Utilization
report:

Report Name Media Utilization

Report Category Media Reports

Where to Locate Report > Report Templates > Media Reports > Media
Utilization

Report Purpose Lists tabular details of media count by media status and media
type.

Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server

Report Display Tabular

Drill down report None

Can be scheduled Yes

Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  All Reports > Standard Report > Media and Devices > Media
Utilization

You can edit the Media Utilization reportto show or hide the columns that you
are interested in. All the columns are shown by default. You can also filter the report
to view reports of specific primary servers. The following table shows the filters for
Media Utilization reportand how you can use these filters to view specific data
in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Media Utilization report for a one week timeframe
and for a single primary server.

The following report enhancements have been made for the Media State report:
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= The unit Years has been added for Relative Timeframe selection. You can
now view data for the last X years. You can also select Year from the top-right
corner of the report.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks.

Tape Count report

This report shows tape count for the following Report On parameters:
= Backup Media Retention Level

= Tape Type

= Volume Pool Name

In Veritas Backup Reporter (VBR), there was a separate report for each of these
parameters. In OpsCenter, the three reports are merged into one report.

The Tape Count report is available in the Distribution view.

Tapes Expiring in Future report

This report shows the number of media that expire at each day in the upcoming
seven days. This time frame can be changed to show more in to the future. The
report is helpful in determining if a large quantity of media may become free in the
future which could justify delaying the purchase of more media.

Note: The filter Backup Media Role applied to the Tape Expiring Now report does
not return any data.

Tapes Expiring Now report

This report lists the media that are about to expire. The Volume Pool Name , Media
ID, and Media Barcode that are listed make it easy to locate the media. The default
time frame when the report is clicked will show what is expiring in the next 24 hours.
That time frame can be changed to show media expiring in the next week, month,
or any future time window desirable.

Vault Media Usage report

This report shows off-site media trends for selected vaults and current off-site media
count. The report consists of two component reports, a bar chart and a table.

This report helps understand your off-site media trends.

Questions like the following are answered by this report:
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= How does the off-site media count vary for each vault?
= What are the details of the current off-site media ?

The bar chart shows the weekly trend of off-site media counts for selected vaults.
While running the report you select the vaults for which you want to run this report.
The report shows a weekly line trend for selected vault. This chart is a good
indication of how the off-site media count varies over the period of time. You can
compare the media counts of different vaults to see which vault is consuming more
media and how it varies.

The report table provides the details of vaulted media for the selected vaults. When
you run the report you specify the vault names. The report provides important media
details like media ID, off-site slot number, container ID, expiration date, barcode ,
and so on.

Media Reports > Media Expiration Schedule

This report gives graphical representation of the expiration schedule for media. The
report predicts the availability of media based on the expiration date of the media.
Using this report you can determine what media will be available for reuse. The
stacked bars represent the number of media of a specific type that are expired or
going to expire on a particular day. Different colors are used in the bars for different
media types. Tool tips for the bar segments provide the media type and count of
the media that is available on that day.

The following are the details that are associated with the Media Expiration
Schedule report:

Report Name Media Expiration Schedule
Report Category Media Reports
Where to Locate Report > Report Templates > Media Reports > Media

Expiration Schedule.

Report Purpose Stacked bars representing number of media getting expired
on a particular reporting day.

Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server

Report Display Historical

Drill down report Yes. See Media Expiration Details.

Can be scheduled Yes
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Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  All Reports > Standard Report > Media and Devices> Media

Expiration Schedule

You can edit the Media Expiration Schedule reportto show or hide the columns
that you are interested in. All the columns are shown by default. You can also filter
the report to view reports of specific primary servers. The following table shows the
filters for Media Expiration Schedule reportand how you can use these filters
to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Media Expiration Schedule report for a specific
primary server to view the expiration schedule of media for that primary server.

The following report enhancements have been made for the Media Expiration
Schedule report:

= A new drilldown report named Media Expiration Details has been added.

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last X years. You can also select Year from the top-right corner
of the report.

= The following options have been removed from TimeFrameGroupBy selection:
= Days of week Average
= Days of week total
= Hours of day Average
= Hours of day Total
= Minutes
= Month of year Average
= Month of year total

= Quarter of year Average
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= Quarter of year total

Figure 2-1 shows a sample view of Media Expiration Schedule Report.

Figure 2-75 Media Expiration Details Report

Media Type Barcode fand s ST Robot Number Robot Hame Expiration Date
Size{KB) Name
HCART 000017L4 414,477,926 NetBackup 0 LD '2“195:‘1“5 ﬁ;'a
HCART 000016L4 414,839,328 NetBackup 0 LD :g%g:';i:"s
HCART 000015L4 414,650,596 NetBackup 0 LD ’1‘3&;?‘1'523:]6
HCART 000013L4 414445792 NetBackup 0 TLD eI
HCART 000011L4 414591840 NetBackup 0 LD pupte e
HCART 000009L4 414,037,984 NetBackup 0 LD ’:”195_11“5 ifd'ﬁ

The following are the details that are associated with the Media Expiration

Details report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

You can edit the Media Expiration Details reportto show or hide the columns
that you are interested in. All the columns are shown by default. You can also filter
the report to view reports of specific primary servers. The following table shows the

Media Expiration Details
Media reports (Drill down)

Report > Report Templates > Media Reports > Media
Expiration Schedule (click the bar in the historical graph)

Details regarding number of media getting expired on a
particular reporting day along with media details

NetBackup, NetBackup Primary Appliance
Primary Server

Tabular

None

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Report > Backup Media Reports >
Media Expiration Schedule (click the bar in the historical graph)
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filters for Media Expiration Details reportand how you can use these filters to
view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Media Expiration Details report for a specific
primary server to view the media expiration details for that primary server.

About Performance reports in OpsCenter

This section describes performance reports that provide information for overall
performance and throughput statistics on NetBackup Primary and Media Servers.

Primary Server Job Throughput report See “Primary Server Job Throughput report”
on page 259.

Media Server Job Throughput See “Media Server Job Throughput report ”
on page 265.

NetBackup SAN Client Performance report  See “NetBackup SAN Client Performance
report” on page 265.

Primary Server Job Throughput report

This report provides a tool to compare performance of various primary servers. The
table of this report displays throughput and job success information for each primary
server. It shows job count and job success rate, and enables you to compare

throughputs of different servers to identify any servers that are performing poorly.

Figure 2-76 shows a sample view of the Primary Server Job Throughput report.
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Primary Server Job Throughput report
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Drilldown links for the server name, number of total and successful jobs columns

are also provided.

Total jobs of a server report

Successful jobs of a server report

This drilldown report from the Total Job Count
column lists the details for all jobs for a selected
server. The report details include details like job
type and status, policy and schedule names, and
start time.

This drilldown report uses the run time parameters
that are passed from the main report.

This drilldown report from the Number of
Successful Jobs column shows details for
successful jobs for a given server. The report
provides details like job type, policy and schedule
names, volume, and file counts.

This drilldown report uses the run time parameters
that are passed from the main report.

The following are the details that are associated with the Primary Server Job
Throughput report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View

Report Display

Primary Server Job Throughput

Performance Reports

Report > Report Templates > Performance Reports > Primary
Server Job Throughput

This report shows the performance of a primary server.

NetBackup, NetBackup Appliance

Primary Server

Tabular
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Drill down report Yes
See “Total Jobs of a Server report” on page 261.

See “Successful Jobs of a Server” on page 263.
Can be scheduled Yes
Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report ~ Reporting > All Reports > Standard Reports > Performance
Report > Primary Server Job Throughput

The following table shows the filters for Primary Server Job Throughput report and
how you can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the clients

Server Server backed up by the selected primary servers in the report. All
primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

Example of filter usage: You may run the Primary Server Job Throughput report
for a specific primary servers to view the performance of the specific primary servers.

The following report enhancements have been made for the Primary Server Job
Throughput report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Total Jobs of a Server report

This tabular report shows the job information run for a primary server i.e. Client
Name, Job Type, Job Status, Policy Name, Schedule Name etc.

Figure 2-77 shows a sample view of Total Jobs of a Server report.
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Figure 2-77 Total Jobs of a Server report

Total Jobs of a Server

Schegule Stan Number  Throughput
JobiD  Server Name Client Name JobType  Job Status Policy Name Time  Duration  VONMEKE) o cies  (KBisec)
Jun 17,
30463 nissapp UM rliascom  bapps4d Backup  Successtul appesx2d_sh UNKNOWN 2% 00234 0 0
PM
Jun 17,
30455 nbsmppTiizngbim.com  appesi23-2pards Snapshol  Sucosseful appess2d_AA UNKNOWN 2910 002842 0 0 0
PM
Jun 17,
30584 nismapp BAMEWeNNES. COM  appesi23-3pards Backup  Successl appesx23_AA Full 2018 000440 624323 57564 23388

670640
PM

The following are the details that are associated with the Total Jobs of a Server

report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

Total Jobs of a Server
Performance Reports

Report > Report Templates > Performance Reports > Primary
Server Job Throughput (drill down from Total Job Count
column) > Total Jobs of a Server

This report shows the job information for a primary server.
NetBackup, NetBackup Appliance

Primary Server

Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

Reporting > All Reports > Standard Reports > Performance
Report > Primary Server Job Throughput (drill down on
Number of Successful Jobs column) > Total Jobs of a Server

The following table shows the filters for Total Jobs of a Server report and how you
can use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.
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Filter Column Description
Primary  Primary Select one or more primary servers to view data for the clients
Server Server backed up by the selected primary servers in the report. All

primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

The following report enhancements have been made for the Backup Job Size
Variance report:

The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.

Successful Jobs of a Server

This drilldown report is obtained when you click number of successful jobs (link)
from the Primary Server Job Throughput report. This tabular report shows details
of all successful jobs of a Server. It shows information like Client Name, Policy

Name, Schedule Name, Start Time, Number of Files, Duration, Volume, Throughput

etc.

Figure 2-78 shows a sample view of the Successful Jobs of a Server report.

Figure 2-78 Successful Jobs of a Server report
. X Schedule HNumber of Throughput
Client Name JobType  Policy Name StartTime Duration  Volume(KB) (KEtsec)
Jun 24,
shogun Backup san_test 81 f?‘lgﬁg 13 00:00:25 8,560.96 93428 227 567
PH
Image Jun 25
beloit. min.veritas.com Import UNKNOWN  UNKMOWMN 2016 00:00:01 0 0 o
1.57.32AM
Jun 25,
shogun Backup san_test 81 2016 00:00:31 8,561.15 93,428 187,082
2:22:45 AW
Jun 25,
shogun Backup Checkpoint  F 2016 00:04:34 23,233,280.08 51,205 223,096
22252 AW

Total 4 Rows , 1 Page(s)

The following are the details that are associated with the Successful Jobs of a
Server report:

Report Name Successful Jobs of a Server

Report Category Performance Reports
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Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report
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Report > Report Templates > Performance Reports > Primary
Server Job Throughput (drill down from Number of
Successful Jobs column) > Successful Jobs of a Server

This report shows the successful jobs for a primary server.
NetBackup, NetBackup Appliance

Primary Server

Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

Reporting > All Reports > Standard Reports > Performance
Report > Primary Server Job Throughput (drill down on
Number of Successful Jobs column) > Total Jobs of a Server

The following table shows the filters for Successful Jobs of a Server report and how
you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the clients
that are backed up by the selected primary servers in the report.
All primary servers that are added to the OpsCenter console are
shown in the Value drop-down list .

The following report enhancements have been made for the Successful Jobs of a

Server report:

= The unit Years has been added for Relative Timeframe selection.
You can now view data for the last x years.

= The option Next has been removed from the drop-down menu for Relative
Timeframe. You now cannot enter a relative timeframe like Next 2 weeks. This
is because the report does not support any futuristic data.
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Media Server Job Throughput report

This report provides details of data that is backed up by NetBackup media servers
and shows server throughput. The report is a useful tool to compare performance
of the media servers that are present in your NetBackup environment.

The pie chart provides a breakdown of the volume of data that is processed for
each media server. A drilldown detail link for throughput details is provided from
each volume pie slice.

Job details for client and media server This drilldown report from the client name column

report provides details for a given client, job type, job
status, and media server. The report details include
job ID, job type, exit status, start time, and duration
in seconds.

This drilldown report uses the run time parameters
that are passed from the parent report.

Media server throughput for media You can use this drill-down report from the

server report Throughput (KB/sec) column to see the variation
of throughput per day. The throughput is
represented by a bar for each day of the reporting
period.

This drill-down report uses the run time parameters
that are passed from the main report.

NetBackup SAN Client Performance report

This report is specific to NetBackup 6.5 and above which features Fibre Channel
connected clients called “SAN Clients”. The blue and the yellow bars for example
are stacked together to show the total number of jobs per day. The blue bars
represent the jobs that ran over the LAN and the yellow is jobs ran over the SAN.
The purple and the yellow lines show the total job throughput for all those jobs that
ran that day. The purple represents total job throughput by LAN and the yellow
represents total job throughput by SAN. This report helps identify what ratio of LAN
to SAN traffic for backups are run and what performance benefit is gained by doing
SO.

About Policy reports in OpsCenter

This section describes policy reports that provide information for the NetBackup
Policy information including Policies consuming the most storage space.



Top 10 Policies Using Most Server Space
report

Job Success Rate by Policy Type report

Policy Change report

Policy Summary Dashboard report
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See “Top 10 Policies Using Most Server
Space report” on page 266.

See “Job Success Rate by Policy Type report”
on page 270.

See “Policy Change report” on page 271.

See “Policy Summary Dashboard report”

on page 271.

Top 10 Policies Using Most Server Space report

This report displays the 10 policies that have backed up the most data in your
NetBackup environment. You can edit the report and run it for one or more primary
servers.

Tool tips appear when you point at each colored bar chart. The tool tip shows the
primary server, policy, and also shows the volume of data in MB.

Click Show Chart as Table link at the bottom of the report to view the report details
in a tabular format. The table lists the volume of data in MB for each policy.

A new drilldown report named Job Details for Policy is now available from the main
report. This drilldown report from the colored bars in the chart provides details about
all jobs for a selected policy. The drilldown report includes information, such as, job
type, status code, client name, and volume in KB.

Figure 2-79 shows a sample view of the Top 10 Policies Using Most Server Space
report.
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Figure 2-79 Top 10 Policies Using Most Server Space report
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The following are details associated with the Top 10 Policies using most server
space report:

Report Name Top 10 Policies Using Most Server Space
Report Category Policy
Where to Locate Report > Report Templates > Policy Reports > Top 10 Policies

using most Server Space

Report Purpose This report shows a ranking of backup policies by space
consumption. This report is valid for NetBackup and
NetBackup Appliance.

Supported products NetBackup, NetBackup Primary Appliance
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Applicable View
Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report
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Primary Server
Ranking (Chart)

Job Details for Policy
See “Job Details for Policy” on page 268.

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Top 10 Policies
using most Server Space

The following table lists the filters for Top 10 Policies using most server space report
and how you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Job Job Type

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more job types like Archive, Backup, Restore etc.
to view data for the selected job types.

By default, the report displays information for the following types
of jobs:

= Backup
s Catalog Backup
= Vault

You must select at least one job type from the Value list.

Example of filter usage: You may run the Top 10 Policies using most server space
report for specific primary servers or views to view details only for the specific
primary servers or views.

Job Details for Policy

A new drill-down report named Job Details for Policy is available when you click
the colored bars from the Top 10 Policies Using Most Server Space report. This
drill-down report provides details about all jobs for a selected policy.
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This drill-down report uses the run time parameters that are passed from the main
report. The drill-down report includes information, such as, job type, status code,
client name, and volume in KB.

Figure 2-80 shows a sample view of the Job Details for Policy report.

Figure 2-80 Job Details for Policy report
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The following are details associated with the Job Details for Policy report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View

Report Display

Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report

Job Details for Policy
Drill down report

Report > Report Templates > Policy Reports > Top 10 Policies
Using most Server Space (click the colored bars)

This report lists all jobs for the selected policy. This report is
valid for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance
Primary Server

Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Top 10 Policies
using most Server Space > Job Details for Policy

The following table lists the filters for Job Details for Policy report and how you can
use these filters to view specific data in the report.
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Filter Column Description

View Select a view to show data for the selected view in the report.
By default All My Views is selected.

Policy Policy Data Select one or more policy data classification names like Gold,
Classification  Silver, Bronze etc. to view data for the policies having the
Name selected data classification names.

Policy Name  Select one or more policy names to view data for the selected
policies.

Example of filter usage: You may run the report for specific policy data
classification names to view details only for the specific policy classifications.

Job Success Rate by Policy Type report

This report provides a quick view of the status of jobs by policy type. The report
shows the job success rate for clients, server, and job policy type.

The bar chart shows the count of successful, partially successful, and failed jobs
per policy type. The tool tips in the colored bars provide job counts and also are
drilldown links to view the details for the policy.

The table in the report displays job information, such as, client name, policy type,
and the success rate.

Note: This report may not show appropriate data for duplication jobs that are
associated with SLP policy.

This issue occurs because the duplication jobs do not have a policy type. The job
batches duplication of images that are created from possibly different policies and
policy types. The duplication job itself has an internal policy that is created but this
internal policy does not have the policy type set because this is not a backup job.

Job details for policy type report This drilldown report from the Policy Type column
and the colored bars in the chart provides details
about all jobs for a selected policy type.

This drilldown report uses the run time parameters
that are passed from the main report.

The table includes information, such as, exit status,
client name, volume in KB, and count of files.
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Successful, partially successful, and There are three drilldown reports from the Number

failed job details for policy type report  of Successful Jobs, Number of Partially
Successful Jobs, or Number of Failed Jobs
columns. The job exit status is used as a filter for
the reports. These reports are similar and provide
details for all jobs for a selected client and policy

type.

This drilldown report uses the run time parameters
that are passed from the main report.

The table in this report provides details like, policy
and schedule name, start and end times, and
duration for the job. The table for failed jobs also
includes a column for the job exit status.

Policy Change report

This report shows a count of the changes that were made to job policies in a given
time frame for the selected servers.

The pie chart shows the number of policy changes (a policy can change multiple
times) for each primary server. (Each different server appears in a different color
in the chart.) Tool tips in the chart provide a count of the changes.

The table in the report displays the count of changes that were made to each policy
for each server.

Policy Summary Dashboard report

This report acts as a dashboard of activities that are summarized by your policies.
It gives an overview of activities and can be used as a tool to troubleshoot and
manage by exception using the drilldown links to other detail reports.

It provides answers for some of the following questions for each policy:
= What is the total number of jobs?

= How many jobs were successful?

= How many jobs were partially successful?

= How many jobs failed?

The table in this report shows information per policy like policy name and type, job
volume in MB, job count, and counts for job exit status. You can also drill down
from the job exit status counts in the columns and view individual policy details
based on exit status and job policy and type.
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There are drilldown reports available from the Total Jobs, Number of Successful
Jobs, Number of Partially Successful Jobs, or Number of Failed Jobs columns of
the main report. These drilldown reports provide an overview of all jobs for the
selected policy name, server, and time frame based on the job status.

These drilldown reports use the run time parameters that are passed from the main
report.

Figure 2-81 shows a sample view of the Policy Summary Dashboard report.

Figure 2-81 Policy Summary Dashboard report
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The following are details associated with the Policy Summary Dashboard report:

Report Name Policy Summary Dashboard

Report Category Policy

Where to Locate Report > Report Templates > Policy Reports > Policy Summary
Dashboard

Report Purpose Tabular report summarizing size, throughput, job counts and

success rate by primary server, policy and policy type.
Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server, Client

Report Display Tabular
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Drill down report

Can be scheduled
Supported export formats

Mapping with NOM report
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Yes

See “Total Jobs for Policy” on page 273.

See “Successful Jobs for Policy” on page 275.
See “Partial Jobs for Policy report” on page 276.
See “Failed Jobs for Policy” on page 278.

Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Policy Summary
Dashboard

The following table lists the filters for Policy Summary Dashboard report and how
you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Success Consider

Rate Partially
Successful
Job as
Successful

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.

The default selection is Yes.

Select No if you do not want to consider partially successful jobs
as successful.

Selecting Yes or No may impact the Success Rate percentage
that is shown in the report. Consider a policy that has 5
successful jobs, 3 partially successful jobs and 2 failed jobs. If
you select the value as Yes, the Success Rate column shows
80%. However if you select the value as No, the Success Rate
column shows 50%.

Example of filter usage: You may run the Policy Summary Dashboard report for

specific primary servers or views to view details only for the specific primary servers

or views.

Total Jobs for Policy

This drilldown report is available when you click a value (link) from the Total Jobs

column of the Policy Summary Dashboard report. This drilldown report provides an

overview of all jobs for the selected policy name, server, and time frame. This

drilldown report uses the run time parameters that are passed from the main report.
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The report provides details like schedule name, start times, and duration of the job

etc.

Figure 2-82 shows a sample view of the Total Jobs for Policy report.

Figure 2-82
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The following are details associated with the Total Jobs for Policy report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

Total Jobs for Policy
Policy (Drill down report)

Report > Report Templates > Policy Reports > Policy Summary
Dashboard (click total jobs) > Total Jobs for Policy

This report lists all jobs of the selected policy. This report is
valid for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance
Primary Server, Client

Tabular

No

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Policy Summary
Dashboard > Total Jobs for Policy

The following table lists the filters for Total Jobs for Policy report and how you can
use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value dropdown list.
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Filter Column Description
Policy Policy Name  Select one or more policy names to view data for the selected
Policy Type policies.

Select one or more policy types to view data for the selected
policy types.

Example of filter usage: You may run the Total Jobs for Policy report for specific
policies to view details only for the specific policies.

Successful Jobs for Policy

This drilldown report is available when you click the successful jobs (link) from the
Policy Summary Dashboard report. This drilldown report provides an overview of
all the successful jobs for the selected policy name, server, and time frame. This
drilldown report uses the run time parameters that are passed from the main report.
The report provides details like schedule name, start times, and duration of the job
etc.

Figure 2-83 shows a sample view of the Successful Jobs for Policy report.

Figure 2-83 Successful Jobs for Policy report
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The following are details associated with the Successful Jobs for Policy report:

Report Name Successful Jobs for Policy

Report Category Policy (Drill down report)

Where to Locate Report > Report Templates > Policy Reports > Policy Summary

Dashboard (click Successful jobs)

Report Purpose This report lists all the successful jobs of the selected policy.

This report is valid for NetBackup and NetBackup Appliance.
Supported products NetBackup, NetBackup Primary Appliance
Applicable View Primary Server, Client
Report Display Tabular

Drill down report No
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Yes
PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Policy Summary
Dashboard > Successful Jobs for Policy

The following table lists the filters for Successful Jobs for Policy report and how
you can use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Policy Policy Name

Policy Type

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Example of filter usage: You may run the Successful Jobs for Policy report for
specific policies to view details only for the specific policies.

Partial Jobs for Policy report

This drilldown report is available when you click a value (link) from the Number of
Partially Successful Jobs from the Policy Summary Dashboard report. This drilldown
report provides an overview of all the partially successful jobs for the selected policy
name, server, and time frame. This drilldown report uses the run time parameters
that are passed from the main report. The report provides details like schedule
name, start times, and duration of the job etc.

Figure 2-84 shows a sample view of the Successful Jobs for Policy report.
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Partially Successful Jobs for Policy report
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The following are details associated with the Partially Successful Jobs for Policy

report:

Report Name

Report Category

Where to Locate

Report Purpose

Supported products

Applicable View

Report Display

Drill down report

Can be scheduled

Partially Successful Jobs for Policy

Policy (Drill down report)

Report > Report Templates > Policy Reports > Policy Summary
Dashboard (click Partially Successful jobs) > Partially
Successful Jobs for Policy

This report lists all the partially successful jobs of the selected
policy. This report is valid for NetBackup and NetBackup
Appliance.

NetBackup, NetBackup Primary Appliance

Primary Server, Client

Tabular

No

Yes

277



OpsCenter reports
About Report Templates descriptions

Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  All Reports > Standard Reports > Policy > Policy Summary
Dashboard > Partially Successful Jobs for Policy

The following table lists the filters for Partial Jobs for Policy report and how you can
use these filters to view specific data in the report.

Filter Column Description

View Select a view to show data for the selected view in the report.
By default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the selected
Server Server primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .
Policy Policy Name  Select one or more policy names to view data for the selected
Policy Type policies.

Select one or more policy types to view data for the selected
policy types.

Example of filter usage: You may run the Partial Jobs for Policy report for specific
policies to view details only for the specific policies.

Failed Jobs for Policy

This drilldown report is available when you click a value (link) from the Number of
Failed Jobs column of the Policy Summary Dashboard report. This drilldown report
provides an overview of all the failed jobs for the selected policy name, server, and
time frame. This drilldown report uses the run time parameters that are passed from
the main report. The report provides details like schedule name, start times, and
duration of the job etc.

Figure 2-85 shows a sample view of the Failed Jobs for Policy report.
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Figure 2-85
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The following are details associated with the Failed Jobs for Policy report:

Report Name
Report Category

Where to Locate

Report Purpose

Supported products

Applicable View

Report Display

Drill down report

Can be scheduled

Failed Jobs for Policy

Policy (Drill down report)

Report > Report Templates > Policy Reports > Policy Summary
Dashboard (click Failed jobs) > Failed Jobs for Policy

This report lists all the failed jobs of the selected policy. This
report is valid for NetBackup and NetBackup Appliance.

NetBackup, NetBackup Primary Appliance

Primary Server, Client
Tabular
No

Yes
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Mapping with NOM report

OpsCenter reports
About Report Templates descriptions

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Policy > Policy Summary
Dashboard > Failed Jobs for Policy

The following table lists the filters for Failed Jobs for Policy report and how you can
use these filters to view specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Policy Policy Name
Policy Type

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more primary servers to view data for the selected
primary servers in the report. All primary servers that are added
to the OpsCenter console are shown in the Value drop-down
list .

Select one or more policy names to view data for the selected
policies.

Select one or more policy types to view data for the selected
policy types.

Example of filter usage: You may run the Failed Jobs for Policy report for specific
policies to view details only for the specific policies.

About Restore reports in OpsCenter

This section describes restore job reports that provide information for all the
NetBackup restore and recovery operations.These reports are applicable only for

NetBackup.

Restore Job Summary by Job Count report  See “Restore > Restore Job Attempt

Summary by Job Count” on page 280.

Restore Job Summary by Volume Restored See “Restore > Restore Job Attempt

report

Restore Job Details report

Client Restore report

Summary by Volume Restored” on page 283.

See “Restore > Restore Job Details”
on page 286.

See “Client Restore report” on page 288.

Restore > Restore Job Attempt Summary by Job Count

This report shows graphical summary of number of restore jobs per day.
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Figure 2-86 shows a sample view of Restore Job Attempt Summary by Job Count
Report.

Figure 2-86 Restore Job Attempt Summary by Job Count Report
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Graphical summary of number of restare job attempts per day. This report is valid for HeiBackup and Appliances.

In addition, you can view the report in a tabular format.

Figure 2-87 shows a sample view of Restore Job Attempt Summary by Job Count
Report.
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Figure 2-87 Restore Job Attempt Summary by Job Count Report (Tabular)

Job End Time Humber of Jobs

Jul 15, 2013
Jul 16, 2013
Jul 17,2013
Jul 18, 2013
Jul 19, 2013
Jul 20, 2013
Jul 21,2013
Jul 22,2013
Jul 23, 2013
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The following are the details that are associated with the Restore Job Attempt
Summary by Job Count report:

Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

Restore Job Attempt Summary by Job Count
Backup

All Reports > Report Templates > Restore > Restore Job
Summary by Job Count report.

Graphical summary of number of jobs per day.
NetBackup, NetBackup Primary Appliance
Primary Server, Client

Historical

Yes. See Restore Job Attempt Details

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Restore Job Summary

You can edit this report to show or hide the columns that you are interested in. All
the columns are shown by default. You can also filter the report to view reports of
specific primary servers. The following table shows the filters for the report and
how you can use these filters to view specific data in the report.
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Filter Column Description

View Select a view to show data for the selected view in the report. By
default All My Views is selected.

Primary  Primary Select one or more primary servers to view data for the virtual

Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the report for a specific primary server to view the
restore jobs per day for that primary server.

Restore > Restore Job Attempt Summary by Volume
Restored

This report shows graphical summary of volume of restore jobs per day.

Figure 2-88 shows a sample view of Restore Job Attempt Summary by Volume
Restored Report.
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Figure 2-88 Restore Job Attempt Summary by Volume Restored Report
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Graphical summary of valume of data reslored per day. This repor is valid for MetBackup and Appliances.

In addition, you can view the historical report in tabular format.

Figure 2-89 shows a sample view of Restore Job Attempt Summary by Volume
Restored Report.
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Figure 2-89 Restore Job Attempt Summary by Volume Restored Report
(Tabular)

Job End Time Volume (MB)

Jul 15, 2013 0
Jul 16, 2013 0
Jul 17, 2013 2257975
Jul 18, 2013 10,460.1
Jul 19, 2013 0
Jul 20, 2013 0
Jul 21, 2013 0
Jul 22,2013 7.93
Jul 23, 2013 0

The following are the details that are associated with the Restore Job Attempt
Summary by Volume Restored report:

Report Name Restore Job Attempt Summary by Volume Restored
Report Category Restore
Where to Locate All Reports > Report Templates > Restore > Restore Job

Summary by Volume Restored report.

Report Purpose Graphical summary showing number of restore jobs per day.
Supported products NetBackup, NetBackup Primary Appliance

Applicable View Primary Server, Client

Report Display Historical

Drill down report Yes. See Restore Job Attempt Details

Can be scheduled Yes

Supported formats PDF, CSV, TSV, XML, HTML

Mapping with NOM report  All Reports > Standard Reports > Restore Job Summary

You can edit this report to show or hide the columns that you are interested in. All
the columns are shown by default. You can also filter the report to view reports of
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specific primary servers. The following table shows the filters for the report and
how you can use these filters to view specific data in the report.
Filter Column Description
View Select a view to show data for the selected view in the report. By
default All My Views is selected.
Primary  Primary Select one or more primary servers to view data for the virtual
Server Server clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .
Example of filter usage: Run the report for a specific primary server to view the
Restore Job Summary by Volume Restored for that primary server.
Following filter enhancements have been done for the report.
= New supported formats TSV, XML, PDF, and HTML are added.
Restore > Restore Job Details
This report lists all the completed restore jobs for a selected timeframe.
Figure 2-90 shows a sample view of Restore Job Details Report.
Figure 2-90 Restore Job Details Report
Restore Job Details
JoblD § ] T Client N Media § Start End Aftempt Size(KB E:""t
o erver Name Type ient Name edia Server . . Namber ize(KB) -
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Jul 17, Jul 17,
12 2013 2013
nbapp141.eng Restore nbapppocd¥ nbapppocl? 12:31:00 12:31:08 130 1
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The following are the details that are associated with the Restore Job Details
report:



Report Name
Report Category

Where to Locate

Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report
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Restore Job Details
Restore

All Reports > Report Templates > Restore > Restore Job
Details report.

Lists all completed jobs for the selected timeframe.
NetBackup, NetBackup Primary Appliance
Primary Server, Client

Historical, Ranking, Distribution

None

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Jobs > Restore Job Details

You can edit the Restore Job Details reportto show or hide the columns that
you are interested in. All the columns are shown by default. You can also filter the
report to view reports of specific primary servers. The following table shows the
filters for Restore Job Details report and how you can use these filters to view

specific data in the report.

Filter Column

View

Primary  Primary
Server Server

Description

Select a view to show data for the selected view in the report. By
default All My Views is selected.

Select one or more primary servers to view data for the virtual
clients that are backed up by the selected primary servers in the
report. All primary servers that are added to the OpsCenter
console are shown in the Value drop-down list .

Example of filter usage: Run the Restore Job Details report for a specific primary
server to view the completed restore jobs for that primary server.

The following report enhancements have been made for the Restore Job Details

report:

= The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also see the Years tab on top-right corner
of the Tabular Backup Report.
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The default Relative Timeframe for this report was 28 days now it is changes
to next 2 weeks.

The following filter enhancements have been made for the Restore Job Details
report:

The units Weeks, Months and Years have been added for Relative Timeframe
selection. You can now view data for the last X years.

The default Relative Timeframe for this report is changed to Previous 14 days.
The column Elapsed Time has been removed.
New supported formats like TSV, XML, PDF & HTML added.

Rows per page parameter value were 20 now it is set to 100.

Client Restore report

This report provides restore job details for a specified client. The table in the report
contains information, such as, primary and media server names, and start and end
times.

You can edit the report to show or hide the columns that you are interested in. All
the columns are shown by default. You can also filter the report to show activity for
a limited sample set, such as one or more clients or views.

Figure 2-91 shows a sample view of the Client Restore report.

Figure 2-91 Client Restore report

Client Restore
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The following are details associated with the Client Restore Report:



Report Name
Report Category
Where to Locate
Report Purpose
Supported products
Applicable View
Report Display

Drill down report
Can be scheduled
Supported formats

Mapping with NOM report

OpsCenter reports
About Report Templates descriptions

Client Restore

Client Reports

Report > Report Templates > Client Reports > Client Restore
Lists all the restore jobs of the given client.

NetBackup, NetBackup Primary Appliance

Primary Server, Client

N.A.

None

Yes

PDF, CSV, TSV, XML, HTML

All Reports > Standard Reports > Client > Client Restore

The following table shows the filters for Client Restore report and how you can use
these filters to view specific data in the report.

Filter Column

View

Client Client Name

Description

Select a view to show data for the selected view in the report.
By default All My Views is selected.

Select one or more clients to view data for the selected clients
in the report. All clients that are protected by the primary servers
in the OpsCenter console are listed.

Example of filter usage: You may run the Clients Restore report for specific clients
to view details only for the specific clients.

The unit Years has been added for Relative Timeframe selection. You can now
view data for the last x years. You can also select Year from the top-right corner

of the report.

About Storage Lifecycle Policy reports

This section describes the Storage Lifecycle policy reports that provide information
about the NetBackup Storage Lifecycle Policies (SLP’s)and NetBackup Auto Image
Replication (AIR). It also inludes detailed information on SLP sizes, progress, and

backlog per Primary.
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The storage Lifecycle Policy reportsin OpsCenter help you gain an end-to-end
visibility across destinations in a storage lifecycle policy. With the Auto Image
Replication functionality, you can replicate images from one NetBackup domain to
another NetBackup domain. You can specify a different primary server as a storage
destination in an SLP. The SLP reports in OpsCenter show an end-to-end view of
the SLP process that includes backup to import of duplicated image into different
NetBackup domains. The SLP reports help you to verify if each step in the SLP is
executed and identify the possible bottlenecks.

The storage Lifecycle Policy reports in OpsCenter help you find answers to
the following questions:

= Is the SLP performing according to schedule?
= Have the 2nd, 3rd... Copies been made? Does the original image still exist?

= Am | at arisk of data loss? A copy at a certain phase is about to expire and the
subsequent phase’s copy has not been made.

= What is my backlog? Is it getting steadily worse?
Review the following points about SLP reports:
= The SLP reports are applicable only to NetBackup.

= The SLP reports can be run only for 7.1 or higher primary servers. If you upgrade
from 7.0 (or 7.0.1) to a 7.1 primary server, the SLP reports also show the images
for 7.0 or 7.0.1 primary servers.
If you upgrade NetBackup from 7.0 or 7.0.1 to 7.1 and the SLP definition contains
multiple backup operations, then the first copy is marked as "Backup" and the
remaining are marked as "Duplication”. For example, if you created an SLP that
contains four destinations where two destinations are for backup and two are
for duplication, then image copy data marks the first copy as Backup and
remaining for Duplication.

= The data that is shown in the SLP reports is collected from the NetBackup
catalog and the SLP worklist by NBSL. Once the initial data collection is
complete, the updated data is collected from the NetBackup catalog in every
15 minutes and from the SLP worklist in every 10 minutes. The SLP worklist is
located in the EMM and contains metadata like how many copies need to be
created, where they need to be created, when they are completed etc.
The data that is displayed in the SLP reports is based on the image data that
exists in the SLP worklist and the NetBackup catalog.

= The effects of deduplication, compression, or optimized deduplication on image
or copy size are not considered in the SLP reports.
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= By default, data for SLP reports is purged from the OpsCenter database after
90 days. You can also customize the purge interval for SLP images from Settings
> Configuration > Data Purge.

= In general, the copy data in the SLP reports (like Copies Completed column) is
based on the data that is collected from the SLP worklist. EMM creates the SLP
worklist once a backup is complete. OpsCenter collects this data in every 10
minutes and shows it in the SLP reports. Depending on when the SLP worklist
is created and also the OpsCenter data collection cycle, the OpsCenter consoles
show details for the copy data.

= The timeframe filter for all SLP reports is based on the time when the primary
backup image (and not an image copy) was created. For example, if you view
the SLP Status by Image Copy report between 7'th May 1:00 P.M. to 8'th May
1:00 P.M., then the copies that got created for an SLP after 8'th May 1:00 P.M.
may be displayed. These copies may be displayed as the timeframe filter is
based on the time when the primary backup image was created and not on the
copy creation time.

n  SLP reports do not consider non-SLP based duplications.
= Creating custom reports for SLP’s is not supported.

The following are two high-level SLP reports:

SLP Status report See “SLP Status report” on page 292.

SLP Backlog report See “SLP Backlog report” on page 297.

Before using the SLP reports, you must understand the SLP and Auto Image
Replication concepts in NetBackup.

See “About SLP and Auto Image Replication” on page 291.

About SLP and Auto Image Replication

This section gives a brief overview about SLP and Auto Image Replication in
NetBackup.

A Storage Lifecycle Policy (SLP) is a storage plan that specifies where data will be
stored and for how long. The SLP determines where the backup image is initially
written and where it is subsequently duplicated. With NetBackup 7.1, you can also
duplicate backup image or duplicate copies from one storage domain to another
for business continuity planning purposes. This means that you can now copy
backup images from one primary server to another primary server, and also specify
a different primary server as a storage destination in an SLP.
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The SLP and Auto Image Replication functionality in NetBackup allow you to move
data to tiers of storage on different primary servers commensurate with the value
of the data as it ages.

More information about SLP and Auto Image Replication functionality is available
in the NetBackup Administrator’s Guide.

SLP Status report

The SLP Status report provides a summary of lifecycle policies that are associated
with a primary server. The SLP Status report is a tabular report that lets you know
the current progress of SLPs in the selected timeframe for each primary server that
is added to the OpsCenter console.

The SLP status report gives a quick summary of the SLP activity and lets you identify
the SLPs that are incomplete. You can see if all your duplications (copies) are
complete or not.

By clicking the links in the SLP Status report, you can drill down to more detailed
reports. You can use the drill-down reports to focus on SLP’s, images, or the image
copies that are incomplete. You can also view SLP status for each destination and
also for each SLP.

From the SLP Status report, you can drill down to the following reports:

SLP Status by SLP report See “SLP Status by SLP report” on page 298.

From the SLP Status by SLP report, you can drill down to
the following reports:

= SLP Status by Destinations report

See “SLP Status by Destinations report” on page 317.
= SLP Duplication Progress report

See “SLP Duplication Progress report” on page 321.

SLP Status by Client report  See “SLP Status by Client report” on page 303.
SLP Status by Image report See “SLP Status by Image report” on page 308.

SLP Status by Image Copy  See “SLP Status by Image Copy report” on page 313.
report

The SLP Status report comprises of the following columns:
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Name of the primary server (link) where the SLP runs. The
SLP may run on the origin primary server or any of the
destination primary servers (in case of Auto Image
Replication). The NetBackup primary server must be of 7.1
or a later version and also added to the OpsCenter console.
This column is mandatory and cannot be removed when you
edit the report.

Click on the primary server (link) to see the drilldown report
named SLP Status by SLP.

This column tells you about the oldest image that is
SLP-incomplete for the selected primary server. This column
represents the image end time (and date). The data from this
column helps you to identify the possible bottlenecks in the
SLP process.

This column is mandatory and cannot be removed when you
edit the report.

Number of the unique clients that are backed up by the SLP
for the selected primary server. Note that if the same client
is backed up twice or thrice by the SLP, the client is counted
only once. Click the number (link) to view the SLP Status by
Client report.

This column is mandatory and cannot be removed when you
edit the report.

Total number of the images that are present in the
OpsCenter database for SLP’s on the selected primary server
(includes both SLP-complete images and SLP-incomplete
images). Click the number (link) to view the SLP Status by
Image report for the specific primary server. This report
displays details of images in the OpsCenter database that
are associated with the SLP’s on the selected primary server.

This column is mandatory and cannot be removed when you
edit the report.
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Images Not SLP Complete
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Percentage of images in the OpsCenter database that are
SLP-complete for the selected primary server. This column
is calculated using data from the following columns of the
SLP Status report:

= Images SLP Complete
= Total Existing Images

The contents of Images % SLP Complete column is
calculated by using the following formula:

Images SLP Complete / Total Existing Images * 100

This column is mandatory and cannot be removed when you
edit the report.

Number of images in the OpsCenter database that are
SLP-complete for the specific SLP on the selected primary
server. You can remove this column when you edit the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-complete for the specific SLP.

Number of images in the OpsCenter database that are
SLP-incomplete for the specific SLP on the selected primary
server. This column is mandatory and cannot be removed
when you edit the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-incomplete.

Total number of image copies in the OpsCenter database for
the specific SLP on the selected primary server (includes
both complete copies and incomplete copies). This column
is mandatory and cannot be removed when you edit the
report.

Click the number (link) to view the SLP Status by Image Copy
report.
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Percentage of completed copies in the OpsCenter database
for the specific SLP on the selected primary server. This
column is mandatory and cannot be removed when you edit
the report. The data for this column is calculated by using
data from the following columns of the SLP Status By SLP
report:

= Copies Completed
» Total Expected Copies

The contents of % Copy Complete column is calculated by
using the following formula:

Copies Completed / Total Expected Copies * 100

Number of the completed copies that are present in the
OpsCenter database for SLP’s on the selected primary server.
Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
complete for the selected primary server.

You can remove this column when you edit the report.

Number of incomplete copies in the OpsCenter database for
SLP’s on a selected primary server. This column is calculated
using the following formula:

Copies Not Complete = Total Expected Copies —Copies
Completed

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for image copies in the OpsCenter database that are
incomplete for the selected primary server.

This column is mandatory and cannot be removed when you
edit the report.
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Expected aggregate size of all copies for SLP’s on the
selected primary server that are present in the

OpsCenter database. This column is mandatory and cannot
be removed when you edit the report.

The Total Expected Size for all copies is calculated by using
the following formula:

Total Expected Size for all copies = (Number of copies) *
(backup copy size)

Note: The total expected size for all copies is a front-end
size and is derived from the number of copies multiplied by
the size of backup copy. The effects of deduplication,
compression, or optimized deduplication on the Total
Expected Size — all copies are not considered in the SLP
reports.

Percentage of completed copy size for the selected primary
server. This column is mandatory and cannot be removed
when you edit the report.

The Completed Copy Size (%) for the specific primary server
is calculated using data from the following columns of the
SLP Status report:

= Completed Copy Size
= Total Expected Size — all copies

The contents of Completed Copy Size (%) column is
calculated for each primary server by using the following
formula:

Completed Copy Size / Total Expected Size — all copies *
100

Aggregate size of all the completed copies in the
OpsCenter database for the selected primary server. You
can remove this column when you edit the report. Note: The
Completed Copy Size is a front-end size. The effects of
deduplication, compression, or optimized deduplication on
completed copy size are not considered in the SLP reports.
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Remaining Copy Size (MB) Aggregate size of all remaining copies that are to be created
for the selected primary server. This column is mandatory
and cannot be removed when you edit the report.

The Remaining Copy Size (MB) for a specific primary server
is calculated in the following manner:

(Remaining Copy Count) x (Size of Backup Copy1)

Note: The remaining copy size is a front-end size and is
derived from the number of remaining copies multiplied by
the size of backup copy 1. The effects of deduplication,
compression, or optimized deduplication on remaining copy
size are not considered in the SLP reports.

You can use filters to view specific data in the SLP Status report. The following
filters are available when you edit the SLP Status report:

Views Select a particular view to see data for the selected view.

Primary Server Select one or more primary servers to see data for the
selected primary servers.

SLP Backlog report

The SLP Backlog report lets you monitor the overall SLP backlog in a glance. This
report shows the trend of images created vs. the images which are SLP incomplete
in a line chart format. This report illustrates what the SLP backlog looks like against
the image creation volume for the selected timeframe and the selected SLP’s. By
comparing the line charts in this report, you can understand the rate at which copies
are created vs. the rate at which images requiring copies are created. This report
provides you with empirical evidence on how efficiently the SLP performs and
visibility into its capacity (i.e. at what point does the outflow begin to fall steadily
behind).

Data for the SLP Backlog report is collected from the OpsCenter database at
midnight (12:00 A.M. by the OpsCenter Server clock). The data collection for the
SLP Backlog report occurs after every 24 hours. This report is available in both
graphical (chart) and tabular formats. To view the report details in a tabular format,
click the link Show Chart as Table at the bottom of the report.

You can edit the report to view specific data in the report. You can also save this
report. Note that when you save the SLP Backlog report and run the saved report
after some time, the report displays current data. You can export or email this report
for reference.
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Note that the data that is shown in the SLP Backlog report (images that are created
and unfinished images) is in GB by default. You can edit the report and change the
units to KB, MB, or TB. The default timeframe for the SLP Backlog report is last
two weeks.

While editing the SLP Backlog report, you can group the timeframe for which you
want to see data. However, the time frame grouping for the SLP Backlog report is
supported for the following intervals only:

= one day
= one week
= one month

The SLP Backlog report does not support any other time frame grouping (like two
days, three months, 1 minute, or four weeks).

You can use filters to view specific data in the SLP Backlog report. The following
filters are available when you edit the SLP Backlog report:

Views Select a particular view to see data for the selected view.

Primary Server Select one or more primary servers to see data for the
selected primary servers.

Storage Lifecycle Policy Select one or more SLP’s to see data for the selected SLP’s.

SLP Status by SLP report

You can view the SLP status by SLP report when you click the primary server (link)
in the SLP report. It provides detailed information on the status of each SLP that is
configured on the selected primary server.

The SLP status by SLP report lets you monitor the progress of each SLP and also
quickly identify the possible bottlenecks.

The SLP Status by SLP report comprises of the following columns:

Primary Server (where the Name of the primary server where the SLP runs. The SLP

SLP lives) may run on the origin primary server or any of the destination
primary servers (in case of Auto Image Replication). The
NetBackup primary server must be of 7.1 or a later version
and also added to the OpsCenter console.

This column is mandatory and cannot be removed when you
edit the report.
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Name of the SLP (link) that is configured on the primary
server. This column is mandatory and cannot be removed
when you edit the report.

Click the name (link) to view the SLP Status by Destinations
report.

Version (link) that is associated with the specific SLP on the
selected primary server. This column is mandatory and cannot
be removed when you edit the report.

Click the version (link) to view the SLP Duplication Progress
report.

The oldest image that is not SLP-complete for the specific
SLP on the selected primary server. This column represents
the image end time (and date). This data helps you to identify
the possible bottlenecks for the specific SLP.

This column is mandatory and cannot be removed when you
edit the report.

Number of unique clients (link) that are backed up by the
specific SLP. Note that if the same client is backed up twice
or thrice by the SLP, the client is counted only once. This
column is mandatory and cannot be removed when you edit
the report.

Click the number (link) to view the SLP Status by Client
report.

The total number of images that are present in the
OpsCenter database for the specific SLP on the selected
primary server. This includes both SLP-complete images and
SLP-incomplete images. This column is mandatory and
cannot be removed when you edit the report.

Click the number (link) to view the SLP Status by Image report
for the specific SLP on the selected primary server. This
report displays details of images in the OpsCenter database
that are associated with the SLP’s on the selected primary
server.
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Percentage of images in the OpsCenter database that are
SLP-complete for the specific SLP on the selected primary
server. This column is mandatory and cannot be removed

when you edit the report.

The data for this column is calculated using data from the
following columns of the SLP Status by SLP report:

= Images SLP Complete
= Total Existing Images

The contents of Images % SLP Complete column is
calculated by using the following formula:

Images SLP Complete / Total Existing Images * 100

Number of images in the OpsCenter database that are
SLP-complete for the specific SLP on the selected primary
server. You can remove this column when you edit the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-complete for the specific SLP.

Number of images in the OpsCenter database that are
SLP-incomplete for the specific SLP on the selected primary
server. This column is mandatory and cannot be removed
when you edit the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-incomplete.

Total number of image copies in the OpsCenter database for
the specific SLP on the selected primary server (includes
both complete copies and incomplete copies). This column
is mandatory and cannot be removed when you edit the
report.

Click the number (link) to view the SLP Status by Image Copy
report.
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% Copy Complete

Copies Completed

Copies Not Complete
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Percentage of completed copies in the OpsCenter database
for the specific SLP on the selected primary server. This
column is mandatory and cannot be removed when you edit
the report.

The data for this column is calculated by using data from the
following columns of the SLP Status By SLP report:

s Copies Completed
= Total Expected Copies

The contents of % Copy Complete column is calculated by
using the following formula:

Copies Completed / Total Expected Copies * 100

The number of completed copies that are present in the
OpsCenter database for the specific SLP on the selected
primary server. You can remove this column when you edit
the report.

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
complete for the selected primary server.

Shows the number of incomplete copies in the
OpsCenter database for the specific SLP on the selected
primary server. This column is mandatory and cannot be
removed when you edit the report.

The data for this column is calculated by using the following
formula:

Copies Not Complete = Total Expected Copies —Copies
Completed

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
incomplete for the selected SLP.
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Total Expected Size - all
copies (MB)

Completed Copy Size (%)

Completed Copy Size (MB)
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Expected aggregate size of all copies for the selected SLP
that are present in the OpsCenter database. This column is
mandatory and cannot be removed when you edit the report.

The data for this column is calculated by using the following
formula:

Total Expected Size for all copies = (Number of copies for
the specific SLP) * (backup copy size for the specific SLP)

Note: The total expected size for all copies is a front-end
size and is derived from the number of copies multiplied by
the size of backup copy. The effects of deduplication,
compression, or optimized deduplication on the Total
Expected Size — all copies are not considered in the SLP
reports.

Percentage of completed copy size for the specific SLP on
the selected primary server. This column is mandatory and
cannot be removed when you edit the report.

The data for this column is calculated from the following
columns of the SLP Status By SLP report:

= Completed Copy Size
= Total Expected Size — all copies

The contents of Completed Copy Size (%) column is
calculated by using the following formula:

Completed Copy Size / Total Expected Size — all copies *
100

Aggregate size of all the completed copies in the
OpsCenter database for the specific SLP on the selected
primary server. You can remove this column when you edit
the report.

Note: The Completed Copy Size is a front-end size. The
effects of deduplication, compression, or optimized
deduplication on completed copy size are not considered in
the SLP reports.
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Remaining Copy Size (MB) Aggregate size of all remaining copies that are to be created
for the specific SLP on the selected primary server. This
column is mandatory and cannot be removed when you edit
the report.

The data for this column is calculated in the following manner:

(Remaining Copy Count for the specific SLP) x (Size of
backup copy for the specific SLP)

Note: The remaining copy size is a front-end size and is
derived from the number of remaining copies multiplied by
the size of backup copy 1. The effects of deduplication,
compression, or optimized deduplication on remaining copy
size are not considered in the SLP reports.

You can use filters to view specific data in the SLP Status by SLP report. The
following filters are available when you edit the SLP Status by SLP report:

Views Select a particular view to see data for the
selected view.

Primary Server Select one or more primary servers to see
data for the selected primary servers.

Storage Lifecycle Policy Select one or more SLP’s to see data for the
selected SLP’s.

The default timeframe for this report is based on what timeframe is selected for the
top-level report.

SLP Status by Client report

The SLP Status by Client report is available as a drill-down report from the SLP
Status and SLP Status by SLP report. You can view the SLP status by Client report
when you click the links in the Total Clients column in the following reports:

= SLP Status
= SLP Status by SLP (a filtered view of the SLP status by Client report is shown)

The SLP Status by Client report lets you monitor the SLP progress for each client
that is associated with the SLP. This report helps you to know details about the
SLPs that protect the clients.

This report also provides details about origin primary server (primary server where
the data is backed up) and the primary server where the SLP is running currently.
These two primary servers may be different when in case of Auto Image Replication.

303



OpsCenter reports
About Report Templates descriptions

The SLP Status by Client report comprises of the following columns:

Primary Server (where the
SLP lives)

SLP Name

SLP Version

Client Name

Origin Primary Server
(created the image)

Oldest Unfinished Image

Name of the primary server where the SLP that is associated
with the client exists. The SLP may run on the origin primary
server or any of the destination primary servers (in case of
Auto Image Replication). The NetBackup primary server must
be of 7.1 or a later version and also added to the OpsCenter
console.

This column is mandatory and cannot be removed when you
edit the report.

Name of the SLP that is associated with the selected primary
server and client. This column is mandatory and cannot be
removed when you edit the report.

Version that is associated with the specific SLP. This column
is mandatory and cannot be removed when you edit the
report.

Client name (link) that is backed up by the specific SLP on
the selected primary server. This column is mandatory and
cannot be removed when you edit the report.

Click the client name (link) to view the SLP Status by Image
report. The SLP Status by Image report is filtered for the
specific client and the specific SLP.

Origin Primary Server is where the primary backup
copy resides. The SLP may run on the origin primary server
or any of the destination primary servers (in case of Auto
Image Replication). The Origin Primary Server must
be a NetBackup 7.1 or later primary server and also added
to the OpsCenter console.

This column is mandatory and cannot be removed when you
edit the report.

This column tells you about the oldest image that is not
SLP-complete for the selected primary server, SLP, and
client. This column represents the image end time (and date).
This data helps you to identify the possible bottlenecks for
the specific SLP.

This column is mandatory and cannot be removed when you
edit the report.
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Total Existing Images

Images % SLP Complete

Images SLP Complete

Images Not SLP Complete
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The total number of images that are present in the
OpsCenter database for the specific SLP and client on the
selected primary server. This includes both SLP-complete
images and SLP-incomplete images. This column is
mandatory and cannot be removed when you edit the report.

Click the number (link) to view the SLP Status by Image report
for the specific SLP on the selected primary server. This
report displays details of images in the OpsCenter database
that are associated with the SLP’s and client on the selected
primary server.

Percentage of images in the OpsCenter database that are
SLP-complete for the specific SLP and client on the selected
primary server. This column is mandatory and cannot be
removed when you edit the report.

The data for this report is calculated from the following
columns of the SLP Status by Client report:

= Images SLP Complete
= Total Existing Images

The data in the Images % SLP Complete column is
calculated by using the following formula:

Images SLP Complete / Total Existing Images * 100

Number of images in the OpsCenter database that are
SLP-complete for the specific SLP and client on the selected
primary server. You can remove this column when you edit
the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-complete for the specific SLP and client.

Number of images in the OpsCenter database that are
SLP-incomplete for the specific SLP and client on the selected
primary server. This column is mandatory and cannot be
removed when you edit the report.

Click the number (link) to view the SLP Status by Image
report. A filtered view of the report appears that displays
details of images in the OpsCenter database that are
SLP-incomplete.
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Total Expected Copies

% Copy Complete

Copies Completed

Copies Not Complete
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Total number of copies expected in the OpsCenter database
for the specific SLP and client on the selected primary server
(includes both complete copies and incomplete copies). This
column is mandatory and cannot be removed when you edit
the report.

Click the number (link) to view the SLP Status by Image Copy
report.

Percentage of completed copies in the OpsCenter database
for the specific SLP and client on the selected primary server.
This column is mandatory and cannot be removed when you
edit the report.

The data for this column is calculated from the following
columns of the SLP Status by Client report:

s Copies Completed
= Total Expected Copies

The contents of % Copies Complete column is calculated
by using the following formula:

Copies Completed / Total Expected Copies * 100

The number of completed copies that are present in the
OpsCenter database for the specific SLP and client on the
selected primary server. You can remove this column when
you edit the report.

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
complete for the selected primary server.

Shows the number of incomplete copies in the

OpsCenter database for the specific SLP and client on the
selected primary server. This column is mandatory and cannot
be removed when you edit the report.

The data for this column is calculated by the following formula:

Copies not Complete = Total Expected Copies — Copies
Completed

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
incomplete for the selected SLP.
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copies (MB)

Completed Copy Size (%)

Completed Copy Size (MB)
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Expected aggregate size of all copies for the selected SLP
and client that are present in the OpsCenter database. This
column is mandatory and cannot be removed when you edit
the report.

The data for this column is calculated by the following formula:

Total Expected Size for all copies = (Number of copies) *
(backup copy size)

Note: The total expected size for all copies is a front-end
size and is derived from the number of copies multiplied by
the size of backup copy. The effects of deduplication,
compression, or optimized deduplication on the Total
Expected Size — all copies are not considered in the SLP
reports.

Percentage of completed copy size for the specific SLP and
client on the selected primary server. This column is
mandatory and cannot be removed when you edit the report.

The data for this column is calculated from the following
columns of the SLP Status by Client report:

= Completed Copy Size
= Total Expected Size — all copies

The contents of Completed Copy Size (%) column is
calculated by using the following formula:

Completed Copy Size / Total Expected Size — all copies *
100

Aggregate size of all the completed copies in the
OpsCenter database for the specific SLP and client on the
selected primary server. You can remove this column when
you edit the report.

Note: The Completed Copy Size is a front-end size. The
effects of deduplication, compression, or optimized
deduplication on completed copy size are not considered in
the SLP reports.
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Remaining Copy Size (MB) Aggregate size of all remaining copies that are to be created

for the specific SLP and client on the selected primary server.
This column is mandatory and cannot be removed when you
edit the report.

The column content is calculated in the following manner:
(Remaining Copy Count) x (Size of Backup Copy1)

Note: The remaining copy size is a front-end size and is
derived from the number of remaining copies multiplied by
the size of backup copy 1. The effects of deduplication,
compression, or optimized deduplication on remaining copy
size are not considered in the SLP reports.

You can use filters to view specific data in the SLP Status by Client report. The
following filters are available when you edit the SLP Status by Client report:

Views

Primary Server

Storage Lifecycle Policy

Client

Select a particular view to see data for the selected view.

Select one or more primary servers to see data for the
selected primary servers.

Select one or more SLP’s to see data for the selected SLP’s.

Select one or more clients to see data for the selected clients.

The default timeframe for this report is based on what timeframe is selected for

top-level report.

SLP Status by Image report

The SLP Status by Image report is available as a drill-down report from the SLP

Status, SLP Status by SLP, and SLP Status by Client report. You can view the SLP

Status by Image report when you click the links in the following columns:

= Total Existing Images

= Images SLP Complete (filtered view of the SLP Status by Image report is shown)

= Images Not SLP Complete (filtered view of the SLP Status by Image report is

shown)

The SLP Status by Image report lets you monitor the lifecycle for the images that
are associated with the SLP. This report helps you to know which images are
complete and incomplete for a specific SLP and identify bottlenecks in the SLP
process. This report gives an idea of how a specific image is duplicated across
primary servers and also provides specific details about the image like backup time,
SLP completion time, copies associated with each image and it's status etc. The
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SLP status by Image report can help you to identify the image IDs that are not

SLP-complete.

The SLP Status by Image report comprises of the following columns:

Primary Server (where the Name of the primary server where the SLP runs. The SLP

SLP lives)

SLP Name

SLP Version

Policy Name

Schedule Name

Client Name

Origin Primary Server
(created the image)

may run on the origin primary server or any of the destination
primary servers (in case of Auto Image Replication). The
NetBackup primary server must be of 7.1 or a later version
and also added to the OpsCenter console.

This column is mandatory and cannot be removed when you
edit the report.

Name of the SLP that is associated with the selected primary
server and image.

This column is mandatory and cannot be removed when you
edit the report.

Version (link) that is associated with the specific SLP. This
column is mandatory and cannot be removed when you edit
the report. Click the version (link) to view the SLP Duplication
Progress report.

Policy that is associated with the SLP. This column is
mandatory and cannot be removed when you edit the report.

Schedule that is associated with the policy. You can remove
this column when you edit the report.

Client name that is backed up by the SLP for the selected
primary server.

This column is mandatory and cannot be removed when you
edit the report.

Origin Primary Server is where the primary backup
copy resides. The SLP may run on the origin primary server
or any of the destination primary servers (in case of Auto
Image Replication). The origin primary server and primary
server where the SLP lives (or is running currently) may be
different if you use Auto Image Replication.

The Origin Primary Server must be a NetBackup 7.1
or later primary server and also added to the OpsCenter
console. This column is mandatory and cannot be removed
when you edit the report.
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Image ID

Backup Time

SLP Completion Time

Lag Time (SLP Completion
Time — Backup Time)

Total Expected Copies

Copies Completed
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Image ID (link) associated with the image. The Image ID is
unique for each image. Click the image ID (link) to view the
SLP Status by Image Copy report.

This column is mandatory and cannot be removed when you
edit the report.

Date and time when the primary backup is completed.

This column is mandatory and cannot be removed when you
edit the report.

Date and time when the image is SLP-complete. This column
is mandatory and cannot be removed when you edit the
report.

The Lag Time gives you an idea of how much time was
required to complete the SLP and judge how fast or slow
duplications occur. The Lag time is displayed in seconds.

The Lag time for a specific image copy is computed by using
data from the following columns and by using the following
formula:

Lag Time = SLP Completion Time — Backup Time

This column is mandatory and cannot be removed when you
edit the report.

Total number of copies expected in the OpsCenter database
for the specific SLP and image on the selected primary server
(includes both complete copies and incomplete copies).

Click the number (link) to view the SLP Status by Image Copy
report. This column is mandatory and cannot be removed
when you edit the report.

The number of completed copies that are present in the
OpsCenter database for the specific SLP and image on the
selected primary server.

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
complete for the selected primary server.

You can remove this column when you edit the report.
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Copies Not Complete

% Copy Complete

Total Expected Size - all
copies (MB)
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Shows the number of incomplete copies in the

OpsCenter database for the specific SLP and image on the
selected primary server. This column is mandatory and cannot
be removed when you edit the report.

The data for this column is calculated by the following formula:

Copies not Complete = Total Expected Copies —Copies
Completed

Click the number (link) to view the SLP Status by Image Copy
report. A filtered view of the report appears that displays
details for copies in the OpsCenter database that are
incomplete for the selected SLP.

Percentage of completed copies in the OpsCenter database
for the specific SLP and image on the selected primary server.
This column is mandatory and cannot be removed when you
edit the report.

The data for this column is calculated from the following
columns of the SLP Status by Image report:

s Copies Completed
= Total Expected Copies

The contents of this column is calculated by using the
following formula:

Copies Completed / Total Expected Copies * 100

Expected aggregate size of all copies for the selected SLP
and image that are present in the OpsCenter database. This
column is mandatory and cannot be removed when you edit
the report. The data for this column is calculated by the
following formula:

Total Expected Size for all copies = (Number of copies) *
(backup copy size)

Note: The total expected size for all copies is a front-end
size and is derived from the number of copies multiplied by
the size of backup copy. The effects of deduplication,
compression, or optimized deduplication on the Total
Expected Size — all copies are not considered in the SLP
reports.
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Completed Copy Size (MB) Aggregate size of all the completed copies in the

Completed Copy Size (%)

Remaining Copy Size (MB)

OpsCenter database for the specific SLP and image on the
selected primary server. You can remove this column when
you edit the report.

Note: The Completed Copy Size is a front-end size. The
effects of deduplication, compression, or optimized
deduplication on completed copy size are not considered in
the SLP reports.

Percentage of completed copy size for the specific SLP and
image on the selected primary server. This column is
mandatory and cannot be removed when you edit the report.

The data for this column is calculated from the following
columns of the SLP Status By Image report:

= Completed Copy Size
» Total Expected Size — all copies

The contents of Completed Copy Size (%) column is
calculated by using the following formula:

Completed Copy Size / Total Expected Size — all copies *
100

Aggregate size of all remaining copies that are to be created
for the specific SLP and image on the selected primary server.
This column is mandatory and cannot be removed when you
edit the report.

The data for this column is calculated in the following manner:
(Remaining Copy Count) x (Size of Backup Copy1)

Note: The remaining copy size is a front-end size and is
derived from the number of remaining copies multiplied by
the size of backup copy 1. The effects of deduplication,
compression, or optimized deduplication on remaining copy
size are not considered in the SLP reports.

You can use filters to view specific data in the SLP Status by Image report. The
following filters are available when you edit the SLP Status by Image report:

Views

Primary Server

Select a particular view to see data for the
selected view.

Select one or more primary servers to see
data for the selected primary servers.
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Storage Lifecycle Policy You can select the following columns:

= SLP Name: Select one or more SLP’s to
view data for the selected SLP’s.

»  SLP status: Select SLP status for which
you want to view data.

Policy Select one or more policies to see data for
the selected policies.

Schedule Select one or more schedules to see data for
the selected schedules.

Client Select one or more clients to see data for the
selected clients.

The default timeframe for this report is based on what timeframe is selected for the
top-level report.

SLP Status by Image Copy report

The SLP status by Image Copy report is available as a drill-down report from the
SLP Status, SLP Status by SLP, and SLP Status by Image report. You can view
the SLP Status by Image Copy report when you click the links in the following
columns:

= Total Expected Copies

= Copies Completed (filtered view of the SLP Status by Image Copy report is
shown)

» Copies Not Complete (filtered view of the SLP Status by Image Copy report is
shown)

The SLP Status by Image Copy report shows how the image copies are created
for different SLP destinations across different primary servers. This report provides
detailed information about the image copies that the SLP creates. This report
provides details such as which copy is complete, which SLP is not complete and
the specific copy operations that are pending.

The SLP Status by Image Copy report comprises of the following columns:
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Primary Server (where the Name of the primary server where the SLP runs. The SLP

SLP lives)

SLP Name

SLP Version

Data Classification

Policy Name

Schedule Name

Client Name

Image ID

Job ID

may run on the origin primary server or any of the destination
primary servers (in case of Auto Image Replication). The
NetBackup primary server must be of 7.1 or a later version
and also added to the OpsCenter console.

This column is mandatory and cannot be removed when you
edit the report.

Name of the SLP that is associated with the selected primary
server.

This column is mandatory and cannot be removed when you
edit the report.

Version (link) that is associated with the specific SLP. This
column is mandatory and cannot be removed when you edit
the report.

Click the version (link) to view the SLP Duplication Progress
report.

Data classification that is associated with the SLP.

This column is mandatory and cannot be removed when you
edit the report.

Policy that is associated with the SLP. This column is
mandatory and cannot be removed when you edit the report.

Schedule that is associated with the NetBackup policy. You
can remove this column when you edit the report.

Client name that is backed up by the SLP for the selected
primary server. This column is mandatory and cannot be
removed when you edit the report.

Image ID associated with the image. The image ID is unique
for each image. This column is mandatory and cannot be
removed when you edit the report.

Click the image ID (link) to view the SLP Status by Image
Copy report.

Job ID associated with the specific operation. This column
is mandatory and cannot be removed when you edit the
report.
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Origin Primary Server
(created the image)

Operation

State

Format

Destination

Expiration Time

Copy/lImport Completion
Time

Lag Time (Copy Time —
Backup Time)
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Origin Primary Server is where the primary backup
copy resides. The SLP may run on the origin primary server
or any of the destination primary servers (in case of Auto
Image Replication). The origin primary server and primary
server where the SLP lives (or is running currently) may be
different if you use Auto Image Replication.

The Origin Primary Server must be a NetBackup 7.1
or later primary server and also added to the OpsCenter
console. This column is mandatory and cannot be removed
when you edit the report.

The operation that is performed on an image copy like
Duplication, Backup, Import etc.

This column is mandatory and cannot be removed when you
edit the report.

Current status of the copy like Complete, Not Started, In
Process, Deleted, Paused. You can remove this column when
you edit the report.

The Format column helps to differentiate between the
NetBackup image format and the snapshot copy. This report
shows the details of any snapshot copy that is a part of the
storage lifecycle policy.

Destination where a copy should reside as per the SLP
definition. This column is mandatory and cannot be removed
when you edit the report.

Time when the copy expires. You can remove this column
when you edit the report.

Time when the copy is completed. This column is mandatory
and cannot be removed when you edit the report.

The Lag Time gives you an idea of how fast or slow
duplications occur. The Lag time is displayed in seconds.

This column is mandatory and cannot be removed when you
edit the report.
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Completed Copy Size (MB) Aggregate size of all the completed copies in the

OpsCenter database for the specific SLP and image on the
selected primary server. This column is mandatory and cannot
be removed when you edit the report.

Note: The Completed Copy Size is a front-end size. The
effects of deduplication, compression, or optimized
deduplication on completed copy size are not considered in
the SLP reports.

You can use filters to view specific data in the SLP Status by Image Copy report.
The following filters are available when you edit the SLP Status by Image Copy

report:

Views

Primary Server

Storage Lifecycle Policy

Policy

Select a particular view to see data for the
selected view.

Select one or more primary servers to see
data for the selected primary servers.

You can select the following parameters:

= Replication to Remote Primary: If the
value is Yes, then copy details for
replication jobs are displayed.

= Operation: Select one or more operations
that you want to view.

»  SLP name: Select one or more SLP’s that
you want to view.

= State: Select one or more states that you
want to view.

Example: If you want to view all pending
import operations, select the following
parameters:

= Operation = Import
= State = Not Started
Example: If you want to view the replication

status for jobs, select the following
parameters:

= Replication to Remote Primary = Yes

»  Operation = Duplication

Select one or more policies to see data for
the selected policies.
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Schedule Select one or more schedules to see data for
the selected schedules.

Client Select one or more clients to see data for the
selected clients.

Images Enter the image ID for which you want to view
data.

The default timeframe for this report is based on what timeframe is selected for the
top-level report.

SLP Status by Destinations report

The SLP Status by Destinations report is available as a drill-down report from the
SLP Status by SLP report. You can view the SLP Status by Destinations report
when you click the SLP name (link) in the SLP Status by SLP report.

The SLP Status by Destinations report provides a summary of all the destinations
for a specific SLP. You can view the SLP status by Destinations report to monitor

the SLP progress for each SLP destination. For example, you may want to know

the image copies that are not complete for a specific SLP destination.

The SLP Status by Destinations report comprises of the following columns:

Primary Server (where the Name of the primary server where the SLP runs. The SLP

SLP lives) may run on the source primary server or any of the destination
primary servers (in case of Auto Image Replication). The
NetBackup primary server must be of 7.1 or a later version
and also added to the OpsCenter console.

This column is mandatory and cannot be removed when you
edit the report.

SLP Name Name of the SLP that you selected. This column is mandatory
and cannot be removed when you edit the report.

SLP Version Version that is associated with the SLP. This column is
mandatory and cannot be removed when you edit the report.

Data Classification Data classification that is associated with the SLP destination.

This column is mandatory and cannot be removed when you
edit the report.
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Origin Primary Server
(created the image)

Operation

Retention

Destination

Average Lag Time (Copy
Time — Backup Time)

Total Expected Copies

Copies Completed
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Origin Primary Server is where the primary backup
copy resides. The SLP may run on the origin primary server
or any of the destination primary servers (in case of Auto
Image Replication). The origin primary server and primary
server where the SLP lives (or is running currently) may be
different in case of Auto Image Replication.

The Origin Primary Server must be a NetBackup 7.1
or later primary server and also added to the OpsCenter
console. This column is mandatory and cannot be removed
when you edit the report.

The operation that is performed on an image copy like
Duplication, Backup, Import etc. for the specific SLP
destination.

This column is mandatory and cannot be removed when you
edit the report.

Retention period that is associated with the specific SLP
destination.

This column is mandatory and cannot be removed when you
edit the report.

Destination where an image should reside as per the SLP
definition.

This column is mandatory and cannot be removed when you
edit the report.

The Average Lag Time gives you an idea of how much time
is required to duplicate the primary copy to a particular
destination for a specific SLP and judge how fast or slow
duplications occur. The Average Lag Time is displayed in
seconds. This column is mandatory and cannot be removed
when you edit the report.

Total number of copies in the OpsCenter database for the
SLP and the specific SLP destination (includes both complete
copies and incomplete copies).

This column is mandatory and cannot be removed when you
edit the report.

The number of completed copies that are present in the
OpsCenter database for the SLP and the specific SLP
destination. You can remove this column when you edit the
report.
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Percentage of completed copies in the OpsCenter database
for the SLP and the specific SLP destination.

The column contents are calculated using data from the
following columns of the SLP Status by Destinations report:

= Copies Completed
= Total Expected Copies

The contents of % Copies Complete column is calculated by
using the following formula:

Copies Completed / Total Expected Copies * 100

This column is mandatory and cannot be removed when you
edit the report.

Expected aggregate size of all copies for SLP and the specific
SLP destination that are present in the OpsCenter database.
This column is mandatory and cannot be removed when you
edit the report. The column contents are calculated by using
the following formula:

Total Expected Size for all copies = (Number of copies) *
(backup copy size)

Note: The total expected size for all copies is a front-end
size and is derived from the number of copies multiplied by
the size of backup copy. The effects of deduplication,
compression, or optimized deduplication on the Total
Expected Size — all copies are not considered in the SLP
reports.

Aggregate size of all the completed copies in the
OpsCenter database for the SLP and the specific SLP
destination. You can remove this column when you edit the
report.

Note: The Completed Copy Size is a front-end size. The
effects of deduplication, compression, or optimized
deduplication on completed copy size are not considered in
the SLP reports.
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Percentage of completed copy size for the SLP and the
specific SLP destination. This column is mandatory and
cannot be removed when you edit the report.

The data for this column is calculated from the following
columns of the SLP Status by Destinations report:

= Completed Copy Size
» Total Expected Size — all copies

The contents of Completed Copy Size (%) column is
calculated by using the following formula:

Completed Copy Size / Total Expected Size — all copies *
100

Aggregate size of all remaining copies that are to be created
for the SLP and the Size (MB) specific SLP destination. This
column is mandatory and cannot be removed when you edit
the report. The data for this column is calculated in the
following manner:

(Remaining Copy Count) x (Size of Backup Copy1)

Note: The remaining copy size is a front-end size and is
derived from the number of remaining copies multiplied by
the size of backup copy 1. The effects of deduplication,
compression, or optimized deduplication on remaining copy
size are not considered in the SLP reports.

You can use filters to view specific data in the SLP Status by Image Copy report.
The following filters are available when you edit the SLP Status by Image Copy

report:

View

Primary Server

Storage Lifecycle Policy

Select a particular view to see data for the
selected view.

Select one or more primary servers to see
data for the selected primary servers.

You can select the following columns:

= Replication to Remote Primary: If the
value is Yes, then SLP’s that duplicate
across primary servers are displayed.

= Operation: Select one or more operations
that you want to view

»  SLP name: Select one or more SLP’s that
you want to view.
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The default timeframe for this report is based on what timeframe is selected for the
top-level report.

SLP Duplication Progress report

The SLP Duplication Progress report is available as a drill-down report from the
SLP Status by SLP report. You can view the SLP Duplication Progress report when
you click the SLP version (link) in the SLP Status by SLP report.

The SLP Duplication Progress report is a graphical report that shows how the image
copies are created for an SLP on a specific primary server. This indicates how
duplications are progressing for an SLP on a specific primary server.

The SLP Duplication Progress report is in a bar chart format and shows the following
data for each axis:

= X axis shows all duplication destinations that are associated with the SLP
= Y1 axis bar charts show the percentage of images that are completed

= Y2 axis shows how many images are created.

Note: The SLP Duplication Progress report shows data for only one primary server
where that SLP version is running.

You can also view the report data in a tabular format. To view the report details in
a tabular format, click the link Show Chart as Table at the bottom of the report.

You can edit the report to view specific data in the report. You can also save this
report for reference.

You can use filters to view specific data in the SLP Duplication Progress report.
The following filters are available when you edit the SLP Duplication Progress report:
View Select a particular view to see data for the selected view.

Primary Server Select one or more primary servers to see data for the
selected primary servers.

Storage Lifecycle Policy Select an SLP to see data for the selected SLP. You can
select only one SLP.

The default timeframe for this report is based on what timeframe is selected for the
top-level report.
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Limitations of SLP reports

The data that is shown in the SLP reports is collected primarily from the EMM
worklist and also from the NetBackup catalog. Hence it is important to understand
how the EMM worklist functions. The functionality of the EMM worklist affects the
data that is displayed in the SLP reports.

The following sections provide an insight on SLP and EMM functionality and also
list some limitations that are associated with the SLP reports.

About storage lifecycle policy retention

While creating a storage lifecycle policy in NetBackup, you can specify the
destinations where copies should be created. For an SLP, an image can be written
to the initial destination as part of the following operations:

m  Backup
= Import

You can define the Retention type for each SLP destination. You can select many
retention types like Fixed (1, 2, 3 weeks), Expire after Copy, Staged capacity
managed etc. The following table explains the meaning of Fixed and Expire after
Copy retention types:

Fixed Fixed retention type means that the backup
data is retained for a specific length of time
before the backups are expired. When the
retention period is reached, NetBackup
deletes information about the expired backup.

Expire after Copy Expire after Copy retention type means that
the image expires after the dependent
duplication is complete.

When you are creating a NetBackup policy, the SLP that you created (like SLP1)
can be selected as Policy Storage (storage unit). The SLP (SLP1) is executed when
the policy runs.

About data collection from EMM
The SLP1 performs the following operations:

data that is shown in the SLP reports is collected from the EMM worklist and the
NetBackup catalog. The worklist is located in the EMM and contains metadata like
how many copies need to be created, where they need to be created, when they
are completed etc. In general, the copy data that is shown in the SLP reports (like
Copies Completed, Completed Copy Size columns etc.) is based on the EMM
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worklist. EMM creates the worklist after a backup is complete based on lifecycle
configuration parameters.

Consider a case when you configure an SLP named SLP1:
= Backup (Stu1)

= Duplication (Stu2)

= Duplication (Stu3)

After the backup is complete, a worklist that contains an entry for each copy is
created in the EMM database. In this example, the EMM worklist has three copy
entries (corresponding to the number of copies that are defined in the SLP). The
EMM worklist is updated as and when a duplication job is processed (for example,
State for the copy changes from Not Started to In Process to Complete).

SLP reporting limitations
OpsCenter collects data for SLP reports in the following phases:

Table 2-1 SLP data collection

Serial No. Phase Description

1. Initial Data Collection When a NetBackup 7.1 or
later primary server is added
to the OpsCenter console,
OpsCenter Server initially
collects all data from the EMM
worklist.

2. Periodic Data Collection After the initial data load,
OpsCenter collects only the
changed data after every 10
minutes.

OpsCenter depends on the EMM worklist for SLP reporting. The following EMM
behavior affects the data that is shown in the SLP reports:

= If the Retention type of the SLP destination is Expire after Copy, then EMM
deletes the copy entry from the EMM worklist after duplication is complete. This
behavior affects the initial data collection and periodic data collection for SLP
reports.
See “Issues associated with initial data collection” on page 324.
See “Issues associated with periodic data collection” on page 325.

= Ifthe Retention type of the SLP destination is Fixed, then EMM deletes the copy
entry based on the Retention period that is specified in the policy. This behavior
affects the initial data collection and periodic data collection for SLP reports.

323



OpsCenter reports
About Report Templates descriptions

See “Issues associated with initial data collection” on page 324.
See “Issues associated with periodic data collection” on page 325.

= Ifthe SLP images reside on a tape drive, then EMM deletes the copy entry when
the particular SLP is complete. This behavior affects the initial data collection
and periodic data collection for SLP reports.
See “Issues associated with initial data collection” on page 324.
See “Issues associated with periodic data collection” on page 325.

= If you cancel an SLP that is in progress, then all the copy entries that are
associated with this SLP image are deleted from the EMM worklist. This behavior
affects the periodic data collection for SLP reports.
See “Issues associated with periodic data collection” on page 325.

Issues associated with initial data collection

For initial data collection, the following potential issues can be seen in SLP reports
due to the EMM behavior.

Since initial data collection loads all the data from the EMM, it may have an image
entry with missing copy entries. It is possible that the copy entries in the EMM
worklist are deleted due to the following factors:

= If the Retention type of an SLP destination is Expire after Copy or Fixed.
» If duplications happen on a tape drive

The deletion of copies has the following affect on the data that is shown in specific
SLP reports:

= The SLP Duplication Progress report is in a bar chart format. The X axis shows
all duplication destinations associated with the SLP; Y1 axis bar charts show
the percentage of images completed (% Images Count) and Y2 axis shows
how many images are actually created (Completed Images Count).
If a backup copy is deleted from the EMM worklist, then this report may show
that the backup copy count is less than the duplication count. This is misleading.
It is expected that when an SLP is complete, same number of copies should be
created on all the destinations. Similarly the % Size Completed computation is
inaccurate for this report.

= If a backup copy entry is deleted from the EMM worklist, the SLP Duplication
Progress report will not show the backup bar chart. Similarly, if a duplication
copy entry is deleted, the Duplication Progress report will not show the duplication
bar chart.

= The SLP Status by Destination report will show incorrect copy sizes across
destinations. The following columns of the SLP Status by Destination report
show incorrect data:
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= Total Expected Size — all copies (MB)
= Completed Copy Size (MB)

Issues associated with periodic data collection

When OpsCenter collects data periodically after every 10 minutes, the following
potential problems can be seen in SLP reports.

Consider a scenario when OpsCenter has collected the data for all copies associated
with SLP1 which is in progress. However, before the next data collection happens
one of the copy entries is removed from the EMM worklist (due to the EMM
behavior). In this scenario, OpsCenter marks such copy entries as Complete if the
image is SLP-complete during the next data collection cycle.

In this example scenario, you may see the following issues:

» For all such copies that OpsCenter marks complete, the SLP Status by Image
Copy report does not show any value for the Lag Time and the Copy End Time.

= [f the last copy entry for an SLP is removed from the EMM worklist (due to EMM
behavior), then the SLP Completion Time that is shown in the SLP Status by
Image report is inaccurate.

Note: The same issues are seen if you cancel an SLP that is in progress (like
SLP1). These issues occur because all the copy entries associated with this SLP
image are deleted from the EMM worklist.

Known Issues with SLP reports
The following known issues are associated with the SLP reports:

= When there are multiple copies in an SLP and two or more copies share the
same destination, then only one-bar chart is shown for such copies in the SLP
Duplication Progress report.

= The size of image copies for which Import is in a Not Started state, is not
considered. Because of this behavior, the sLp status, SLP Status by SLP, SLP
Status by Client reports may display Completed Copy Size % as 100% while
in reality there may be image copies for which the Import operation is in a Not
Started state.

= Ifthe Importis in a Not Started state for some image copies, the SLP Status by
Destination report may show two rows for the same storage destination. This
data is shown because there is insufficient data for image copies for which
Import is in a Not Started state. The additional row is not shown once the Import
operation is complete for all image copies.
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About Workload Analyzer reports in OpsCenter

This section provides descriptions on the Workload Report Templates available in
OpsCenter. The reports are in a graphical format and provide details on the overall
past, current, and projected workload of your NetBackup environment including job
counts, sizes, throughput, and scheduled job queues.

Workload Analyzer report

The Workload Analyzer is a report that gives information about the activities that
are done across a period of seven days. The activities are number of jobs running
at a given period of time and the amount of data that is transferred during this period.
The report contains 168 data points of analysis in terms of the activities that are
done for each hour for a period of seven days.

The report is comprised of four reports that are based on time, data transfer, job
queue, and job throughput. Time is the point from when the jobs start, the periods
for which the jobs are active, and the point when the jobs end. Job queue is based
on the length of time, a job is in queue before the job is initiated. Job size is the
amount of data that is moved from the target to the destination depending on the
job type. Job size is also based on how much data is broken down and moved in
a given hour. Job throughput is based on the data transmission rate.

The Workload Analyzer reports consider only the jobs done for calculating and
generating the report. The calculation can result in a difference in data for the current
hour and date. For example, a job that started in the past, and is in the queued
state for a long time is not considered in the job queue report. It is considered only
when it is complete.

See “Workload Analyzer subreports: Job Count, Size, Queue, and Throughput”
on page 326.

See “Generating a Workload Analyzer report” on page 331.

Workload Analyzer subreports: Job Count, Size, Queue,
and Throughput

The Workload Analyzer reports are based on time, queue, size, and throughput.
The following reports are a part of the Workload Analyzer report:

= Job Count Workload Analyzer: This report is based on the number of jobs
running at a given period of time. The purpose of this report is to display the
data that is based on time and load. You can determine the time for the job
count on the basis of the start and end time of the job. Data for load is determined
based on how many jobs are active during a given period of time. Calculations
are done to determine the number of jobs that are active during a given period
of time.
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For example, the following figure displays the job counts for a given period of
time. (A) shows the jobs that start before the time interval and end after the time
interval. (B) shows the jobs that start before the time interval and end during
the time interval. (C) shows the jobs that start and end during the time interval.
(D) shows the jobs that start during the time interval and end after the time
interval.
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Job Size Workload Analyzer: This report is based on the amount of data that
is transferred during a given period of time. The calculation is based on the total
amount of data that is backed up by the jobs divided by the time period.

For example, in the following figure there are four jobs that have different
durations across a four hour time period. The left-hand side displays the amount
of data that's transferred during the four hour time period. The right-hand side
of the report displays the start time and end time for each job, amount of data
transferred, and duration. Job A is active for a period of four hours, it starts at
1:20 P.M. and ends at 4:20 P.M. During that period the total data that is
transferred is 80,000 MB. You can calculate data transfer rate, multiply data
transfer rate by the number of minutes during each hour when there is job activity.
Job activity in the first hour is 20 minutes, in the second and third hour it is 60
minutes, and fourth hour it is 20 minutes. Jobs B, C, and D follow a similar
pattern. Load is the sum of loads of all jobs during that hour. The yellow slot
shows maximum activity and the data that is transferred is 115960 KB.

Job Queue Workload Analyzer: This report is based on the period for which,
jobs are in a queue state before data back up begins. Queue time is calculated
through the use of timestamps such as time taken to initiate the job, time taken
to start and end the job. Jobs that have a high queue time are identified to reduce
scenarios where many jobs with high queue time are initiated at the same time.
The queuing is calculated at individual job level and then aggregated to the level
where the report is generated.
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Job Throughput Workload Analyzer: This report is based on the rate in
Mbytes\Sec at which the data is transferred This calculation provides an important
indicator to understand the performance. The throughput report is based on
cross-hour calculation. The report displays accurate analysis of the data.
Compared to the other workload reports, the totals for the rows of this report
are averaged.

The Start Write time ensures that the speed is only measured against the time
in which, the actual data transfer takes place. This calculation ensures that the
queue time is not considered. The queue report calculates the queue time. In
the following figure, the throughput is calculated across four jobs that span for
a period of three hours. One job belongs to Policy B and three jobs belong to
Policy A. The green boxes indicate the time in which the write job occurs.

Workload Analyzer report template options

The Workload Analyzer report template is a pre-fixed 168 hour reporting template.
The template makes extensive use of color to display the analyzed data through
the heat map technology. You can configure the color range. Report categories
that include attributes such as backup server, media server, client, policy, provide

ag
tha

ood means to understand the basics of workload and performance. All the reports
t comprise the workload analyzer report template are based on time. The following

figure is a sample report template.

Job Count Workload Analyzer

@ Previous Week Mext Week E]
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The highlights of the workload analyzer report template are as follows:

You can hover the mouse on each cell in the report to get details such as date,
time, hour, and actual value of the hour.
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You can configure the range for each color. The color depicts the density of the
jobs running at that hour. It also displays the number of minutes of queue time,
the amount of data transferred, and the throughput rate. The deeper the color
of the cell, the higher is the value in the cell.

You can use the Report on feature to select entities for which, you require the
data. For example, if you select Report on for a primary server, the second
column in the report displays data for the primary server only. The entities include
Backup Server, Media Server, Backup Client, Policy, Policy Type, Schedule,
Job Type, Job Level, Job Error Code, Exit Status, Job Exit Code, Job
Transport Type, Schedule\Level Type, and Storage Unit.

You can drill down to the next level in the report. The second column is hyper
linked and provides the drill-down option. For example, from the primary server
you can drill down to client. A drill-down report is launched. You can drill down
to clients from the media server, policy, policy schedule, schedule, job type, job
error code, job status, job level, transport type. Other drill-down options are
policy type to policy, job status to job error code, view to next level down the
view hierarchy.

The last row on the report shows the total values of all the rows for the entire
time span. The first column shows data for the entire week, whereas the hour
column shows data for that particular hour for all entities.

You can use various filters in the report. The filters include:

Filter type Description

Time Filter Filter on Absolute or Relative time filter
View Filter on any view.

Primary Server, media server Filter on available primary servers and

media servers.

Client Filter on available client.

Policy Filter on name and type of policy.
Schedule Filter on schedules

Job Filter on status, status code, transport type,

type, and schedule or level type.
Storage unit Filter on the name.

Workload Filter on duration threshold and time basis.
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You can use the Report on feature for different variables. The variables include
Backup Server, Media Server, Backup Client, Policy, Policy Type, Schedule,
Job Type, Job Level, Job Error Code, and Storage Unit.

You can drill down on any cell to know the details about the data.

The following drill-down options are available for all the Workload Analyzer reports.

Primary Server to Client

Media server to Client

Policy Type to Policy

Policy to Client

Policy ScheduletoClient

Schedule to Client

Job Type to Client

Job Error Code to Client

Job Status to Client (when Job Status <> Failure)
Job Status to Job Error Code (when Job Status = Failure)
Job Level to Client

Transport Type to Client

View to Next level down the view hierarchy

The colors in the report represent different data values, the information is available
in the following table.

Table 2-2 Color range values
Color range Value
Idle Displays the cells that are gray, which means there are no active

jobs assigned.

1-10 Displays value for the data that has the color range between 1 -

10, the light yellow cells represent these values.

11-50 Displays value for the data that has the color range between 11

- 50, the dark yellow cells represent these values.

51-100 Displays value for the data that has the color range between 51

- 100, the orange cells represent these values.
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Color range values (continued)

Color range

Value

More than 100

Displays the value for data that has the color range that is greater
than 100, the red cells represent these values.

See “Workload Analyzer subreports: Job Count, Size, Queue, and Throughput”

on page 326.

Generating a Workload Analyzer report

You can generate the Workload Analyzer report using the Workload Analyzer report
template from the reports tree. The report comprises of four reports that are based
on time, data transfer, queue time, and throughput speed.

To generate the workload analyzer report

1 Inthe OpsCenter console, click Reports.

2 Onthe Reports Template tab, click Create New Report. The reports are also
available under the reports tree as shown in the following figure

Client Reports
Cloud Reporis

Deduplication Repors
Disk & Tape Device Activity Reports
Media Repors

Performance Reports

Palicy Repons

Reslore Repors

Storage Lifecycle Policy Reports

Workoad Analyzer Reports

Description
Protection status of all MetBackup Clients (physical and vrtual) with Bare Metal Recovery (BMR) status.

NesBackup cloud storage status including storage forecasting, throughput perdormance, and chargeback
costs

NetBackup deduplication storage Including deduplication rates and storage space saved

NetBackup disk, tape, and SAN Client storage unit ulilization and free space available.

MetBackup media satus, expiration, and availability, including tape, disk. Appliances, and MetBackup Vault
Reporting for averall perormance and throughput statistics on NetBackup Master and Media Servers
Repoding for NetBackup Policy i including Policies ing e most starage space

Repodting for all MatBackup restars and recovery oparations
MetBackup Storage Lifecycle Palicies (SLP'sjand NetBackup Auto Image Replication (AIR) status
Heat map reporting on the averall past, current, and projected workload of your NetBackup environment

A graphical report showing workload based on job counts across a week This report is valid for NetBackup
and Appliances.

A graphical report showing workload based on job size acress a week. This repor is valid for NetBackup and
Appliances

A graphical report showing workload based on job queuing across a week This repart is valid for NetBackup
and Appliances.

A graphical report showing workload based on job throughput across a wesk. This repart is valid for

MasRackin and onliancas

3 On the Report Wizard, retain the default selection Create a report using an
existng report templateand click Next.

4 From the Select Report Template list, select the Workload Analyzer report
you want to create and click Next.
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5 Select the time frame from the Relative TimeFrame (beginning at) or Absolute
TimeFrame (beginning at) options.

The Timeframe option displays the output for seven days for the previous week
or the next week. The Relative Timeframe option also displays data from the
date you choose, it can also be from the middle of a week. Absolute Timeframe
displays data for a week for the date you select. For example, if you select
today's date, the data that is displayed is for the next week including today's
date. The selection is for a week and there is no end time provided for selection.

Select the required filters and click Next.
View the report and click Next.

Enter a name and description in the Report name and Description text boxes.
Select the location and click Save to save the report.

Note: Open the saved report. Use the options Previous Week and Next Week
to view data for the previous seven days or next seven days.

About exporting and emailing the Workload Analyzer report

The Workload Analyzer report can be exported in the HTML format. You can set
the export location through the Report Export Location tab.

The report can be emailed only in the HTML format.

Note: When the Workload Analyzer report is emailed for Outlook Express, it does
not show the correct alignment of the cells of the report.
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This chapter includes the following topics:
= Creating a custom report in OpsCenter

= Creating an OpsCenter report using SQL query

Creating a custom report in OpsCenter

In addition to using the reports that come by default with OpsCenter, you can use
the Custom Report Wizard to create custom reports that are unique to your
installation.

After creating a custom report, you can modify the report, print, save, and email it.

As you work with different report categories, the Report Wizard displays different
parameters. Many of the parameters are used for multiple report categories, and
they appear in different combinations for each type.

You can create a custom report by using the parameters that are available in the
Custom Report Wizard.

See “About Custom Report Wizard parameters” on page 339.

To create a custom report

1 Inthe OpsCenter console, click Reports > Report Templates.
2 Click Create New Report.

3 Onthe Select Report Creation Option page, click Create a Custom Report
to start the Custom Report Wizard.
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Select a report category from the Category drop-down list:

Backup/Recovery Select this category to create reports on jobs, disk pool, logs,
image, media, tape drive etc.

The Subcategories appear as per what you select from the Category drop-down
list. From the Subcategory drop-down list, select one of the following report
subcategories:

The following subcategories appear when you select Backup/Recovery as the
main category:

Disk Pool Select to view a consolidated report related to disk pool.

Job/Image/Media/Disk Select to view job, image, media, or disk data. The
reports based on this subcategory provide a
consolidated view of job, image, media, and disk. For
example, you can create a custom report that tells the
number of images per job type or a tabular report that
tells which image is backed up on which media.

You can also view the backups that are taken on the
disk.

Log Select to view logs that are generated as a result of
backup and recovery activity in NetBackup.

Media Select to view reports on media like tape media etc.

Tape Drive Select to view reports on tape drives. This subcategory
does not show reports related to media servers.The
associated filter parameters, such as Tape Drive Device
Host or Tape Drive Type appear.

Scheduled Jobs Generate reports on Scheduled Jobs using this
category. For example you can create a report that
compares the scheduled time and the actual time for
scheduled jobs.
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Select a report format from the following formats in the View Type drop-down
list:

Distribution Display groupings or objects or resources in a pie chart.

Ranking Display a horizontal bar graph showing all the data for each view
level object, from greatest to the least, within the selected time
frame.

Historical Display a stacked (segmented) bar graph with a trendline

superimposed over it showing the average upward and downward
trends of the data over time.

Tabular Display data in the form of a table.

Click Next.

In the Select Parameters panel of the Custom Report Wizard, select values
for one or more report parameters. The report parameters that appear depend
on the report category and the view type that you selected.

See “Configuring timeframe parameters” on page 339.
See “About Custom Report Wizard parameters” on page 339.

As you select parameters, the Content pane may refresh to display additional
selections. For example, when you select a view filter, you are then given a
choice of items on which to filter the report display.

Click Next.

In the Modify Display Options panel, define the measurements to be collected
for historical, ranking, tabular, and distribution reports. Different display options
are displayed for different view types.

See “About display options” on page 342.
Click Next.

In the View Report Data panel, you can view the report that is created as per
your selection.

Click Next.

To return to the Custom Report Wizard and make changes to the report, click
Back.

Save the report. Enter a report name, a description (optional), and location
where you want to save the report.

Click Save.
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Example 1: You may want to create a custom report based on your specific
requirements. For example, you may want to create a daily status report of the
clients that are backed up everyday.

This report gives the detailed tabular information of the jobs directory being backed
up, its status (if it's successful, partially successful or failed), Level Type
(Incremental, Full, Differential Incremental), the job file count and job size in the
datacenter . You can enhance this report by adding more available columns based
on the report requirement.

See the procedure to know how you can create a daily status report of the clients
that are backed up everyday.

To create a daily status report of the clients that are backed up everyday
1 Inthe OpsCenter console, click Reports.
2 On the Report Templates tab, click Create New Report.

3 On the Report Wizard, select the Create a custom report option and click
Next.

4 Select the Report Category as Backup/Recovery and the Subcategory as
Job/lImages/Media/Disk.

5 Select the Report View type as Tabular.
Click Next.
Select the appropriate timeframe for which you want to view the data.

Select the Job filter. Select the Column as Backup Job data type, Operator
as =, and Value as Yes. Click Add.

Click Next.

Under Tabular Report Properties, select the Time Basis as Job End Time.
Change the Display Unit as per your requirement.

10 Select Available columns from the list that appears:
= Backup Job File Count
= Backup Job Size
= Job Directory
= Job End Time
= Job Start Time
= Job Status
= Job Status Code
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= Job Type

= Primary Server

= Schedule Name

= Schedule/Level Type
Click Add.

Click Next to run the report.

Example 2: You may want to create a report that examines the number of tapes
in each status category and its percentage.

To report on the distribution of tape status in your environment

1
2
3

9

In the OpsCenter console, click Reports.
On the Report Templates tab, click Create New Report.

On the Report Wizard, select the Create a custom report option and click
Next.

Select the Report Category as Backup/Recovery and the Subcategory as
Media.

Select the Report View type as Distribution.
Click Next.

Select the appropriate timeframe for which you want to view the data. You can
also select No Time Basis.

Optionally, select any filters based on your requirement.
Click Next.

In the Distribution Chart Properties section, make the following selections:

Chart Type Pie Chart
Report On Media History Status
Report Data Media ID
Count
Click Next.

Example 3: You may want to create a custom tabular report that shows the following
information:

Know what jobs were successful in the past week for a specific primary server
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= Show the amount of time the backup took

= Show how large the backup was

To create a report showing successful backup job details for a primary server
1 Inthe OpsCenter console, click Reports.

2 On the Report Templates tab, click Create New Report.

3 On the Report Wizard, select the Create a custom report option and click
Next.

4 Select the Report Category as Backup/Recovery and the Subcategory as
Job/Image/Media/Disk.

Select the Report View type as Tabular.
Change Relative Time Frame to Previous 1 Week

Under Filters, select Job. In the Column area, select Job Type, select the =
Operator and choose a value of Backup.

Click Add.

8 Back under the Column heading, select Job Status leave the Operator at “="
and choose Successful as the value

Click Add.
9 Click Next.
10 Select the Time Basis as Job Start Time

11 You may change the Display Unit or Time Duration. For example if the primary
server takes smaller backups, then you may change the Display Unit to MB.

12 From the Available Columns list, select the following:
= Backup Job Size
= Client Name
= Job Duration
Click Add to move them under the Selected Columns area.

13 In the Selected Column area, perform the following operations for each of the
rows:

= Click the check box next to Client Name on the right and click Move Up
to make it the first row.

= On the Job Duration row, change Operation to Total.
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= On the Job Size row, change Sort Order to Descending and Operation to
Total.

14 Click Next.

About Custom Report Wizard parameters

The Custom Report Wizard displays a set of parameters that varies depending on
the report type. The following topics describe all the available parameters:

n Define Time frame parameters
See “Configuring timeframe parameters” on page 339.

= About display options
See “About display options” on page 342.

= Report conditions
See “Defining report conditions” on page 346.

n Filter parameters
See “Selecting and using filter parameters” on page 341.

Configuring timeframe parameters

You use the Time Frame parameters to define the report’s overall time frame and
the intervals for which data is reported.

You can specify absolute or relative time frame for a report.

You can select the following timeframe parameters:

Relative Timeframe Select Previous or Next from the drop-down list (wherever
applicable), and then specify the number of hours, days, weeks,
months, quarters, or years to define the period. The report displays
data collected within the specified time period, for example, data
of the previous 3 months.

The Relative Timeframe is especially useful for reports that you
plan to generate on a regular basis. Such reports always show data
collected over the most recent time interval.
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Start from the This applies only to Relative time frames. In Start from the beginning
beginning of <selected of <selected unit>, the <selected unit>may stand for Hours, Days,
unit> Weeks, Months, Quarters, or Years depending on what unit you

select as a Relative Timeframe.

If you specify a relative timeframe and check Start from the
beginning of <selected unit>, the Relative timeframe is calculated
starting from the first day for week, month, quarter, or year selection,
from 12 A.M. for day selection, and from the earliest whole number
(no minutes or seconds) for hour selection. Do not select the Start
from the beginning of <unit> check box if you want to view data
for the entire period specified in Relative Timeframe.

Examples:

= The current date is June 13, 2010. If you select the Relative
Timeframe as Previous 1 Month and do not select the Start
from the beginning of Month check box, the report shows
data from May 14, 2010 to June 13, 2010. However if you select
the Start from the beginning of Month check box, the report
shows data from June 1, 2010 to June 13, 2010.

= The current date and time is September 13, 10:30 PM. If you
select the Relative Timeframe as Previous 2 Days and do not
select the Start from the beginning of Days check box, the
report shows data from September 11, 10:30 P.M. to September
13, 10:30 P.M. However if you select the Start from the
beginning of Days check box, the report shows data from
September 12, 12 A.M. to September 13, 10:30 P.M.

= The current time is 4:25 P.M. If you select the Relative
Timeframe as Previous 2 Hours and do not select the Start
from the beginning of Hour check box, the report shows data
from 2:25 P.M. to 4:25 P.M. However if you select the Start
from the beginning of Hours check box, the report shows data
from 3 P.M. to 4:25 P.M.

Note: If you specify relative time frame and check Start from
the beginning of <selected unit>, the report is configured to
display data collected over the interval ending at the current
date. This is effectively equivalent to specifying an absolute time
frame; the report’s contents remain static whenever you display
it.

Absolute Timeframe Define the beginning and end of the time interval to be covered by
the report. When you enter absolute dates, the report’s contents
remain static whenever you display it.
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This applies only to Absolute timeframes. Check this option to view
all the data on and before the To date that you enter in the Absolute
timeframe.

Example: Suppose you specify an absolute timframe: From March
1, 2004, 12:00 A.M. to April 30, 2004, 12:00 A.M. The report
displays data from the time period between the start and end dates.
Now if you check Ignore From Date, the report ignores the From
Date and displays all data before April 30, 2004, 12:00 A.M.

This applies only to Absolute timeframes. Check this option to view
all data on and after the From date that you enter in the Absolute
timeframe.

Example: Suppose you specify an absolute timframe: From March
1, 2004, 12:00 A.M. to April 30, 2004, 12:00 A.M. The report
displays data from the time period between the start and end dates.
Now if you check IgnoreTo Date, the report ignores the To Date
and displays all data on and after March 1, 2004, 12:00 A.M.

This signifies that the data shown should not be grouped with time.
The report includes all the data in the OpsCenter database
irrespective of time. The timeframe grouping is not applicable.

Day Window is applicable when you specify an Absolute or Relative
timeframe. From the Day Window, you can specify the time interval
that constitutes one day. Select values from the From and To
drop-down lists.

Example: 6:00 PM to 6:00 AM
Example: 12:00 AM (midnight) to 12:00 PM (noon)

This option appears only when you select a Historical view type.

Select the time interval by which you want to group the records.
For example, if you selected 1 month as the Report Time Frame
and 10 days as the Group By interval, the report shows records in
three chunks of data grouped by 10 days.

Selecting and using filter parameters

You can use filter parameters to obtain additional filtering capability for the report
that you want to display. For example depending on the category or subcategory
that you select, you may filter on the following:

= Client Operating System

» Client is Active
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= Policy Active: Select Yes to view policies that are active. Select No to view
policies that are not active.

s Media is On Hold column has been added under the Media filter.

= Image is on hold and Image Copy is on hold columns have been added under
the Image filter.

To specify additional filtering criteria

1 On the Custom Reports Wizard, select a report category, subcategory and
view type. Click Next.

2 On the Select Parameters panel, the respective filters appear in the Filters
section.

The list of filters that appear depend on the report category and view type that
you select.

3 Click the filter that you want to use, and then specify one or more values using
the fields provided.

About display options

Use the Modify Display Options panel to define the measurements to be collected
for historical, ranking, tabular, and distribution reports. Different display options are
displayed for different view types.

About Historical view display options

The following display options are available for historical reports. The following
parameters are displayed:

Report On Define the report’s scope using the drop-down list. This field denotes
the entity on which grouping is required. For example, when you
select the Report On parameter as Client, the Y-axis report data is
grouped per client.

Example: Job Status, Image type etc.

Description Description to display along with the report. If you leave this field
blank, no description is provided by default.

X-Axis

Display Name For Historical reports, a label for the horizontal (X) axis. If you leave
this field blank, a default label is provided.
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The metric used to define the graph’s horizontal (X) axis.
Examples: Attempt End Time, Client Name

If you choose a Report Data parameter like Client Name which is
not time-based, another parameter called Time Basis appears.

This parameter appears if you select a Report Data parameter like
Client Name that is not related to time. Time Basis resembles the
time attribute on which time filter is applied as criteria. This attribute
is not shown if you select No Time Basis while configuring the
timeframe in the Wizard. Time Basis is the metric used for assigning
a time to each item in the report, if not specified by the Report Data
parameter.

Example: The start time or the end time for each backup job.

For Historical reports, a label for the horizontal (Y1 or Y2) axis. If
you leave this field blank, a default label is provided.

For Historical reports, the metric used to define the graph’s vertical
(Y1 or Y2) axis.

Examples: Job Size, Status Code etc.

For numeric data types, such as Job Size, the units in which to
display the data. This is applicable only for size-related attributes
like Job size, image size, fragment size etc.

Examples: MB, GB.

The report format. Additional formats may be available depending
on the values specified in Report Data.

Use the Trendline and Forecast parameters to project future trends
by averaging actual data from the recent past. Check Show
forecast with forecast periods, and use the drop-down list to
specify a number of forecast periods (intervals). This displays a
forecast line extending to future dates, using linear regression to
predict values based on the trend of data within the report’s time
frame.

Example: 12 shows forecast data for the next 12 months (if the
Time Frame Group By is 1 month).

The following Web site helps in calculating the forecast:

http://easycalculation.com/statistics/regression.php
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Use the Trendline parameter to indicate a general pattern or
direction by averaging actual data from the recent past. Check
Show trendline with moving average, and use the drop-down
list to specify the number of data points to factor into the average.
At each interval on the graph, the trendline shows a moving average
of the most recent data points.

Example: 3 displays a trendline that, at each interval, shows the
average of the current data point and the two previous data points.

For Historical reports, select the Target Performance checkbox
and then either Y1 or Y2-Axis radio button. Type a value in the text
box to include a target level or threshold in the report display. The
target value appears as a horizontal line, useful for making quick
visual comparisons between the target value and the actual values
being reported.

About Ranking chart display options

The following display options are available for Ranking reports. The following
parameters are displayed:

Chart Type  Select Bar Chart from the drop-down list.

Report On Select the entity that you want to see in the report like Image Type.

Display Select how many rankings you want to see and how you want them arranged
(in Ascending or descending order).

Y-Axis Enter a label for the Y-Axis.

Display
Name

Report Data This is the data that should be plotted on the Y-axis.

Time Basis  Metric used for assigning a time to each item in the report, if not specified
by the Report Data parameter.

Example: The start time or the end time for each backup job.

Description  Description to display along with the report. If you leave this field blank, no
description is provided by default.

About Distribution chart display options

The following display options are available for Distribution reports:

Chart Type

Select Pie Chart from the drop-down list.
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Report On Select the entity that you want to see in the report like Attempt
Status.

Report Data This is the data that should be plotted on the pie chart.

Time Basis Metric used for assigning a time to each item in the report, if not

specified by the Report Data parameter.

Example: The start time or the end time for each backup job.

Description Description to display along with the report. If you leave this field
blank, no description is provided by default.

About Tabular display options

Use the Modify Display Options panel to establish the column titles for a tabular
report.

The following display options appear for a tabular report:

Time Basis  From the Time Basis drop-down list, select a time basis like Job End Time
or Job Start Time.

Time Basis is used to assign a time to each item in the report.
Description  Enter a description for the report. This is optional.

Display Unit  From the Display Unit drop-down list, select one of the following units:

= B

= KB
= MB
= GB
= 1B

Time From the Time Duration drop-down list, select one of the following time
Duration intervals:

= Seconds

=  Minutes

s Hours

s Days

s Weeks

= Months

= Years
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Available From the Available Columns list, select one or more values for table columns,
Columns for example, Client Name, Status, Job Group ID.
Click Add.

The columns selected from the Available Columns list are added to the
Selected Columns, which you can rearrange as you want them to be
displayed on reports.

Selected The columns selected from the Available Columns list are added to the
Columns Selected Columns, which you can rearrange as you want them to be

displayed on reports using the following controls:

= Sort order

= Operation

= Move Up

= Move Down

= Remove

All the columns from the Selected Columns list are displayed in the report.

Rows per From the Rows Per Page drop-down list, select number of rows of records
page that you want to display on one report page.
Display When you select this option, all duplicate rows are replaced by a single row

unique rows in the report and only distinct records are shown. Duplicate rows generally
in the report appear if the rows do not have a unique ID.

Defining report conditions

In the Conditions section of the Modify Display Options panel, specify exception
conditions for notification. Exception conditions represent potential problems, for
example an unusually high percentage of backup job failures or an unusually low
quantity of data being backed up. Each condition is defined by assigning threshold
values for a particular metric, such as Success Rate or Total Backup Job Size. You
can set a low threshold, a high threshold, or both. The conditions are applicable
only for numeric values like Job Size (and not for values like Job Type, Primary
Server). You can apply condition for attributes like Job type or Primary server
provided you have applied a function like Count, Distinct Count etc. on it.

After you specify your conditions, you can create a report schedule so that when a
condition is true, an email notification is sent or the report is exported, or both. The
conditions are applied only when a report is scheduled.

Creating an OpsCenter report using SQL query

This section provides the procedure to create a report using SQL query.



Custom reports in OpsCenter Analytics | 347
Creating an OpsCenter report using SQL query

Only OpsCenter Analytics users can access the custom SQL query function.

See “About custom SQL query in OpsCenter Analytics” on page 11.

Note: OpsCenter provides detailed information about the OpsCenter database
schema that you may want to know before running any SQL query to generate
reports. On the Report Wizard > SQL Query page, click the following link to open
the PDF that contains all relevant information: Refer to the OpsCenter Database
Schema Document

Note: OpsCenter Reporter and Restore Operator do not have access to the custom
SQL query option.

To create a report using SQL query
1 Inthe OpsCenter console, click Reports.
2 On the Report Templates tab, click Create New Report.

3 On the Report Wizard, select the Create a report using SQL Query option
and click Next.

4 On the SQL Query page, enter an SQL query to view the required data.

For example, to view all NetBackup primary servers that monitored and
managed by OpsCenter, enter the following SQL query: select * from
domain_primarieserver

5 Click Next.

You can view all primary server details that are stored in the
domain_primarieserver database table.

Note: When you run a stored procedure that has multiple result sets, then
output of only the first result set is displayed on the GUI. The output of other
result sets is not shown on the GUI.

Note that OpsCenter stores most of the time fields in Gregorian. If you want to see
the value for a given Gregorian date field in a timezone that is configured on the
OpsCenter host, you should use utcbiginttonomtime(gregorianDatefield) function,
where gregorianDatefield is any time value in gregorian. The function
utcbiginttonomtime function cannot consider DST time offset. Hence it ignores
any DST offset while showing the date and time value.

You must not use utcbiginttoutctime () function as it does not show time in a
time zone that is configured on your OpsCenter host.
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